Certification Study Guide
Series: IBM Maximo Asset Management V7.1

Helps you achieve IBM Maximo Asset Management V7.1 certification
Explains the certification path and prerequisites
Introduces sample test questions

Vasfi Gucer
Alisson Negrisolo de Godoi
Anantaram Kandukuri
Brent Knapp
Caio Elias Saad
James Strand
Jonathan Baffa
Julio Madeira
Maamar Ferkoun
Marcel Laurenz
Shireen Ahmed
Note: Before using this information and the product it supports, read the information in “Notices” on page ix.

First Edition (July 2009)

This edition applies to IBM Maximo Asset Management Version 7.1.
# Contents

Notices ................................................................. ix  
Trademarks .......................................................... x  

Preface ......................................................................... xi  
The team that wrote this book ......................................... xii  
Become a published author ............................................. xv  
Comments welcome ..................................................... xvi  

Chapter 1. Certification overview ...................................... 1  
1.1 IBM Professional Certification Program .......................... 2  
   1.1.1 Benefits of certification ...................................... 3  
1.2 IBM Tivoli Software Professional Certification.................. 4  
1.3 Test 000-015: IBM Maximo Asset Management V7.1 Implementation .................................................. 7  
   1.3.1 Job role description and target audience ............... 7  
   1.3.2 About the test .................................................... 7  
   1.3.3 Receive your 15% discount when taking the test ......... 7  
1.4 Suggested resources for study ...................................... 8  
   1.4.1 Courses ............................................................ 8  
   1.4.2 Publications ....................................................... 8  

Chapter 2. Assets ........................................................ 11  
2.1 Assets module ....................................................... 12  
2.2 Rotating assets and rotating items ................................. 16  
   2.2.1 Move/Modify Assets ........................................ 19  
   2.2.2 Swap Assets .................................................... 20  
   2.2.3 Move/Swap/Modify .......................................... 21  
2.3 Meters ................................................................... 22  
   2.3.1 Meters and meter groups ..................................... 22  
   2.3.2 Condition Monitoring ....................................... 23  
2.4 Locations ................................................................ 25  
2.5 Classifications ......................................................... 27  
2.6 Database Configuration ............................................ 30  
2.7 Application Designer ................................................ 33  

Chapter 3. Preventive Maintenance ................................. 35  
3.1 Master Preventive Maintenance application ....................... 36  
3.2 Preventive Maintenance application ............................... 36  
3.3 Working with the Master PM ....................................... 37  
   3.3.1 Creating a Master PM ......................................... 37
### 6.2.2 Currency codes ................................................. 93
### 6.2.3 Exchange rates .................................................. 95
### 6.2.4 Company records versus company master records .......... 97
### 6.2.5 Company records and contracts ................................. 97
### 6.2.6 Company records and purchasing ............................... 98
### 6.3 Companies application ........................................... 98
   - 6.3.1 Manage companies ........................................ 99
   - 6.3.2 Deleting a company ....................................... 100
### 6.4 Purchase Requisitions application ............................... 101
   - 6.4.1 Managing purchase requisitions ............................ 101
### 6.5 Purchase Orders application .................................... 103
   - 6.5.1 Managing purchase orders ................................. 104
### 6.6 Receiving application ........................................... 106
   - 6.6.1 Rotating items ............................................. 109
### 6.7 Request for Quotations application .............................. 110
### 6.8 Invoices application ............................................ 112
   - 6.8.1 Invoice types .............................................. 113
   - 6.8.2 Invoice status ............................................. 113
   - 6.8.3 Approving an invoice ..................................... 115
   - 6.8.4 Create an invoice that contains multiple vendors ........ 116
   - 6.8.5 Add taxes to the cost of an invoice line item ................ 116

### Chapter 7. Resources .................................................. 119
#### 7.1 Resources module ............................................... 120
#### 7.2 Labor .............................................................. 120
#### 7.3 Qualifications .................................................... 127
#### 7.4 People .............................................................. 131
#### 7.5 Person Group ...................................................... 133
#### 7.6 Crafts ............................................................... 135

### Chapter 8. Work Management .......................................... 139
#### 8.1 Work orders ........................................................ 140
   - 8.1.1 Work order status ......................................... 140
   - 8.1.2 Work plans .................................................. 141
   - 8.1.3 Job plans .................................................... 142
   - 8.1.4 The Move/Swap/Modify actions ............................. 146
   - 8.1.5 Work order ownership ..................................... 149
#### 8.2 Work order flow control .......................................... 150
   - 8.2.1 Process flow ................................................ 150
   - 8.2.2 Flow control ............................................... 151
   - 8.2.3 Flow action ............................................... 152
#### 8.3 Plan labor and crafts ............................................. 153
   - 8.3.1 Work plans .................................................. 154
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs.
Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both. These and other IBM trademarked terms are marked on their first occurrence in this information with the appropriate symbol (® or ™), indicating US registered or common law trademarks owned by IBM at the time this information was published. Such trademarks may also be registered or common law trademarks in other countries. A current list of IBM trademarks is available on the Web at http://www.ibm.com/legal/copytrade.shtml

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

    ClearQuest®
    Foundations™
    IBM®
    Lotus®
    Maximo®
    Rational®
    Redbooks®
    Redbooks (logo)®
    Tivoli®
    WebSphere®

The following terms are trademarks of other companies:

ITIL is a registered trademark, and a registered community trademark of the Office of Government Commerce, and is registered in the U.S. Patent and Trademark Office.

J2EE, Java, and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Active Directory, Microsoft, Windows, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of others.
Preface

This IBM® Redbooks® publication is a study guide for IBM Maximo® Asset Management V7.1 and is aimed at individuals who want to get an IBM Professional Certification for this product.

The IBM Maximo Asset Management V7.1 certification exam, offered through the Professional Certification Program from IBM, is designed to validate the skills required of technical professionals who work in the implementation and configuration of the IBM Maximo Asset Management V7.1 product.

This book provides a combination of theory and practical experience needed for a general understanding of the subject matter. It also provides sample questions that will help in the evaluation of personal progress and provide familiarity with the types of questions that you will encounter in the exam.

This publication does not replace practical experience, and is not designed to be a stand-alone guide for any subject. Instead, it is an effective tool that, when combined with educational activities and experience, can be an extremely useful preparation guide for the exam.

For your convenience, we structure the chapters based on the sections of the Test 000-015: IBM Maximo Asset Management V7.1 Implementation, such as Assets, Inventory, and so on, so studying each chapter will help you prepare for one section of the exam.

The team that wrote this book

This book was produced by a team of specialists from around the world working at the International Technical Support Organization (ITSO), Raleigh Center.

Vasfi Gucer is a Project Leader at the International Technical Support Organization, Austin Center. He has been with the ITSO since January 1999. He has more than 12 years of experience in the areas of systems management, networking hardware, and software on mainframe and distributed platforms. He has worked on various IBM Tivoli® client projects as a Systems Architect in the U.S. He writes extensively and teaches IBM classes worldwide on Tivoli software. Vasfi is also an IBM Certified Senior IT Specialist, PMP and ITIL® Expert.

Alisson Negrisolo de Godoi is a Software Engineer for IBM Brazil Software Laboratory. He has over two years of experience in working with IBM Tivoli Maximo and over four years of experience in software development. For Maximo solutions, he has provided support for petroleum and miner companies.

Anantaram Kandukuri is a Maximo - Sr. Delivery Manager at Envision Enterprise Solutions Pvt. Ltd, Hyderabad, India. He has 12 years of production experience in process industry and more than 13 years of IT experience in software development, customization and implementation of ERP, EAI, and J2EE™ applications. He has wide experience on Maximo Solutions - 5.1, 5.2, 6.2, and 7.1 versions of Maximo.
Brent Knapp is a Maximo Project Manager in IBM USA. He has been working with Maximo for over two years and has extensive background in applied program and project management. His experience has focused on large, complex technology-based projects with an emphasis on management of technology-driven services. Brent’s experience includes support to clients in manufacturing, finance, energy, consumer package goods, and healthcare. Over the past six years, he has authored 12 books on project management. In addition to being certified in PMP and ITIL, Brent holds several IBM certifications.

Caio Elias Saad is a Software Engineer at IBM Brazil Software Laboratory, based in São Paulo, Brazil. He has over five years of experience in Java™ Enterprise development and over two years working on IBM Maximo Asset Management development. The main projects he has been involved in are Maximo Core EAM development V6.x, V7.x, and V8.x and huge Maximo V7.x implementations using Integration Framework and other products like Maximo for Oil and Gas, and Calibration industry solutions.

James Strand is an IBM Certified Deployment Professional in Maximo Asset Management V7.1. He is President of james233, Inc., a consulting and training firm based in Arkansas. He has over 10 years experience in a variety of business and non-profit environments. He holds a Master in Business Administration degree from Oral Roberts University.

Jonathan Baffa is the Director of Information Technology for SaS, a long term Maximo and IBM Business Partner. Jonathan is an IBM Certified Advanced Deployment Professional, ITIL Certified, and has over four years of experience with Maximo and its related products. Jonathan provides strategic direction for corporate IT and establishes best practices for hosted and non-hosted solutions as well as their technical engagements and deployments.
Julio Madeira is a Software Engineer at IBM, a position he has held for the last two years, and also has 15 years of experience with IT. He has a Bachelor Degree in Computer Sciences from Catholic University of Santos and also a Post-Graduate degree in IT Management from Fundação Getúlio Vargas in Brazil.

Maamar Ferkoun is a Senior Product Professional with the IBM worldwide Software Advanced Technology group. He is based in IBM Hong Kong S.A.R. of the PRC and has over 20 years of experience in the IT industry, including over 10 years with IBM. He holds a degree in Computer Science, an ITIL Manager, and a COBIT certification. Maamar began his career with IBM as a Software Field Engineer engaged across the Asia Pacific region. His area of expertise covers the service management product portfolio and best practices.

Marcel Laurenz is a proven Senior IT Consultant and Director of LAURENZ-IT, based in northern Germany. Marcel has more than 10 years of experience in leading international projects and teams, specifically in areas of operations and service management. He is a certified IBM Lotus®, WebSphere®, Tivoli, Microsoft®, and ITIL expert, and holds a degree in Sport Science and Economy. He is an entrepreneur, building high performance teams.

Shireen Ahmed is a Senior Staff Software Engineer in the ClearQuest® Group at IBM Rational® Software, Lexington, Massachusetts. She has been with IBM since 2002 and has lead and worked on several projects focusing on ClearQuest and Globalization (G11n). She has spent more than 20 years as a software developer. Ms. Ahmed holds a Master degree in Computer Science from Boston University, Boston and a Master degree in Mathematics from Northeastern University, Boston.
Thanks to the following people for their contributions to this project:

Amanda Hayden  
Service Desk and Asset Management Solutions (SaS)  
http://www.sassolutions.com

Diane Sherman, Wade Wallace  
International Technical Support Organization, Austin Center

Tamikia Barrow  
International Technical Support Organization, Raleigh Center

Kristin Wall Gibson, Emma Jacobs, James Whiteman/IBM USA

Marc Perucca  
IBM UK

**Become a published author**

Join us for a two- to six-week residency program! Help write a book dealing with specific products or solutions, while getting hands-on experience with leading-edge technologies. You will have the opportunity to team with IBM technical professionals, Business Partners, and Clients.

Your efforts will help increase product acceptance and customer satisfaction. As a bonus, you will develop a network of contacts in IBM development labs, and increase your productivity and marketability.

Find out more about the residency program, browse the residency index, and apply online at:  
ibm.com/redbooks/residencies.html
Comments welcome

Your comments are important to us!

We want our books to be as helpful as possible. Send us your comments about this book or other IBM Redbooks publications in one of the following ways:

- Use the online **Contact us** review Redbooks form found at:
  ibm.com/redbooks

- Send your comments in an e-mail to:
  redbooks@us.ibm.com

- Mail your comments to:
  IBM Corporation, International Technical Support Organization
  Dept. HYTD Mail Station P099
  2455 South Road
  Poughkeepsie, NY 12601-5400
Certification overview

This chapter provides an overview of the skill required to become an IBM certified Advanced Technical Expert. The chapter offers a comprehensive review of specific topics that provide essential information for obtaining the certification.

This chapter contains the following topics:

- “IBM Professional Certification Program” on page 2
- “IBM Tivoli Software Professional Certification” on page 4
- “Test 000-015: IBM Maximo Asset Management V7.1 Implementation” on page 7
- “Suggested resources for study” on page 8
1.1 IBM Professional Certification Program

Having the right skills for the job is critical in the growing global marketplace. IBM Professional Certification, designed to validate skill and proficiency in the latest IBM solution and product technology, can help provide that competitive edge. The IBM Professional Certification Program Web site is available at:


The IBM Professional Certification Program offers a business solution for skilled technical professionals seeking to demonstrate their expertise to the world.

In addition to demonstrating your skill and proficiency in the latest IBM technology and solutions, professional certification can help you excel at your job by giving you and your employer the confidence that your skills have been tested. You can deliver higher levels of service and technical expertise than non-certified employees and move on a faster career track. Professional certification puts your career in your control.

The certification requirements are difficult but not overwhelming. Certification is a rigorous process that differentiates you from everyone else.

The mission of the IBM Professional Certification Program is to:

► Provide a reliable, valid, and fair method of assessing skills and knowledge.
► Provide IBM with a method of building and validating the skills of individuals and organizations.
► Develop a loyal community of highly skilled certified professionals who recommend, sell, service, support, and use IBM products and solutions.

The IBM Professional Certification Program has developed certification role names to guide you in your professional development. The certification role names include IBM Certified Specialist, IBM Certified Solutions/Systems Expert, and IBM Certified Advanced Technical Expert for technical professionals who sell, service, and support IBM solutions. For technical professionals in application development, the certification roles include IBM Certified Developer Associate and IBM Certified Developer. An IBM Certified Instructor certifies the professional instructor.

The IBM Professional Certification Program provides a structured program leading to an internationally recognized qualification. The program is designed for flexibility by enabling you to select your role, prepare for and take tests at your own pace, and, in some cases, select from a choice of elective tests best suited to your abilities and needs. Some roles also offer a shortcut by giving credit for a certification obtained in other industry certification programs.
You can be a network administrator, systems integrator, network integrator, solution architect, solution developer, value-added reseller, technical coordinator, sales representative, or educational trainer. Regardless of your role, you can start charting your course through the IBM Professional Certification Program today.

1.1.1 Benefits of certification

Certification is a tool to help objectively measure the performance of a professional on a given job at a defined skill level. Therefore, it is beneficial for individuals who want to validate their own skills and performance levels, those of their employees, or both. For optimum benefit, the certification tests must reflect the critical tasks required for a job, the skill levels of each task, and the frequency a task must be performed. IBM prides itself in designing comprehensive, documented processes that ensure that IBM certification tests remain relevant to the work environment of potential certification candidates.

In addition to assessing job skills and performance levels, professional certification can also provide the following benefits:

- **For employees:**
  - Promotes recognition as an IBM certified professional
  - Creates advantages in interviews
  - Assists in salary increases, corporate advancement, or both
  - Increases self-esteem
  - Provides continuing professional benefits

- **For employers:**
  - Measures the effectiveness of training
  - Reduces course redundancy and unnecessary expenses
  - Provides objective benchmarks for validating skills
  - Facilitates long-range planning
  - Helps to manage professional development
  - Aids as a hiring tool
  - Contributes to competitive advantage
  - Increases productivity
  - Increases morale and loyalty

- **For IBM Business Partners and consultants:**
  - Provides independent validation of technical skills
  - Creates competitive advantage and business opportunities
  - Enhances prestige of the team
  - Contributes to meeting IBM requirements for various IBM Business Partner programs
Specific benefits can vary by country (or region) and role. In general, after you become certified, you should receive the following benefits:

- **Industry recognition**
  Certification can accelerate your career potential by validating your professional competency and increasing your ability to provide solid, capable technical support.

- **Program credentials**
  As a certified professional, you receive (through e-mail) your certificate of completion and the certification mark associated with your role for use in advertisements and business literature. You can also request a hardcopy certificate, which includes a wallet-size certificate.

  IBM Professional Certification acknowledges the individual as a technical professional. The certification mark is for the exclusive use of the certified individual.

- **Ongoing technical vitality**
  IBM certified professionals are included in mailings from the IBM Professional Certification Program.

### 1.2 IBM Tivoli Software Professional Certification

The IBM Tivoli Professional Certification program offers certification testing that sets the standard for qualified product consultants, administrators, architects, and partners.

The program also offers an internationally recognized qualification for technical professionals seeking to apply their expertise in today’s complex business environment. The program is designed for those who implement, buy, sell, service, and support IBM Tivoli solutions and want to deliver higher levels of service and technical expertise.

Whether you are a Tivoli client, partner, or technical professional wanting to put your career on the fast track, you can start on the road to becoming a Tivoli Certified Professional today.

**Benefits of Tivoli certification**

Tivoli certification provides the following benefits:

- For the individual:
  - IBM Certified certificate and use of logos on business cards
  - Recognition of your technical skills by your peers and management
– Enhanced career opportunities
– Focus for your professional development

▶ For the IBM Business Partner:
– Confidence in the skills of your employees
– Enhanced partnership benefits from the IBM Business Partner program
– Ability to bill your employees’ services at higher rates
– Strengthens proposals to customers
– Deepens technical skills available to prospective customers

▶ For the customer:
– Confidence in the services professionals handling your implementation
– Ease of hiring competent employees to manage your Tivoli environment
– Enhanced return on investment (ROI) through more thorough integration with Tivoli and third-party products
– Ease of selecting a Tivoli Business Partner that meets your specific needs

Certification checklist
To pursue certification, follow the steps in this checklist:

1. Select the certification that you want to pursue.

2. Determine which test or tests are required by reading the certification role description.

3. Prepare for the test, using the following resources provided:
   – Test objectives
   – Recommended educational resources
   – Sample assessment test
   – Other reference materials
   – List of opportunities for gaining experience

   **Note:** These resources are available from each certification description page, as well as from the test information page.

4. Register to take a test by contacting one of our worldwide testing vendors:
   – Prometric
   – Pearson Virtual University Enterprises (VUE)

   **Note:** When providing your name and address to the testing vendor, be sure to specify your name exactly as you want it to appear on your certificate.
5. Take the test. Be sure to keep the Examination Score Report provided upon test completion as your record of taking the test.

**Note:** After taking a test, your test results and demographic data (including name, address, e-mail, and phone number) are sent from the testing vendor to IBM for processing (allow two to three days for transmittal and processing). After all the tests required for a certification are passed and received by IBM, your certificate is issued.

6. Repeat steps 3 on page 5 - 5 until all required tests are successfully completed for the certification role. If you must meet additional requirements (such as an *other vendor* certification or exam), follow the instructions on the certification description page to submit these requirements to IBM.

7. After you complete your certification requirements, you are sent an e-mail asking you to accept the terms of the IBM Certification Agreement before receiving the certificate.

8. Upon acceptance of the terms of the IBM Certification Agreement, an e-mail is sent to you containing the following electronic deliverables:
   - A Certification certificate in PDF format, which can be printed in either color or black and white
   - A set of graphic files of the IBM Professional Certification mark associated with the certification achieved
   - Guidelines for the use of the IBM Professional Certification mark

9. To avoid unnecessary delay in receiving your certificate, ensure that your current e-mail is on file by maintaining an up-to-date profile. If you do not have an e-mail address on file, your certificate is sent through postal mail.

Certificates are sent by e-mail. However, you may also contact IBM at the following e-mail address to request a paper copy of the certificate, including a laminated wallet-sized card:

mailto:certify@us.ibm.com

**Note:** IBM reserves the right to change or delete any portion of the program, including the terms and conditions of the IBM Certification Agreement, at any time without notice. Some certification roles offered through the IBM Professional Certification Program require recertification.
1.3 Test 000-015: IBM Maximo Asset Management V7.1 Implementation

This section describes the IBM Maximo Asset Management V7.1 Implementation certification test.

1.3.1 Job role description and target audience

An IBM Certified Deployment Professional - IBM Maximo Asset Management V7.1 is a technical professional responsible for planning, installation, configuration, operations, administration, and maintenance of a Tivoli Asset Management V7.1 solution. This individual is expected to perform these tasks with limited assistance from peers, product documentation, and support resources.

1.3.2 About the test

To be certified, you must select Test 015: IBM Maximo Asset Management V7.1 Implementation. Note the following information about the test:

- Approximate number of questions: 69
- Duration in minutes: 105
- Format: Multiple choice
- Required passing score: 71%

For the most updated objectives of the IBM Maximo Asset Management V7.1 Implementation certification test, refer to the following link:


1.3.3 Receive your 15% discount when taking the test

You can receive a 15% discount on the IBM Certified Deployment Professional - Maximo Asset Management V7.1 certification exam, if taken at any Prometric testing center. Simply remember to use the code 15T015.
1.4 Suggested resources for study

Courses and publications are offered to help you prepare for certification tests.

1.4.1 Courses

Refer to the following link for a list of courses related to IBM Maximo Asset Management V7.1:


The courses are recommended, but not required, before taking a certification test. If you want to purchase Web-based training courses, or you are unable to locate a Web-based or classroom course at the time and location you want, contact one of our delivery management teams:

- Americas
  mailto:tivamedu@us.ibm.com
- EMEA
  mailto:tived@uk.ibm.com
- AP
  mailto:tivtrainingap@au1.ibm.com

**Note:** Course offerings are continuously being added and updated. If you do not see the courses listed in your location, contact one of the previously listed delivery management teams.

1.4.2 Publications

Before taking Test 015: IBM Maximo Asset Management V7.1 Implementation certification test, we recommend that you review the following product documentation and IBM Redbooks publications.

**Online publications**

For online publications of IBM Maximo Asset Management V7.1, go to:

IBM Redbooks publications
Refer to the IBM Redbooks publications as a study resource:

▶ *Deployment Guide Series: Maximo Asset Management V7.1*, SG24-7640
  This book provides information to assist in the deployment and initial configuration of a IBM Maximo Asset Management V7.1 environment.

▶ *IT Asset Management Processes using Tivoli Asset Manager for IT*, SG24-7601
  This book provides high-level overviews of Tivoli IT Asset Management Portfolio. Using product-specific terminology, it describes how the product capabilities can enhance the implementation and automation of common IT asset management processes. Most of the information in the book is also applicable to IBM Maximo Asset Management.

▶ *Maximo Asset Management Essentials V7.1 Implementer’s Guide*, SG24-7645
  This book provides general IBM Maximo Asset Management V7.1 product information and covers the planning, installation, and initial configuration processes.
Assets

This chapter covers the Assets module and its relationship with other modules such as Work Order, Classifications and Preventive Maintenance. This chapter also covers several of the most important features on the Assets module, such as rotation items, meters, asset status, locations, user’s attributes and others.

This chapter contains the following topics:

- “Assets module” on page 12
- “Rotating assets and rotating items” on page 16
- “Meters” on page 22
- “Locations” on page 25
- “Classifications” on page 27
- “Database Configuration” on page 30
- “Application Designer” on page 33
2.1 Assets module

The Assets module is used to manage all the assets that have been purchased, and control them through their entire asset life cycle.

To support maintenance of assets, the Assets module has the following applications:

- **Assets**
  Assets is used to create, change, and keep asset records up-to-date as life span, life-to-date, status modifications, spare parts, and assembly structures.

- **Locations**
  Locations is the place where assets are operated, stored, or repaired. Generally, locations are defined as a means of tracking assets, but if your company does not use asset records to track equipment, you may define a location as any facility for which you want to create a maintenance record.

- **Meters**
  Meters keeps the record's life-to-date and history of the consumption of an asset. The meters can be of type *Continuous* (cumulative such kilometers and miles, hours of use, engine starts, fuel consumed), *Gauge* (fuel level, oil pressure and level, and noise level) and *Characteristic* (the condition of the asset, for example vibrating, noise, color).

- **Meter Groups**
  Meter Groups is the top-level of meter application, where you can group certain types of meters. As explained previously, the default groups can be Continuous, Gauge, and Characteristic.

- **Condition Monitoring**
  Condition Monitoring tracks gauge and characteristics records of an asset.

- **Failure Codes**
  Failure code is an element of a failure hierarchy. A failure consists of problems, causes, and remedies. An individual failure code can be used at more than one level of a failure hierarchy. For example *high temperature* can appear in one failure hierarchy as a problem and in another as a cause.

The Asset module applications can be launched by from the Go To menu, by selecting **Go To → Assets**, as shown in Figure 2-1 on page 13.
The Assets application is responsible for the creation and maintenance of assets and an asset's related information such as costs, parent, statuses, location, vendor, maintenance, and meters.

The Assets application enables the user to be able to create the asset hierarchy and the list of locations, such as sites, buildings and subassemblies.

The asset hierarchy is a good way to control the maintenance costs in different levels. It is by far the best way to manage a group or a specific asset.

When you open the Assets application, you see the following tabs:

- List, which is where you can search for Assets.
- Asset, which is for assets maintenance such as create, update, and delete.
- Spare Parts, which you use to create asset hierarchy and all subparts of it.
- Safety, which you use for maintenance of safety records of an asset.
- Meters, which you use to track, insert, consult data related to the meter life-to-date of an asset.
- Specifications, which is where you can make the maintenance of the specification of an asset record related to the Classifications application.

The default main window is the List tab. If you are looking for a specific attribute on the List tab, or you use the More Search fields in the Advanced Fields, and the results contain only one asset, the Asset tab opens, as shown in the Figure 2-2.

![Figure 2-2  Assets applications](image)

When creating a new asset, certain default fields are filled automatically and are read-only to the user. Other fields are writable, but they become read-only after the first-save of the asset record. These are fields such as: Asset name, Parent, Location, Rotating Item, Condition Code, and Asset Up?.

To change certain read-only fields, use the **Select Action** menu for a corresponding option to the related field.

Certain fields are required in order for the user to be able to save the record. These are fields such as Asset Name, Status, Site, Asset Up?, Change By, Changed Date, Last Changed Date, and Total Downtime. Any asset can be
moved between sites and organizations, regardless of whether it is a rotating item.

When searching for a specific asset, there are many search options such as: attribute search, asset hierarchy, and classification description. You have many options in the More Search Fields window, shown in Figure 2-3.

![Figure 2-3 More Search Fields function on Assets application](image)

To find all work orders related to a specific asset, use the asset Select Action menu, then select View → **View Work Details**. This option shows all related records regarding work orders, preventive maintenance, routes, and collections.

You can add information to this view regarding children assets and ancestors, as shown in Figure 2-4.

![Figure 2-4 More Views options](image)
2.2 Rotating assets and rotating items

Rotating assets are interchangeable assets that are moved in and out of service as needed. The term is generally applied to assets that can be repaired or refurbished rather than replaced, and can be used interchangeably at different locations or as subassemblies on different assets. Some examples of rotating assets might include pumps, motors, transmissions, laptops.

Rotating asset records also have a Rotating Item number to track the asset as it moves from a storeroom to an asset or location, to repair, and so forth. Having both an asset and item number lets you track identical assets both individually, via their unique asset numbers, and as a group, via their shared item number.

For example, a company might have fifty identical fire extinguishers (same manufacturer, same model), so all fifty have the same item number. However, each fire extinguisher has a unique history of when it was purchased, placed in the facility, inspected, used, and recharged, so each extinguisher has a unique asset number to let you track it individually.

To associate an rotating asset with a rotating item, use the Rotating Item field, as shown in Figure 2-5 on page 16.

Figure 2-5  Rotating Item Field on Assets application
To create a rotating item, you must add a valid rotating item from the Item Master application, as shown Figure 2-6 on page 17.

**Rotating assets versus rotating items:** Rotating assets are a special category of asset records, used to refer to any asset record that contains a value in the Rotating Item field. Rotating assets consist of multiple interchangeable assets, with each asset having the same item number and a different asset number.

These items are tracked both by their item numbers in the Inventory module and by their individual asset numbers in the Assets module. The term *rotating item* is used when referring to inventory records and management, and the term *rotating asset* is used when referring to asset records and maintenance.

To create a valid item master, you must create a record with status of *Active* and with the *Rotating?* field check box selected. Then, you may add this item to your asset record, which results in your asset being configured as a rotating item.
When you move an asset for another location for repairs, you have limited types of locations that you can work with. Actually, when working with a non-rotating item, you may move this asset only for locations of type: Operating, Repair, Salvage, or Vendor. When working with a rotating item, this restriction is not applied anymore.

For a rotating item, you may use items (from the Item Master application) or tools (from the Tools application). You may not use service items, because service itself is not a unique and consumable material.

After you create a rotating item, the field Rotating Item becomes read-only. However, you may change it by using the Select Action menu and then selecting Change Item Number. The Change Item Number dialog opens, as shown in Figure 2-7 on page 18.

![Change Item Number](image)

*Figure 2-7  Change Item Number*

Having both an asset and item number allows you to track rotating assets individually, with their unique asset numbers, and also as a group, with their shared item number. Figure 2-8 shows the Rotating Item field in the Locations application.
To create a location, click **New Location**. The main fields will be ready to be populated. The status for new locations can be: Not Ready, Operating, or Decommissioned. By default, the initial status is Not Ready.

An asset can be moved between sites and organizations regardless of being a rotating item. The difference exists only when moving or swapping the assets.

### 2.2.1 Move/Modify Assets

See the icon of Move/Modify Assets in Figure 2-9.
Use the Move/Modify function to move an asset from a non-inventory location to another non-inventory location or a storeroom. You can move assets within your current site, to another site within your organization, or to a site in a different organization of the company.

The Move/Modify Assets function allows you to move or modify assets individually or using the Mass Move. When you move multiple assets, you have to specify the same information for the assets. For example, you might specify the same location for the assets that you are moving.

Use Move/Modify Assets to perform the following tasks:
- Move assets grouped or not for a location, site, or bin.
- Work, create, and update users and custodians.
- Modify a single or multiple assets attributes.

2.2.2 Swap Assets

See the icon of Swap Assets function in Figure 2-10.

![Swap Assets](image)

Figure 2-10  Swap Assets

To replace one asset with another one, you may use the Swap Assets action. For example, you might specify a different location for the asset that you want to swap out. You can swap any number of assets at once by using the Swap Assets dialog box. You cannot use the Swap Assets action to move rotating assets from inventory locations; you must issue or transfer rotating assets using the inventory applications.

Note the following information about swapping assets:
- If two assets share the same item set, you can swap both if they are defined as rotating item. You can swap them even if they are in different locations.
- If the replacing asset from another site or organization has the same asset identifier as an asset in your current site, IBM Maximo Asset Management prompts you to assign a new asset identifier to the replacing asset. Every asset within a site must have a unique identifier.
The ability to swap assets to and from another site or organization depends upon your security authorization.

2.2.3 Move/Swap/Modify

When working with Move/Modify or Swap Assets, you can also perform a modification regarding the responsibility for this asset using the function *User and Custodians* that is available from other applications across IBM Maximo Asset Management such as:

- From Move/Modify Assets action in the Assets application.
- From Associate User and Custodians action in the Assets application.
- From the Move/Swap/Modify action in the Work Order Tracking application.

You use the Users and Custodians tab to associate an asset with a person as an user or as custodian or as both.

In IBM Maximo Asset Management, an asset can have multiple users, multiple custodians, or multiple users and custodians. If an asset does not have any users or custodians, anyone can create an incident or service request for it. You may create a request with that asset only if you are an associated user or custodian for that asset. In the other applications, when a caller contacts a service desk agent, the agent can associate the caller with the ticket and then associate the appropriate assets with the ticket.

Figure 2-11 shows an example of Move/Swap/Modify.
2.3 Meters

The Meters application is used to keep the records, life-to-date, and history of the consumption of an asset. The three types of meters are:

- Continuous, which is cumulative, such as kilometers and miles, hours of use, engine starts, and fuel consumed
- Gauge, which can be, for example, fuel level, oil pressure and level, and noise level
- Characteristic, which are asset characteristics such as vibrating, noise, and color

2.3.1 Meters and meter groups

You can create meters and meter groups in the Meters application and then within the Item Master application, associate a meter to an item or a meter group on a rotating item. As mentioned in 2.3, “Meters” on page 22, meters can be of three types: continuous (kilometers life-to-date, liters consumed), gauge (a temperature reading), and characteristic (a color, a vibration level, a sound level).

When you associate a continuous meter to an item and then issue the item to a work order, asset, or location, IBM Maximo Asset Management updates the associated asset or location record with the quantity that was issued and decreases the storeroom balance of that item. (This process happens only when the meter on the item matches the meter on the asset or location.)

For example, you might have FUEL defined as a meter and GASOLINE as an item. Within Item Master, you can associate the meter FUEL to the item GASOLINE. When you issue fuel for an asset, such as a truck, IBM Maximo Asset Management decreases the balance of the fuel in the storeroom by the amount issued, and in the Assets application on the Meters tab, you can see that the amount of fuel issued to the truck increases by the issued amount. This approach allows you to track fuel consumption for that asset.

With MILES for example, you can track the life-to-date of a vehicle and its consumption average of miles that a vehicle uses by day or by month. To do that, when associating with an Asset, you have to specify an Average Calculation Method of SLIDING-DAYS and specify the Sliding Window Size.

The two methods to calculate an average can be by using the last readings (sliding-readings) or by the last days (sliding-days). In both cases, you specify the quantity of days or the reading in the field Sliding Window Size, as shown in the example in Figure 2-12.
The field Average Units/Day indicates the average in the period that is specified as the Sliding Window Size; the Life to Date for Asset field indicates the sum of all readings, such as the odometer of a car for example.

A meter group is a set of meters that you can apply to an asset record. In the case of a rotating item, IBM Maximo Asset Management automatically applies any meter group that is associated with the rotating item to any assets that are created for that item.

For example, a pump is a rotating item. On a pump, you might track meters such as inlet pressure, outlet pressure, and vibrations. These meters are common to all pumps. Instead of having to add these meters to each asset record created for this rotating item, you may instead create a meter group with this collection of pump-related meters and associate it with the rotating item. Each time you create an asset record for the pump, IBM Maximo Asset Management associates the meter group and its meters to the asset record so that you do not have to do it manually.

### 2.3.2 Condition Monitoring

The *Condition Monitoring* application is used to create and view measurement point records for your assets and locations. A measurement point record defines the limits of acceptable meter readings for a characteristic or gauge type meter on an asset or location. You can generate preventive maintenance (PM) work orders or work orders with a specific job plan for assets or locations whose meter readings are outside acceptable limits.

Each measurement point is unique. You can compare similar measurement points on different assets or locations using meter readings. For example, you may use similar types of compressors in multiple locations, but you might have purchased the compressors from different vendors. If you have a pressure gauge on each of those compressors, you can generate reports that enable you to compare the pressure readings on those compressors. This information helps you to determine whether the compressors from one vendor are more efficient.
than a similar compressor from another vendor. You may not use a meter name more than once on an asset or location record, but you may use the same meter name on multiple asset and location records.

Condition Monitoring tab is shown in Figure 2-13 on page 24.

![Condition Monitoring application main fields](image)

Figure 2-13  Condition Monitoring application main fields

Within those fields, you specify the Point of the monitoring condition by providing the asset name, meter to be monitored, its site, meter type, and the unit of measure.

Then, you have to specify the range by setting the *Upper Limits* and the *Lower Limits* as shown in Figure 2-14 and in Figure 2-15, respectively.

![Upper Limits section under Condition Monitoring application](image)

Figure 2-14  Upper Limits section under Condition Monitoring application

![Lower Limits section under Condition Monitoring application](image)

Figure 2-15  Lower Limits section under Condition Monitoring application
All measurements can be entered as part of a work order rather than directly against the measure point record in the Condition Monitoring application. When this is the case, a better approach is to set up a cron task to automate the generation of the work order when the limits have been exceeded.

Initially set the schedule on the cron task instance to run every 10 minutes. If you use an existing instance, check the OrgID and SiteID cron task parameters. To verify whether the cron task has been run, review the Cron Task History after the specified time. If the last measurement has exceeded its action limits, you will find that a work order was generated.

There are two main differences between measurement points for characteristics meters and for continuous meters. When an upper or lower limit exceeds its limit for a characteristics meter, a preventive maintenance (PM) item is generated. When you are working with a continuous meter, a work order can be generated manually or with a cron task as described previously.

### 2.4 Locations

The Locations application is a site-level application and is generally defined as a place where assets are operated, stored, or repaired. Typically, locations are defined as a means of tracking assets, but if your company does not use asset records to track equipment, you may define a location as any facility (or portion of a facility) for which you want to create a maintenance record.

You use the Locations application to add, view, modify, and delete location records for assets, and organize these locations into logical hierarchical or network systems. Use systems of locations for specifying the location for assets.

Asset records provide the groundwork for gathering and tracking valuable information about the history of assets, including asset performance at specific sites, and as an asset is moved from location to location. When you organize your locations into systems, you can quickly find a location and then identify the assets at a specific location.

You may also use the Locations application to create repair locations, courier locations, salvage locations, vendor locations, and labor locations. To add a new location in the system, you must have at least the following information:

- Location ID, which is the ID for the new location, such as BLD901 for Building 901
- Type, which specifies the type of this location in order to ease the process of identifying where the asset is and the reason. The Type can be: Holding, Repair, Operating, Salvage, Labor, Courier, Vendor, and Syslevel.
- Site, which is the name of the site where this location belongs
- Status, which is the current status of the location

Figure 2-16 on page 26 shows an example of a location.

The following common terms are used when discussing location hierarchies:

- **Hierarchy** is any system of places ranked one above another. Each parent location can have many child locations, but each child location can have only one parent location.

- **Location** is typically a place where assets operate, but includes any building, place, or position that contains assets, or where maintenance work might have to be performed.

- **Network** is any system of interconnected locations. Unlike hierarchies, in a network each location can have multiple parents and children.

- **Operating location** is the place where equipment operates.
Primary system is the default hierarchy of locations. Each site is allowed to have only one primary system. Your primary system must be hierarchical; that is, there must be a single top-level location that is the parent of all other locations in the system. If assets in different locations are part of an asset hierarchy, their locations must exist in the primary system.

Site is a work location, such as a plant or facility. A site belongs to a single organization.

System is a grouping of locations, organized into either hierarchical or network relationships. A hierarchical system could define location relationships of a plant, having a plant site as a parent to plant buildings, which are parents of sublocations within the building areas. A network system could define the location relationships of a system of pipes or ducts, where certain locations feed back to others.

2.5 Classifications

Classification is the capability to specify or apply hierarchy for assets, locations, and other Items.

If an asset is a rotating item, the classification is determined from its rotating item. If the attribute values are updated on the rotating item, they are also changed on all rotating assets that belong to this rotating item.

Classification can be used to structure records into organized hierarchies. Using classifications helps you easily locate records and ensure that records are not duplicated unintentionally.

Your system administrator creates one or more different classification hierarchies by using the Classifications application. By default, Classifications allow you to classify and search the following types of records: Classification, Parent Classification, and Classification Path. These can optionally be grouped by Organization, Site, or both.

You can access the Classifications application from the Go To menu by selecting Go To → Administration → Classifications.

The Classification application has the fields shown in Figure 2-17 on page 28.
The main window contains three sections:

- **Use With**, which lists the application that this classification will be used with, such as assets, item, location and work order.

- **Children**, which is a node list that is being used by classification.

- **Attribute**, which provides asset attribute identification.

The fields above the sections are displayed in applications that use classification such as Assets, Locations, Item Master, Job Plans, Work Orders, Ticket Template and more.

All classification attributes are related to the application listed in the Use With section, as shown in the Figure 2-18 on page 29.
Figure 2-18  Use With section on Classifications application

Figure 2-19 shows the main fields of Classification on the Assets application.

Figure 2-19  Classification main fields

A good example of using classification is when you have an asset from IT and that asset has characteristics such as memory size, disk size and processor speed as shown in Figure 2-20 on page 30.
Also in Figure 2-20, you see an example of two instances of the same attribute MEMORY SIZE for the same Asset. It is possible only because we are using one resource named Section. The Section is the resource used when the system administrator has to add the same attribute/specification twice for the same asset, otherwise it is not possible.

2.6 Database Configuration

Database Configuration is the application responsible for the major configuration that a System Administrator can do, including attributes and indexes.

In the following example, we show how many changes can be made by using Database Configuration:

1. In the Service Request application, open a request, then click Detail Menu in the Asset field and then click Select Value. The window shown in Figure 2-21 on page 31 opens.

Also refer to Chapter 9, “Service Requests” on page 177.
2. On the Filter By field, press ALT+F1 to see the field properties, as shown in Figure 2-22.

Here, the **Table** is the database configuration object and **Column** is the attribute.

With the information in the example, you can check the database properties in the Database Configuration application.

3. Select **Go To → System Configuration → Platform Configuration → Database Configuration**.

The Database Configuration is displayed on the List tab.
4. Search for the object **SR** and open it in the Attribute tab, as shown in Figure 2-23.

![Attributes tab on the Database Configuration](image)

In this window, you may change several configurations such as:

- Description
- Type
- Length
- Title
- Class
- Domain
- Default Value
- Alias

Depending on the business requirements, you may change the Default Value to the most used option. This kind of change can also be performed for other fields and other applications.
2.7 Application Designer

With a significant focus on configuration tools such as Application Designer for modifying the user interface and Database Configuration for adding features such as new tables and columns, IBM Maximo Asset Management helps you more easily tailor the software without custom programming. In some cases, the creation of new fields is required, however sometimes simply displaying hidden fields in the user interface is the answer.

To access the Application Designer, select **Go To → System Configuration → Platform Configuration → Application Designer**. The List tab of Application Designer is displayed. When an application is selected (assets for example) the window shown in Figure 2-24 opens.

![Application Designer main window](image-url)
In the Application Designer, you may add fields to an application. For example, you may add GL Account field on an existing application, such as Assets. So, in this example, on the Application Designer you would have to add the Asset Object GL account attribute, and the GLNAVIGATOR lookup fields.
Preventive Maintenance

This chapter provides helpful information about the Preventive Maintenance module. Preventive maintenance (PM) work is performed on a regular schedule in order to keep assets running efficiently. The applications in the Preventive Maintenance module can help you plan and budget for regular maintenance work by planning the labor, material, service, and tools required of your regularly scheduled maintenance and inspection work orders.

The Preventive Maintenance module consists of two main areas:

- Master Preventive Maintenance application
- Preventive Maintenance application

This chapter should help you understand the differences between the applications and how to use them in your daily business.

This chapter contains the following topics:

- “Master Preventive Maintenance application” on page 36
- “Preventive Maintenance application” on page 36
- “Working with the Master PM” on page 37
- “Working with Preventive Maintenance records” on page 42
3.1 Master Preventive Maintenance application

You use the Master Preventive Maintenance (Master PM) application to create generic maintenance templates, which can be for preventive maintenance, inspections, or any other type of periodic work. You can specify the frequency that the work should be performed, seasonal dates that apply to the PM, and one or more job plans that apply to the PM. Job plans are created in the Job Plans application (refer to 3.4.2, “PM job plans” on page 43 for more details). Job plans list tasks, labor, materials, service, and tool requirements necessary to complete preventive maintenance, inspection, or other work that can be planned in advance.

**Note:** Master PM records are defined at the system or database level in IBM Maximo Asset Management multisite functionality.

IBM Maximo Asset Management multisite functionality provides large enterprises a way to standardize and share certain kinds of data between facilities while keeping other kinds of data, such as work management data, unique to a particular site. The multisite capability also allows you to selectively give users access to data at different sites. For more information on multisite implementation, refer to *Multisite Administration Guide* at:


You use the Master PM application to define generic preventive maintenance records, either for general maintenance, or for rotating items. Master PM records can be used to create site-specific associated PM records. When you use a Master PM to create an associated PM, IBM Maximo Asset Management copies the data to the associated PM, which can then be modified as necessary.

3.2 Preventive Maintenance application

After creating a Master PM template, you may use it to create associated PMs. Associated PMs are *non-master PMs* that are created and managed in the Preventive Maintenance application and are defined for a specific asset or location. Non-master PMs are used to generate Preventive Maintenance work orders for assets and locations.

**Restriction:** You do not generate work orders with Master PMs or include them in PM hierarchies.
Preventive Maintenance (PM) records are defined at the Site level. You create PM records for a specific asset or location, at a specific Site. PM records can only be used to generate PM work orders at their specified Site. You can group PM records into hierarchies that reflect asset or location hierarchies.

3.3 Working with the Master PM

The section should help you understand the tasks that can be performed within the Master PM application.

3.3.1 Creating a Master PM

When you create a new Master PM, IBM Maximo Asset Management enters a value in the Item Set field based on the Site listed on your person record. You have the option of specifying a rotating Item for the Master PM.

To create a new Master PM, select Go To → Preventive Maintenance → Master PM, as shown in Figure 3-1. The Master PM application opens.

![Open Master Preventive Maintenance](image)

By default IBM Maximo Asset Management selects the following check boxes:

- Create Associated PMs for Items Location?
- Create Associated PMs for Items Asset?

These selections allow you to create associated PMs for any location or asset record that lists the item in the records rotating Item field as shown in Figure 3-2.
In addition, by creating the Master PM, you can add a Frequency, Seasonal Date, and Job Plan Sequence to the Master PM, which are explained as follows:

- Frequency tab is used to define the (enter, view, or modify) scheduling criteria to use when generating work orders. The Frequency tab contains two sub tabs:
  - Time Based Frequency tab defines the Frequency Units (days, weeks, months, and years) and Frequency that should be used when generating time-based PM work orders.

The frequency criteria for the PM are defined as in Table 3-1.

**Table 3-1 Frequency criteria**

<table>
<thead>
<tr>
<th>Type of PM</th>
<th>Criteria for when PM alert is generated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time-based PMs</td>
<td>If the Next Due Date minus the Alert Lead is less than or equal to the system date.</td>
</tr>
<tr>
<td>Meter-based PMs on an asset</td>
<td>If the Next Meter Reading minus the Current Reading, minus the Alert Lead is less than or equal to zero.</td>
</tr>
<tr>
<td>Meter-based PMs on a location</td>
<td>the Next Meter Reading minus the Current Reading, minus the Alert Lead is less than or equal to zero.</td>
</tr>
</tbody>
</table>

The three options to calculate the appropriate start date are:

- **Use Last WO’s Start Information to Calculate Next Due Frequency**
  Select this check box if you want the due dates of generated work orders to be calculated from the target start date of the last work order. If you do not want to calculate the Next Due Date based on the target start of the last work order, clear the check box. For example, if you want the next work order to be generated when the last work order was actually completed instead of when it started, clear the check box.
• Generate WO Based on Meter Reading (Do Not Estimate)
  Select this check box if you want work orders generated only when the
defined meter reading has been reached. Clear this check box if you
want the next work order due date to be based on the average metered
usage.

• Generate WO when Meter Frequency Is Reached
  Select this check box if you want work orders for this PM to be
automatically generated when the meter frequency has been reached
and entered. This check box can only be selected if the Generate WO
Based on Meter Reading (Do Not Estimate) check box has been
selected.

  – Meter Based Frequency tab is used to define one or more continuos
    Meters and the criteria that determines when PM work orders should be
generated based on meter readings.

  **Note:** Use the Job plans or Locations Application to trigger
  meter-based preventive maintenance.

  ▶ Seasonal Date tab can be used to specify a PM's active months or
    seasons. You use the Seasonal Dates tab to specify the active days, dates, or
    seasons for a PM. For example, your plant runs a five-day week, and does
    not run on Saturday or Sunday. If you do not want IBM Maximo Asset
    Management to generate PM work orders that are due on the weekend, you
    would clear the Saturday? and Sunday? check boxes. If the PM is for
    seasonal work, such as air conditioning maintenance, or servicing snow
    removal equipment, you can use the Active Dates table window to indicate
    the start and end dates for the period of time that the PM should be active.
    You can list multiple active periods. When IBM Maximo Asset Management
    generates PM work orders, it checks the active dates listed on the Seasonal
    Dates tab as shown in Figure 3-3 on page 40.
Job Plan Sequence tab describes the tasks that have to be performed on a work order, and the labor, materials, services, and tools that are necessary. Figure 3-6 on page 43 shows the Job Plan section in detail.

Job plans are created in the Job Plans application.

**Note:** Job plans have to be activated before they are available to other applications.

Job plans are usually asset-specific; they are written for a specific asset, item, or location. For example, if you have a job plan for monthly maintenance and a different job plan to be used once a quarter, the sequence for the monthly job plan would be 1 (every month) and the sequence for the quarterly job plan would be 3 (every three months). Figure 3-4 shows the Job Plan Sequence.

**Additional information**

More information about the use of this three actions are explained in the *IBM Maximo User's Guide:*

Master PM records are templates, that are used to create other PM records with the Create Associated PMs action in the Master PM Select Action menu. Refer to 3.3.2, “Creating associated PM records” on page 41.

Associated or non-master PM records are viewed and managed in the Preventive Maintenance application.

**Note:** Job plans that have a Site specified for the record cannot be associated with a Master PM because they are Site specific.

You can use the Update Associated PM action in the Master PM application to copy updated information from a Master PM to its associated PMs. Refer to 3.3.3, “Updating associated PM records” on page 41.

### 3.3.2 Creating associated PM records

Associated preventive maintenance records can be added to the PM record.

To add a new or further PM record to a Master PM, select Select Action → Create Associated PMs, as shown in Figure 3-5. Then, select the entries from the list. This process can be used for one or several records.

![Figure 3-5  Create Associated PMs](image)

### 3.3.3 Updating associated PM records

A Master PM can be associated with PMs at more than one site. When you use the Update Associated PMs action to update PM records, you can select which sites you want to update. To update associated PM records, select Select Action → Update Associated PMs. Then, select the entries from the list.

**Important:** IBM Maximo Asset Management only updates PMs for an asset or location if the meters on the asset or location record match all of the meters listed on the Master PM.
For detailed information about updating associated PM records, refer to The Preventive Maintenance Module in the *IBM Maximo User’s Guide*:


### 3.3.4 Deleting Master PM records

If a Master PM record does not have any associated PMs, it can be deleted by selecting **Select Action → Delete Master PM**. IBM Maximo Asset Management displays a message if the Master PM cannot be deleted.

### 3.4 Working with Preventive Maintenance records

A Preventive Maintenance (PM) record is a plan to perform periodic work on an asset or location, or a group of assets and locations that are listed on a route. Many assets and locations require regular maintenance to ensure uninterrupted efficiency and to guard against breakdowns. Assets and locations might also require other non-preventive maintenance work that must also be figured into maintenance schedules, for example, periodic inspections.

#### 3.4.1 Ownership of PM records

Individuals or groups can assume responsibility, or *ownership*, of a work order in IBM Maximo Asset Management. When a group owns a work order, all members of that group see the work order in their Work View. If a member of a group takes ownership of a work order, they are responsible for managing the work order until it is complete, or delegated to another group or person.

Job plan and preventive maintenance records contain Owner and Group Owner fields. When you generate a PM work order or apply a job plan to a work order, IBM Maximo Asset Management automatically copies the values in these fields to the work order. You may also assign ownership to a work order by using the Select Owner and Take Ownership actions in the Work Order Tracking application.

For more information about ownership and how to create workflow, refer to the *IBM Maximo User’s Guide*:

3.4.2 PM job plans

You can specify one or more job plans on a PM record. A job plan describes the tasks that have to be performed on a work order, and the labor, materials, services, and tools that are necessary. Job plans are created in the Job Plans application and have to be active before available. Job plans are usually asset-specific; they are written for a specific asset, item, or location. Figure 3-6 shows the Job Plan Sequence form in detail.

![Figure 3-6 Job Plan Setup](image)

Job plans are defined at the system level in Multisite, but can contain details that are specific to organization and site. When IBM Maximo Asset Management copies job plan data to a PM work order, it copies the information about the job plan that applies to the work order Site.

PM records and routes

You use the *Routes application* to create lists of related work assets, which are considered *stops* along the route. These route stops can be assets or locations, or a combination of the two. When you list a route on a PM record and generate work orders, IBM Maximo Asset Management creates a work order hierarchy with a top level work order, child work orders or standalone work orders for each of the route stops.
3.4.3 PM hierarchy

A PM hierarchy is a group of PMs arranged in parent-child relationships. At the highest level of a PM hierarchy, one PM is the parent. This top-level PM can have one or more child PMs. Each child PM can have one or more children, and so on. A child PM can only have one parent PM. You can create PM hierarchies that mirror your asset and location hierarchies, as shown in Figure 3-7.

You use PM hierarchies to generate hierarchies of scheduled work orders. When one PM in the hierarchy is due to be generated, IBM Maximo Asset Management generates the PM work orders for every PM in the hierarchy. You can enable this feature for children by selecting the Use this PM to Trigger PM Hierarchy? box. In addition, you can add a sequence number to each PM in a PM hierarchy; the sequence number is copied to work orders you generate from the PM.

To create a PM hierarchy, select Go To → PM Hierarchy Tab in the PM and click New Row. Then, select the entry from the list.

You cannot delete a PM record that is part of a hierarchy. PM records that have a parent or child PMs must be removed from their hierarchies before you can delete them.

Attention: To change the hierarchy to be driven by a child PM, you have to select the Override Updates from Master PM? check box.

3.4.4 PM routes

You use the Routes application to create lists of related work assets, which are considered stops along the route. These route stops can be assets, locations, or a combination of the two. When you list a route on a PM record and generate work orders, IBM Maximo Asset Management creates a stand-alone work order
or a work order hierarchy with a top level work order, and child work orders for each of the route stops.

Further details are specified in the *IBM Maximo User’s Guide:*


### 3.4.5 PM alerts

All PM related alerts are not configured in the PM application directly. To set up the notification, you have to use the Organization application. You have the option to combine the alerts with the following criteria:

- **Generate WOs Due on the Current Date Plus this Number of Days.**
  
  Enter a lead time value in days. The lead time value causes work orders to be generated a specified number of days in advance of the current date. The default is no lead time.

- **Use Priority from Job Plans on Sequenced PMs?**
  
  If you want the system to use the work order priority from job plans in generating sequence PMs, select this check box. The default is not checked.

- **Use Frequency Criteria?**
  
  If this box is selected (the default), the system evaluates the selected records to determine which PMs are due to generate work orders. The system calculates a PM's due date from the frequency criteria on its Frequency tab. If a PM is part of a hierarchy, it can trigger work order generation from the entire PM hierarchy. Clear this check box to generate work orders for the selected set's top-level PMs and PMs that are not master PMs. If a top-level PM of a hierarchy is in the selected set, you also generate work orders for its child PMs.

- **Base Work Order Generation on Meter Reading Only (Do Not Estimate)?**
  
  Select this check box if you want the system to generate the work order only when the meter reading reaches the meter frequency specified on the Frequency tab (Meter Based Frequency sub tab). If the check box is cleared, the system generates the PM work order by estimating when the meter will reach the frequency, based on the value in the Average Units/Days field on the same sub tab.

To configure the Alerts for PM, select **Go To → Administration → Organizations**, and then select the appropriate Organization.

The Select Action menu enables you to configure the PM Options. Figure 3-8 on page 46 shows the details.
In addition to the PM Options, your system administrator can use the Cron Task application to set up a PM cron task. A cron task is a software command to execute a task at a scheduled time. To configure the cron task for PM, select Go To → System Configuration → Platform Configuration → Cron Task Setup

Then, follow the instructions as described:

1. Query for the PMWoGenCronTask.
2. Select the Cron Task tab.
3. Select the New Row button.
4. Enter a Cron Task Instance Name and update the description as applicable.
5. Set the schedule.
6. Select the Active check box.
7. Select the Parameters sub-tab.
8. Update the Value field as applicable with the correct path to the log.
9. Select the Save button.

The example in Figure 3-9 on page 47 shows the Cron Task configuration.
If you want to configure WO creation for each of your PM, select **Select Action → Generate Work Order** from the Preventive Maintenance application and fill in the details as shown in Figure 3-10.

**Tip:** Use the *Organization application* to generate PM alerts for your work orders. Ensure that your PMs are set up to indicate when the alert will occur.

In addition, ensure the PM cron task is set up to automatically generate PMs.
Inventory

This chapter describes the Inventory module in IBM Maximo Asset Management. It goes through the initial setup required and covers all the applications included in the module.

This chapter contains the following topics:

- “Inventory module” on page 50
- “Initial setup” on page 50
- “Inventory applications” on page 56
4.1 Inventory module

The Inventory module is used to manage spare parts inventory. The business goal is to find a balance of inventory stock, allowing maintenance work to be performed with minimum delays if materials are unavailable, but without keeping unnecessary or seldom used item in stock.

In summary, it works to balance two conflicting objectives:
- Maximizing the availability of items for upcoming work tasks
- Reducing excess inventory balances and related carrying costs

The Inventory module consists of the following applications:
- Item Master
- Service Items
- Tools
- Stocked Tools
- Inventory
- Issues and Transfers
- Condition Codes
- Storerooms
- Companies
- Purchase Orders

4.2 Initial setup

This section describes the initial settings that must be set up before you start using the applications to create and manage items.

4.2.1 Units of measure and conversion

Before you create item records, define all units of measure and the conversion values for those units.

To configure the units of measure, access the Select Action menu (shown in Figure 4-1 on page 51) that is available in the following applications:
- Item Master
- Service Items
- Tools
- Stocked Tools
- Inventory
Add or modify units of measure
A unit of measure describes the increment that you order or issue, or the item or tool that you transfer, or service you order.

The three attributes that define a unit of measure are: *Unit of Measure*, *Description*, and *Abbreviation*. However, only two of them, *Description* and *Abbreviation*, are editable after the unit of measure is created.

Figure 4-2 shows how to create the unit of measure.

Add or modify conversions
A conversion factor is a numeric value that is applied to relate one unit of measure to another (ratio).
The four attributes that should be defined when creating a conversion factor are *From Unit of Measure*, *To Unit of Measure*, *Conversion Factor*, and *Item Number*. All of them are required, except for the Item Number. This last attribute should be used when the conversion is directly associated to the item. For example, a CASE for one item might be 24 and for another item it might be 36. However, the numbers 24 and 36 represent the quantity within the case and not the issue unit. If you receive a case of 24 gaskets, but you issue them in sets of four, then the conversion ratio for CASE in this example would be 6. You can assign the conversion of a CASE of 24 gaskets to be 6, and associate it to the item gaskets.

Figure 4-3 shows the window for creating and modifying conversion factors.

![Add/Modify Conversions](image)

**Figure 4-3  Add/Modify Conversions**

### 4.2.2 Commodity groups and commodity codes

A commodity identifies a product category. Some companies organize their purchasing departments by commodity. Purchasing managers may create budgets, create and manage purchase orders, and manage vendor relationships based on commodities.

You may create commodity group and commodity code records in the system that can be applied to item, company, purchasing, and contract records. When
you associate a commodity group and commodity code with an item record, users (for example planners or purchasing agents) are then able to search for items by commodity code.

A commodity group can have multiple commodity codes associated with it, and a commodity code can only belong to a single commodity group. Also, commodity codes are defined at the level of the item set, and commodity group names must be unique for the item set.

To configure the commodity groups and codes, access the Select Action menu shown in Figure 4-4 and that is available in the following applications:

- Item Master
- Service Items
- Tools
- Companies
- Purchase Orders

![Select Action Menu](image)

**Figure 4-4  Add/Modify Commodity Codes selection**

### 4.2.3 Item sets

Item sets are Inventory items and materials, service items, and tools are created as part of an item set. An item set consists of an ID that identifies a list of items that can be shared by one or more organizations. Only one item set can be specified for an organization, but more than one organization may use the same item set. Items and tools can be transferred between organizations that share the same item set.

**Note:** Sets are in a level between system and organization.

When you create item records, all item identifiers must be unique within an item set. Everywhere that an item ID is referenced on a record there is also an item set ID.

Item sets are created in the Sets application, which you can access by selecting **Go To → Administration → Sets**.
4.2.4 Organizations settings

This section describes the inventory options that can be set up from the Organizations application. From the Start Center, select Go To → Administration → Organizations. From the Select Action menu, you may select Inventory Defaults, Reorder, or Inventory Costs, as shown in Figure 4-5, to open their associated dialog windows.

![Inventory Options action menu](image)

**Figure 4-5  Inventory Options action menu**

### Inventory Defaults

In this dialog, you may set up the values for the *ABC analysis*, which is explained in 4.3.5, “Inventory” on page 65, and specify whether the system will allow users to issue or transfer items with a negative current balance or negative available balance, as shown in Figure 4-6.

![Inventory Defaults dialog](image)

**Figure 4-6  Inventory Defaults dialog**

*Note:* The Sets application enables you to create two types of sets: *Item Sets* and *Company Sets.*
Reorder
In this dialog, you set up how the external and internal requests should be created when reordering items. Limiting the number of reorder lines per PO/PR, is also possible (see Figure 4-7). Limiting the number means, for example, that IBM Maximo Asset Management will create a second PO/PR for the same supplier, with remaining lines. These settings apply to all requests and orders.

![Inventory Reorder dialog](image)

Figure 4-7   Inventory Reorder dialog

Inventory costs
The Inventory costing model is part of the initial setup and can be set in the Organizations application. The dialog is shown in Figure 4-8 on page 56.

Two options must be set:

- *Issue Cost* specifies whether the system uses standard cost (the default) or average cost when an item is issued.

- *Non Capitalized Rotating* specifies whether the system uses issue cost (the default) or asset cost when a non-capitalized rotating asset is issued.

**Note:** The issue costing model settings are applied only to the selected site.
4.3 Inventory applications

This section describes each application included in this module.

4.3.1 Item Master

The Item Master application is used to define items that will be stocked in your storerooms.

When you create an item record, you define the possible attributes of the item, such as commodity codes, order and issue units, whether the item is lotted, rotating, or condition-enabled. With that, you also set any alternate items use in an item’s place and a list of the condition codes you want applied to the item.

To access the application, select **Go To → Inventory → Item Master**.

**Item Master tabs**

The Item Master application has the following tabs.

- List
  
  Use this tab to search for item records. Although you may also use it to change status of multiple items, the tab has no other special action.
Item

This tab is the main tab of the application. Use it to enter, view, or modify items. The two required fields for new items are: Item identifier and Lot Type (although Lot Type is not required for rotating items).

In this tab, you may also specify the main attributes for the items, such as commodity codes, meter, order and issue units, whether the item is rotating, kit, lotted or condition-enabled, and other attributes.

Use the alternate sub tab to define items that can be used in place of other items. Use the Condition Codes sub tab to add condition codes that you want applied to the item. For more information, see 4.3.7, “Condition Codes” on page 70.

Note: The alternate item relationship is not automatically reciprocated when you insert an alternate item to the current item record. If you want two items to be alternate to each other, each record should specify the other item as an alternate.

Note the following important concepts regarding the Item tab:

- Rotating item

  A rotating item is a special category of item record, used to indicate items that can be used interchangeably as a replacement for a like item, such as fire extinguishers, motors, or pumps, but that are repaired or refurbished when they are removed from service. Rotating items can be managed like any other item record; they can be stocked in storerooms, issued and transferred, reordered and so forth. For example, if you have to create a maintenance schedule for a rotating item, you must create an asset record, mark it as rotating, and refer to the item. For more details about how rotating assets works, refer to Chapter 2, “Assets” on page 11.

  Note: An item cannot be both a spare part and a rotating item because rotating items are maintained, and spare parts items are consumed or used once.

- Item kit

  An item kit is a collection of items that can be issued as a single unit comprising of a parent item record and associated child item records. Item records contains a Kit? check box, which indicates that the item will act as the virtual container for all other items contained within the kit.

  Note: Item kits cannot be lotted, rotating, or condition-enabled.
► Storerooms

Use this tab to view a read-only list that has information about storerooms that stock the item. Examples are the costs and the balance for each storeroom.

To add an item to a storeroom, select **Select Action → Add items to Storeroom**, as Figure 4-9 shows. This action is accessible in all tabs of the Item Master application.

![Select Action](image)

*Figure 4-9  Add Items to Storeroom action*

► Vendors

Use this tab to enter, view, modify, or delete information about vendors and manufacturers for an item. The list can include vendors that you have previously ordered from, and vendors that you have not purchased the item from. You may use the vendor data to compare prices and delivery information.

► Specifications

Use this tab to classify an item, and add, view, modify, or delete specifications that give details about the attributes of the item.

► Item Assembly Structure

Use this tab to enter, view, or modify an item assembly structure (IAS). An IAS is a list of individual items and subassemblies that are required when you build an asset or define the requirements of a location. Rather than specify item components each time you enter an individual asset or a location, you create an item assembly structure as a template. You may use an IAS as a template when building multiple asset assembly structures and their related location systems.
**Item status**

Item status can have the following values:

- **Active**
  
  Items in this status can be selected and used in the other applications.

- **Pending**
  
  This status is the default value for new records. These items cannot be used anywhere outside Item Master and Inventory applications.

- **Pending Obsolescence**
  
  Items can be depleted from storerooms, but no balance replenishment is allowed.

- **Obsolete**
  
  Items are permanently unavailable for use.

- **Planning**
  
  Items can be referenced in work order plans, POs and PRs, but they cannot have financial transactions created against them.

When changing the status of an item, you may roll new status to Organizations and Inventory. This step can be done by selecting the check box shown in Figure 4-10.

![Figure 4-10  Item change status dialog](image)

### 4.3.2 Service Items

The *Service Items* application is used to define and manage purchased service by creating service item records and maintaining a list of vendors that supply the service item.
Service items are defined at the item set level and cannot be received into inventory or stored in a storeroom. They are always categorized as direct issue items and you can reorder a service item by using the Reorder Direct Issue Itms/Svcs action available from the Select Action menu.

Examples of service items might be janitorial invoices, telephone bills, and elevator repair service.

**Note:** Service items can be requested or ordered through the Desktop Requisitions, Purchase Requisitions, or Purchase Order applications and the line type must be set to **Standard Service** in order to request a service item.

To access the application, select **Go To → Inventory → Service Items**.

**Service Items tabs**
The Service Items application has the following tabs:

- **List**
  Use this tab to search for service records. Although you may use it to change the status of multiple service items, the tab has no other special action.

- **Service**
  This tab is the main tab of the application. Use it to enter, view, or modify service items. This tab has only one required field, which is the Service Item identifier.

  Other primary attributes, such as commodity codes, whether an inspection is required, and others can also be specified in this tab.

  Use the Vendor sub tab to maintain a list of vendors that supply the service item. For each vendor, you may specify and track the last price for that service and the promised lead time from the vendor for this service item.

- **Specifications**
  Use this tab to classify an service item and add, view, modify, or delete specifications that give details about the attributes of the service item.

**Service Item status**
The Service Items application has the same status values as the Item Master application.
The status values can be:

- **Active**
  These items can be selected and used in the other applications.

- **Pending**
  This status is the default value for new records. These items cannot be used in other applications.

- **Pending Obsolescence**
  These items can be depleted from storerooms, but no balance replenishment is allowed.

- **Obsolete**
  These items are permanently unavailable for use.

- **Planning**
  These items can be referenced in work order plans, POs and PRs, but they cannot have financial transactions created against them.

When changing the status of an service item, you may roll new status to Organizations. This can be done by selecting the check box shown in Figure 4-11.

![Change Status](image)

**Figure 4-11  Service item change status dialog**

### 4.3.3 Tools

The *Tools* application is used to manage information about the tools used to perform work. Tools are typically non-consumable items for which you charge an hourly rate for their use. Examples of tools include air compressors, nail guns, calibration equipment, and heavy equipment such as cranes and excavators.

You catalog these tools in an item set, which can then be shared by the organizations using that item set. You may add these tools to storerooms, and use them on job plans and work orders. When you use a tool on a work order,
IBM Maximo Asset Management can reserve the tool in the specified storeroom. You may also issue, receive, and transfer tools from storerooms.

When you create a tool record, you are defining the main attributes of the tool (such as commodity codes, issue unit, whether the tool is lotted, or rotating), along with any alternate tools that can be used in its place and a list of the qualifications necessary for a person to use the tool. All tools are marked as capitalized.

To access the application, select **Go To → Inventory → Tools**.

**Tools tabs**
The Tools application has the following tabs:

- **List**
  
  Use this tab to search for tools records. Although you may use it to change status of multiple tools, the tab has no other special action.

- **Tool**
  
  This tab is the main tab of the application. Use it to enter, view, or modify tools. The two required fields for new tools are the *Tool* identifier and the *Lot Type* (although Lot Type is not required for rotating tools).

  Other main attributes, such as commodity codes, issue unit, whether the tool is lotted or rotating, and others can also be specified in this tab.

  Use the alternate sub tab to define tools that can be used in its place.

  **Note:** The alternate tool relationship is not automatically reciprocated when you insert an alternate tool to the current tool record. If you want two tools to be alternate to each other, each record should specify the other tool as an alternate.

  Use the Required Qualifications sub tab to define a list of qualifications necessary for a person to use the tool.

- **Storerooms**
  
  Use this tab to view a read-only list with information about storerooms that stock the current balance for each storeroom.

  To add a tool to a storeroom, select **Select Action → Add Tools to Storeroom**, as Figure 4-12 on page 63 shows. This action is accessible in each tab of the Tools application.
Figure 4-12  Add Tools to Storeroom action

- **Vendors**
  Use this tab to maintain a list of vendors that supply the tool. For each vendor, you may specify and track the last price for that tool, the promised lead time from the vendor, its Web page, and other relevant information.

- **Specifications**
  Use this tab to classify a tool, and add, view, modify, or delete specifications that give details about the attributes of the tool.

**Tools status**
The Tools application has the same status values as the Item Master application. The status values can be:

- **Active**
  This status indicates that these tools can be selected and used in the other applications.

- **Pending**
  This status is the default value for new records. These tools cannot be used in other applications.

- **Pending Obsolescence**
  This status means the tool can be depleted from storerooms, but no balance replenishment is allowed.

- **Obsolete**
  This status means the tools are permanently unavailable for use.

- **Planning**
  This status means these tools can be referenced in work order plans, POs and PRs, but they cannot have financial transactions created against them.
When you change the status of a tool, rolling a new status to Organizations and Inventory is possible by selecting the check box shown in Figure 4-13.

![Change Status Dialog](image)

**Figure 4-13** Tools change status dialog

**Note:** You may select a tool to use it in the work plan if its status is *Active*. However, to reserve the tool for use, it must be available in a storeroom.

### 4.3.4 Stocked Tools

The *Stocked Tools* application is used to manage existing tools in storerooms, although creating new tool records by using it is not possible.

**Note:** To create new tool records, use the Tools application.

Examples of using the Stocked Tools application include tracking tool balances down to the bin and lot level for a storeroom, tracking vendors that supply a tool, and reordering details such as price and lead time for orders. You may also view rotating assets that list the tool as the rotating item on the asset, and also assets that list the tool as a spare part.

**Note:** Different from the previous applications, the Stocked Tools application manages tool inventory at the site level.

To access the application, select **Go To → Inventory → Stocked Tools**.
Stocked Tools tabs
The Stocked Tools application has the following tabs:

- **List**
  
  Use this tab to search for tools and storerooms records. Although you may use it to change status of multiple tools, the tab has no other special action.

- **Stocked Tool**
  
  Use this tab to view and modify information about the tools used for maintenance work. You can also view the main tool attributes and other information such as balance summary and issue history.

  Use the Balances sub tab to either add a new bin with current balance and physical count, or manage existing bins for this tool by adjusting balances, physical counts, and reconciling balance data.

- **Vendors**
  
  Use this tab to maintain a list of vendors that supply the tool. For each vendor, you may specify and track the last price for that tool, the promised lead time from the vendor, its Web page, and other relevant information.

- **Rotating Tool Assets**
  
  Use this tab to identify and track rotating assets associated with a rotating tool record.

- **Where Used**
  
  Use this tab to list all assets to which a tool is listed as a subassembly or spare part.

### 4.3.5 Inventory

An inventory is a listing of all items, materials, and rotating assets that are stored in your storerooms. With IBM Maximo Asset Management, you create item records in the Item Master application, and you create storeroom records in the Storerooms application, but you manage your inventory in the Inventory application.

Inventory records refer to an item/location combination, usually an item at a storeroom location. Items are added to storerooms by using the Add Item to Storeroom action in the Item Master application.

By using the Inventory application, you can track item balances down to the bin and lot level for a storeroom, and track item costs by using condition codes. You may track vendors that supply an item, and reorder details such as price and lead time for orders. You can view rotating assets that list a rotating item record, and view assets that list the item as a spare part.
From the Inventory application, you may also issue and transfer items, assemble and disassemble kits, and change the balances and costs.

**Note:** When you assemble or disassemble kits, the Inventory application automatically changes the balances for the items that are being used in the kit.

To modify the balances and costs, select **Inventory Adjustments** from the Select Actions menu, and then select any of the actions shown in Figure 4-14.

![Current Balance action menu](image)

**Figure 4-14**  Current Balance action menu

To access the application, select **Go To → Inventory → Inventory.**

**Inventory tabs**

The Inventory application has the following tabs:

- **List**

  Use this tab to search for item/location combination records. Although you may also use it to change status of multiple items, the tab has no other special action.

**Note:** The Inventory application tracks items and materials in storerooms, which are at the site level. Therefore, the Inventory application is managed at the site level.
Inventory

Use this tab to enter, view, or modify item balances, costs, balances, bins and lots, and to view storeroom locations where the item is stocked.

The three required fields in this tab are:

- Stock Category field specifies whether the item is a stocked (STK), non-stocked (NS), or a special order (SP) item.
- Issue Unit field specifies standard quantity by which the item is issued from the storeroom, such as each or roll.
- Count Frequency field specifies the number of days between an audit or count of an inventory item.

Use the Inventory Balances sub tab to specify the storage information for the items and the balances, and other information such as expiration date.

Note: If the expiration date is not provided, you may provide the shelf life (in days), and then the system will calculate the expiration date.

Use the ABC Analysis sub tab to quickly identify which inventory items represent your company's greatest investment in terms of monetary value and turnover rate. This approach helps ensure that crucial inventory does not fall below minimum levels, and helps keep current balance figures for an item reconciled with the actual count. The ABC type value for an item is determined by running an ABC Analysis report, which multiplies the current year-to-date (YTD) issued quantity by the last cost of the item. The items are then sorted in descending order of the currency value reached by this calculation. The type is set to A, B, or C based on a percentage you (system administrator) set in the Inventory Defaults dialog box in the Organizations application.

Reorder Details

Use this tab to enter, view, or modify reorder details for inventory items, such as the reorder point, lead time, and issue units of an item.

You may enter or view information about one or more vendors for an item, and information about multiple manufacturers or models for each vendor.

The Reorder Point (ROP) is the point at which items should be reordered so that their number does not fall below the number designated as safety stock during the lead time for the order. Ideally, the calculation of the ROP is based on the following variables:

- Safety Stock is the minimum number of the item that you must have available at all times.
– **Lead Time** is the amount of time between placing an order and delivery of the items.

– **Economic Order Quantity** is the number of an item that should be reordered at one time, usually based on the vendor's price for a particular quantity ordered. For example, buying a case of an item might cost less per item than buying the item individually.

➤ **Rotating Asset**

Use this tab to identify and track rotating assets associated with a rotating item record.

You may assign an inventory item number to assets so that they can be stocked and reordered as necessary. A rotating asset is generally repaired rather than replaced, and it can be rotated between different plant locations or different parent assets.

➤ **Where Used**

This tab lists assets on which the item is used. If you use the Spare Parts tab (in the Assets application) to associate the item with an asset, the assets are automatically copied to the Where Used tab.

### 4.3.6 Issues and Transfers

The *Issues and Transfers* application is used to manage the movement of inventory items out of the storerooms. You *issue* an item when it is moving out of a storeroom to be used. You *transfer* an item when it is moving between storerooms.

**Note:** Because the Inventory and Storerooms applications are at the site level, Issues and Transfers are also managed at the site level.

To access the application, select **Go To → Inventory → Issues and Transfers**.

**Issues and Transfers tabs**

The Issues and Transfers application has the following tabs:

➤ **List**

Use this tab to search for location records.

➤ **Issue**

Use this tab to issue items and tools from a storeroom directly to a work order, asset, location, or against a general ledger account. You may also use
this tab to return items and tools to a storeroom. When you issue an item or tool, the balance is updated in the storeroom.

To issue an item previously reserved for the selected storeroom, use the Select Reserved Items dialog. You may also issue a non-reserved item by selecting the **New Row**, and return previously issued items by using the Select Items for Return dialog.

**Note:** When returning an item, if you cannot find a prior issue transaction for it, you may return it by creating an issue transaction of type RETURN.

An option exists to change the reservations for each storeroom; use the **Add/Modify Reservations** from the Select Action menu. You may create, modify, and delete the reservations. For more details, see Figure 4-15.

![Add/Modify Reservations dialog](image)

**Figure 4-15  Add/Modify Reservations dialog**

- **Transfer Out**

  Use this tab to transfer items and tools out of your storeroom to either a location (courier, labor, storeroom) within a site or to a courier if transferring across sites or organizations.

- **Transfer In**

  Use this tab to transfer items or tools into your storeroom from another location (courier, labor, storeroom) within a site or from a courier if the transfer was across sites or organizations.
4.3.7 Condition Codes

The Condition Codes application is used to build the master list of condition codes for a particular item set.

A condition code enables you to specify that an item record has a different value depending on the physical condition of an item. For example, an item that has been damaged, worn, used, or rebuilt would not have the same value as a new item. A condition code has a rate associated with it, which can be used to calculate the value of non-new inventory items. For example, you might create two conditions for an item:

- New, which is the value of the item at 100%
- Used, which is the value of the item at 50% of the full value

To access the application, select Go To → Inventory → Condition Codes.

Note: Condition Codes are defined at the item set level. Item sets exist below the System level, but above the Organization level so that Organizations can share data.

4.3.8 Storerooms

The Storerooms application is used to add and maintain information about storeroom locations, view items that are stocked in a storeroom, and define the GL account codes to be associated with a storeroom.

A storeroom is a location that contains inventory items. Storerooms have general ledger account codes associated with them to help track inventory costs.

Note: Storerooms are defined at the site level.

To access the application, select Go To → Inventory → Storerooms.

Storerooms tabs

The Storerooms application has the following tabs:

- List
  Use this tab to search for storerooms records.
- Storeroom
  Use this tab to create, modify, and delete storeroom locations, define the general ledger account (GL Account) codes to be associated with the
storeroom, define the lead time calculation for items in a storeroom, and optionally flag the storeroom to function as an internal supplier to other storerooms.

When you create a new storeroom, specify information for the following account data fields:

- **GL Control Account** field is the default GL account applied to items in this storeroom. It tracks cost on every inventory transaction made with the storeroom.
- **Cost Adjustment Account** field is the account that tracks changes in either the average price or the standard price from manual inventory price adjustments.
- **Receipt Variance Account** field is the debit account to track the differences between the inventory standard cost and the receipt cost (specific to the storeroom) for any items in the associated storeroom location.
- **Purchase Variance Account** field is the account used to track fluctuations in purchase costs for items (or the variance between PO and original Last and Standard price).
- **Shrinkage Account** field is the credit account used when manually adjusting the inventory quantity.
- **Invoice Variance Account** field is the debit account used to track variances in the price, expressed in the vendor's currency, between receipt and invoice for this storeroom.
- **Currency Variance Account** field is the account containing the differences between the PO price and the invoice price that result from changes in the exchange rate.
- **Tool Control Account** is the default debit account for capitalized tools.
- **Use in PO/PR?** field specifies whether this storeroom can be used to supply and reserve inventory items and tools for use with internal purchase requisitions and internal purchase orders. If the check box is selected, you may order and reserve items or tools from this storeroom on internal POs and PRs. If the check box is cleared (the default), this storeroom cannot be used to supply items or tools internally.

► Items

Use this tab to view a read-only list of items associated with a specific storeroom. To view items from the Storerooms application, you must first either add the items to a storeroom using the Item Master application or they must be received, transferred, or returned to a storeroom.
Contracts

This chapter introduces and discusses topics that you have to be familiar with in the IBM Maximo V7.1 Contracts module before you take the IBM “Test 000-015: IBM Tivoli Asset Management V7.1 Implementation.”

This chapter explains the functions of the IBM Maximo Asset Management contracts provided in the standard installation. It also summarizes what you must know to create, implement, and maintain the Contracts module in IBM Maximo Asset Management.

This chapter contains the following topics:

- “Contract module applications” on page 74
- “Contract status” on page 76
- “Working with contracts” on page 77
- “Using terms and conditions” on page 83
5.1 Contract module applications

To meet your company requirements, contracts are used to define a certain relationship between your company and all kinds of vendors, service providers or even internal departments.

The Contracts module was designed to meet these requirements and therefore it has been divided into the following applications:

- Labor Contract

  A Labor Contract is a way to define the rates that will be paid for craft and skill combinations, as well as rates to be paid to specific laborers. You can set up a labor rate to create invoices for all approved labor transactions within a specified time period, for example every month. Labor Contracts are created in the Labor Rate Contracts application. The Labor Contracts can also cover the Labor records for external or contracted labor identified by the vendor Labor records. Refer to IBM Maximo Asset Management Product Reference Guide at:


- Lease/Rental Contracts

  A Lease Contract is an agreement to lease one or more assets from a vendor. Lease Contracts specify lease period, payment schedules, and other conditions of the contract. IBM Maximo Asset Management can generate invoices based on the payment schedule intervals. This type of agreement might involve more than two parties, because one vendor might sell the assets and another might hold the lease. Lease Contracts are created in the Lease/Rental Contracts application.

  A Rental Contract is similar to a Lease Contract. Rental Contracts specify the time period for the rental, payment schedules, and other conditions of the contract, such as in percentage of total amount due. Unlike a Lease, a Rental Contract can be terminated at will, and does not include a buy-out option in the terms of the contract. Rental Contracts are created in the Lease/Rental Contracts application.

  **Note:** The Lease/Rental Contracts application can also be used to define overall terms and conditions of an agreement between vendor and customer regarding one or more rotating assets.
Master Contract

A Master Contract defines the relationship with a vendor and contains the terms and conditions that apply to the contracts created and listed under it. Master contracts are created in the Master Contracts application. The application is used to associate many contract types for a particular vendor. For example, a master contract might list rental contracts for tools or equipment, purchase contracts for materials, a labor rate contract, and a warranty on parts and labor.

Purchase Contract

A Purchase Contract specifies the terms and conditions for a purchase. Purchase Contracts are created in the Purchase Application and provide detailed Information about a contract’s contact information or shipping and financial terms. Furthermore, this type of contract can be used for creating price, blanket, or purchase types. Refer to Figure on page 82, and also to Chapter 6, “Purchasing” on page 87 for more details).

Note: The Purchase Contract allows you to specify the maximum amount per contractor or contract.

Warranty Contract

A Warranty Contract is created in conjunction with the purchase of an asset and generally has no cost associated with it. This contract contains the details of what is covered by the warranty. If a Warranty Contract is purchased, it is considered an extended warranty by IBM Maximo Asset Management. Warranty Contracts are created in the Warranty Contracts application. You also use a Warranty Contract to create a Service Contract. A Service Contract indicates that an outside service provider maintains one or more assets. Payment for the service can be made with a single fee or schedule set of payments. Refer to IBM Maximo Asset Management Product Reference Guide at:


Software Contract

Note: The Software Contract type is only available in IBM Tivoli Asset Management for IT, not in IBM Maximo Asset Management.
5.2 Contract status

Contract status can have the following values:

- **APPR (Approved)**
  From this status, you can change the status to Canceled (CAN), Closed (CLOSE), Suspended (SUSPND), or Expired (EXPIRED).

- **CAN (Canceled or Terminated)**
  See “Deleting contracts” on page 81 for more information.

- **CLOSE (Closed)**
  See “Deleting contracts” on page 81 for more information.

- **DRAFT (Draft)**
  In this status you can edit everything according to the properties for this type of contract. From this status, you can change to Waiting on Approval (WAPPR), APPR, CLOSE, or CAN.

- **EXPIRD (Expired)**
  See “Deleting contracts” on page 81 for more information.

- **PNDREV (Pending Revision)**
  This status indicates the contract is a new revision of an existing contract. This is similar to draft, but you can only edit specified fields.

- **REVISED (Revised)**
  The system applies a Revised status when a more current revision is approved. You cannot modify anything on this contract or change the status to any other status.

- **SUSPND (Suspended)**
  See “Deleting contracts” on page 81 for more information.

- **WAPPR (Waiting on Approval)**
  When a contract is waiting for approval, you can modify anything (according to properties). You can change WAPPR to DRAFT, APPR, CLOSE, or CAN.

- **WSTART (Waiting to Start)**
  The system applies this status when you choose APPR and the start date is in the future. You may change this status to APPR.
5.3 Working with contracts

To support the daily asset management business, you have to be familiar with maintaining the required contracts. At this stage, the contract is already negotiated and signed by all parties. The Contract module is the place to store the details and to maintain the changes, but it is not the application to negotiate the content of the contract.

This section guides you through the details of maintaining the Contract module.

5.3.1 Creating contracts

When you create a new contract, choose a contract type from the list in 5.1, “Contract module applications” on page 74.

All contracts you create are defined at the organizational level, so that the purpose of each contract type has been defined. In addition, you can use the Organization application to define further contract types of your own.

How to create a contract

To create a new contract, use Go To → Contracts and select a contract type.

Figure 5-1 on page 78 shows you how to open the Contracts module to select the different kinds of contracts.
Figure 5-1  Start the Contracts Module and choose the type

When you start creating a new contract in IBM Maximo Asset Management, you include the following general information about the contract:

- Contract Identifier and Description
- Contract Type
- Status
- Vendor Reference number and details about the vendor
- Buyer
- Start Date and End Date
- Total Cost or Maximum Amount
- Contract lines
- Terms and Conditions

In addition, you indicate properties that are specific to each contract type.

How to create a Master Contract
A Master Contract is a way to associate many contract types together for the same vendor and define terms and conditions for the relationship with the vendor. A Master Contract lists all contracts that you have with a particular
vendor. Master Contracts are created in the *Master Contracts application*. Refer to 5.1, “Contract module applications” on page 74.

**Tip:** Keep in mind that when you create a Master Contract, certain fields such as total cost are for your reference only and have to be updated manually.

A Master Contract can be associated with the following types of contracts:

- Purchase Contracts
- Lease Contracts
- Warranty on assets

The following introduction guides you through the creation process:

1. To create a new Master Contract use **Go to** → **Contracts** → **Master Contracts**.
2. Fill in the description and select the company.
3. Select one or more sites from the Select Action menu.
4. Before finalizing the Master Contract, the contract has to be authorized. Choose **Select Action** → **Authorize Site**.

If you have changed the status of the Master Contract to APPR, an error message displays, as shown in Figure 5-2.

![System Message](image)

*Figure 5-2  Example, when not changing the status for the Master Contract*

Click **OK**. The status of the contract has to be approved. Therefore, click the **Change Status** button to change the status to **APPR**.

Now you may associate further underlying contract to your Master Contract.

5. Choose **Select Action** → **Create Associated Contract** and select the type of contract.

6. Save the contract. You are now able to add more contracts to the same Master Contract.
The newly created Master Contract has the status Draft. The contract must be approved and cannot be changed after.

Figure 5-3 shows the status values to be added to the Master Contract.

![Figure 5-3 Approve Master Contract](image)


**Revising contracts**

After you have changed the status of a contract to APPR (Approved), the only field that can be edited on the contract is the Status field. You cannot *un-approve* a contract. If you have to modify the contract, you must use the **Revise Contract** action.

**Note:** A contract can be changed only by creating a revision of the existing contract.

The Revise Contract action is available for contracts with a status of APPR that do not already have an existing revision (that is, a revision with a status of PNDREV (Pending Revision)). The Revise Contract action creates a copy of the current contract. IBM Maximo Asset Management copies all of the information from the original contract, including contract lines, terms and conditions, associated service level agreements, commodities, and authorized sites. To separate both contracts, the contract description for the revised contract has to be added.
The contract number is the same as the original contract, and the value in the Revision field is the revision number of the original contract plus one. For example, the original contract has a revision number of zero, so the first revision has a revision number of 1 (0+1=1). The status of the revision is PNDREV. The status of the original contract does not change when you create a revision. The original contract is available for use and can have new transactions created against it. When you change the status of the revision from PNDREV to APPR, IBM Maximo Asset Management changes the status of the original contract from APPR to REVISD (Revised) and that version of the contract becomes a history record.

**Note:** If you approve a contract revision that has a Start Date is in the future, IBM Maximo Asset Management changes the revision status to WSTRART (Waiting to Start) and the original contract does not change status from APPR to REVISD.

IBM Maximo Asset Management includes escalations that check for contracts in a status of WSTART whose start date is the current date and automatically changes the status of the contract to APPR. You can use the View Revision History action to view every revision that has been made to the current contract with the revision process. The Contract Details table window displays every version of the contract. IBM Maximo Asset Management displays the most current revisions first. The Contract Line Details table window displays contract lines that have been changed or added in the version of the contract that is highlighted in the Contract Details table window and the previous version of the contract. Each changed line is followed by the previous version of that line, so that you can see the changes.

**Tip:** During a database search for a contract record, the contract that has the highest revision number is the most recent version of the contract.


**Deleting contracts**

IBM Maximo Asset Management does not offer the option to delete a contract. You are supposed to keep the contract for reference purposes, even after it is no longer in use.
The status of the contract can be set as:

- **SUSPND (Suspended)**
  
  The contract cannot be edited. You can change a contract’s status from SUSPND to APPR, CAN, or CLOSE.

- **EXPIRD (Expired)**
  
  The end date (End Date field) of the contract has passed without the contract being renewed. The contract cannot be edited, but a revision can be created against an expired contract. You cannot change a contract’s status from EXPIRD to any other status.

- **CAN (Canceled)**
  
  Cancelling a Lease/Rental Contract or Warranty Contract cancels any outstanding scheduled payments for the contract. IBM Maximo Asset Management notifies you if unapproved purchase orders exist against a contract. Unapproved purchase orders cannot have their status changed to approved after the contract is cancelled. You can only cancel a Master Contract if all of its associated contracts are closed or cancelled. When you change a contract’s status to CAN, the contract becomes a history record and cannot be edited.

- **CLOSE (Closed)**
  
  Closing a Lease/Rental Contractor Warranty Contract cancels any outstanding scheduled payments for the contract. IBM Maximo Asset Management notifies you if unapproved purchase orders exist against a contract. Unapproved purchase orders cannot have their status changed to approved after the contract is closed. You can only close a Master Contract if all of its associated contracts are closed or cancelled. When you change a contract’s status to CLOSE, the contract becomes a history record and cannot be edited.

**Example: Purchase Contract**

Because the Purchase Contract allows many more configuration options than other contracts, we discuss it in more detail in this section. (An overview of the contract types is given in 5.1, “Contract module applications” on page 74.)

After you have created and specified the basic information for your Purchase Contract, you are allowed to add several more records to this particular contract. You may add records to the Contract Lines tab in the Purchase Contracts application to review and modify the lines on a contract (Figure 5-4 on page 83).
5.4 Using terms and conditions

Terms and conditions are requirements that are defined for contracts and purchasing records, often by a legal department. You use the *Terms and Conditions application* to enter and maintain a library of terms and conditions that can be added to a purchasing record or contract. These terms can contain information such as liability concerns, shipping and handling details, or delivery time expectations. The terms entered in the Terms and Conditions application are
available from the Terms and Conditions tabs in Purchasing and Contract applications. From the tabs, you can select a term from the library to associate with that purchasing or contract record.

### 5.4.1 Working with terms and conditions

You use the *Terms and Conditions application* to create and maintain a library of terms and conditions that describe the legal obligations between a contract buyer and a seller. Terms and conditions are created on the organizational level and appear on records in the following applications:

- All contracts (Contracts module)
- Invoices
- Purchase Requisitions
- Purchase Orders
- Requests for Quotation

**Tip:** If the **Editable on Use?** check box is selected for a term, you can edit the term after it has been copied to a record.

### Creating new terms and conditions

To create new terms and conditions, you have two options. You may create terms and condition available for either:

- All contracts based on the library
- A single contract based on the contract only

To create terms and conditions, use **Go to → Contracts → Terms and Conditions**, and then fill in the appropriate information:

- Specify Liability concerns
- Specify Shipping and handling details
- Specify delivery time expectations

Then, click **Save**. Refer to 5.3.1, “Creating contracts” on page 77.

The terms and conditions in the library can be added to a contract from the Terms and Conditions tab of the individual applications. You may also create terms with the New Row button on the Terms and Conditions tab, but terms created in this manner are saved to the record and are not added to the library.

Figure 5-5 shows how to create Terms and Condition by clicking the **New Row** button.
Updating terms and conditions
You may modify an existing term in the Terms and Conditions application at any time. Modifying a term does not update existing contracts or purchasing documents that reference the term. For your own benefit, review the Terms and Conditions Library and make the changes when applying them to the purchase order or contract.

Deleting terms and conditions
You may delete a term from the library at any time by using the Mark Row for Delete button next to the term. This does not remove the term from any contract or purchasing document.
Purchasing

The Purchasing module is one of the applications devoted to financial and purchasing functions. The Purchasing module tracks requests for and purchases of materials and services, receipt of the purchases, and invoices for the purchases.

This chapter contains the following topics:

- “Purchasing module” on page 88
- “Company records” on page 93
- “Companies application” on page 98
- “Purchase Requisitions application” on page 101
- “Purchase Orders application” on page 103
- “Receiving application” on page 106
- “Request for Quotations application” on page 110
- “Invoices application” on page 112
6.1 Purchasing module

The Purchasing module consists of the following applications:

- **Companies**
  This application is for managing records for manufacturers, vendors, and other companies that do business with you. Any value appearing in a Company or Vendor field in a IBM Maximo Asset Management record should have a company record associated with it. Company masters are used for the purposed of defining companies that belong to a company set that can be shared by one or more organizations.

- **Company Master**
  This application is used to create *company master records* that belong to a particular company set.

- **Invoices**
  This application is used to record invoices and match against purchase orders (POs) and receipts for approval. You use the *Receiving application* to record the receipt of ordered items and materials. You use the *Invoices application* to record invoices received from vendors, which can be matched to POs. You can also manage scheduled payments for a contract in the Invoices application.

- **Purchase Orders**
  This application is used to purchase materials or services from an internal supplier or an external vendor. You use the *Purchase Orders application* to create and manage purchase orders for items, materials, services, tools, and so forth. Purchase orders created automatically in the inventory reorder process are also visible in the Purchase Orders application.

- **Purchase Requisitions**
  This application is used to request the ordering of materials or services. You use the *Company Master* and *Companies applications* to create records for the vendors that provide you with goods and contract labor, other service providers, and asset manufacturers. Any value appearing in a Company or Vendor field on a IBM Maximo Asset Management record should have a company record associated with it.

- **Receiving**
  This application is used to receive materials into inventory and record the receipt of services. You use the Receiving application to record the receipt of ordered items and materials. When you receive items, IBM Maximo Asset Management increases balances in the Inventory application or issues direct issue items directly to an asset, location, or work order.
You may use the Receive Rotating Items action to create records in the Assets application for rotating assets.

**Request for Quotation**

This application is used to request and manage vendor quotations for prices and delivery information for goods and services.

**Terms and Conditions**

This application is used to enter and maintain a library of terms and conditions to be used on contracts and purchasing documents. These terms can contain information such as liability concerns, shipping and handling details, or delivery time expectations.

### 6.1.1 Purchasing and inventory

The Purchasing module works closely with the Inventory module to maintain balances of items and materials in company storerooms.

When you reorder items either manually (using one of the reorder actions in the Inventory application), or automatically, IBM Maximo Asset Management automatically creates one or more of the following types of purchasing records for the reorder:

- Unapproved purchase requisitions (PRs)
- Approved purchase requisitions (PRs)
- Unapproved purchase orders (POs)
- Approved purchase orders (POs)

### 6.1.2 Internal versus external purchases

To centralize purchasing, all inventory purchasing can be done through a central storeroom, and all other storerooms can purchase their stock from that central storeroom.

IBM Maximo Asset Management supports this type of purchasing by allowing you to create two types of purchase requisitions and purchase orders. Both purchase requisition (PR) and purchase order (PO) records contain a check box, labeled *Internal*.
This check box is in the Vendor section of the record and that is used to indicate whether the PR/PO is an internal or external purchase, as follows:

- **Internal PR/PO**
  
  This is requesting the transfer of materials from another company storeroom. When making internal purchases, select the Internal? check box and enter Storeroom and Storeroom Site information.

- **External PR/PO**
  
  This is requesting the purchase of the necessary materials or services from an outside vendor. When creating external PRs/POs, leave the Internal? check box empty and enter company information.

### 6.1.3 Line Types

Purchase requisitions (PRs) and purchase orders (POs) list each item or service to be purchased on a separate line. Each PR or PO line must have a Line Type specified for it.

IBM Maximo Asset Management allows you to select from the following default Line Types:

- **ITEM**
  
  This type is the default. Use it to order inventory items, that is items that have item records created for them in the Item Master application.

- **MATERIAL**
  
  Use it to order items or materials on a one time basis, that is items that do not have item records created for them in the Item Master application. You must enter a description, quantity, cost, and charge value. The charge value can be a work order, location, asset, or GL Account code.

- **SERVICE**
  
  Use it to order services on a one time basis, that is services that do not have records created for them in the Service Items application. Services require a description, line cost, and charge value. The charge value can be a work order, location, asset, or GL Account code.

- **STDSERVICE**
  
  Use it to order standard service items, that is services that have records created for them in the Service Items application.
6.1.4 Commodity codes

Commodity codes can be defined and managed by choosing Select Action → Add/Modify Commodity Codes in any of the following applications:

- Companies
- Item Master
- Purchase Orders
- Service Items
- Tools

Classifying items and services with commodity groups and commodity codes provides a way for you to analyze spending by item type. After you have defined commodities, you may associate them with company, contract, and item records. You may also associate commodities with individual PR or PO lines for items, service items, or tools that do not have commodity codes assigned to them, including special order materials or services.

**Note:** Commodity group or commodity code information added to a PR Line or PO Line is not copied to item records.

6.1.5 Purchasing and contracts

The Purchasing module works closely with the Contracts module to define the specific financial relationship between buyer and seller.

Company records and contracts are both defined at the Organization level, whereas most purchasing is done at the Site level. When you enter a contract in one of the contracts applications, you must select the Authorize Sites action to authorize each site that you want to be able to use the contract.

Contracts module is discussed in detail in Chapter 5, “Contracts” on page 73.
Creating purchasing records from contracts

Purchasing records can be created in the Contracts module. You create purchase orders in three ways:

- Directly from the Purchase Orders application
- From purchase requisitions (PRs)
- From requests for quotations (RFQs)

Types of purchase orders include:

- CHG (Change)
  A change order is a duplicate purchase order generated from an approved purchase order. If you must change an approved PO that has no receipts, you might prefer to do so by creating a change order. The change order preserves the audit trail by retaining the original PO while you make the necessary changes to the change order PO.

- PARTS (Parts)
  This type indicates that the purchase order is for work order parts.

- REL (Release)
  IBM Maximo Asset Management creates a release type PO when you use the Create Release PO action available in the Purchase Contracts application. A blanket release is a purchase order that you generate from a purchase contract. Your system administrator can set IBM Maximo Asset Management so it automatically approves REL type POs generated from valid contracts.

- SERV (Service)
  This type indicates that the purchase order is for services.

- STD (Standard)
  This type is the default for POs created in the Purchase Orders application.

Distributing costs on purchase orders

In the system, you can distribute the costs of a purchase record line item across multiple GL accounts. For example, if your department ordered and received a new laser printer that the packaging department will also use, you may specify two GL accounts for the printer, one for each department's GL. A PO line item must meet the following conditions if you want to distribute its costs:

- The PO line item is a direct issue item or service.
- None of its items or services have been received.
- The PO type is REL (Release), CHG (Change), or STD (Standard).
- The PO status is WAPPR (Waiting on Approval).
- None of the service lines are prorated.
6.2 Company records

A company master record in IBM Maximo Asset Management represents a vendor from whom you purchase goods or services, asset manufacturers, and other companies that you do business with. A company record contains organization specific information about a vendor, such as contact names and addresses. If a company has multiple locations, you may create separate records for each branch location and associate them with a parent company record.

**Note:** Company information must be entered in the Companies application before other applications, such as Inventory and Purchasing, can access it.

6.2.1 Multisite and company records

Company records are at the Organization level. This means that key fields for new records must be unique for the organization, but may duplicate record IDs used by other organizations and these records can only be viewed by users who have security permission to the organization and the application.

Company master records are created at the Company Set level so that the records can be shared by more than one organization. Item records for items, services, and tools are defined at the Item Set level, so that the records can be shared by one or more organizations and items and tools can be transferred between organizations and sites that share the same Item Set. Other item-related data such as commodities, condition codes, and conversion values between order units and issue units are also defined at the Item Set level.

6.2.2 Currency codes

You use the *Currency Codes application* to define and manage currencies. A currency code is a short, user-defined value that you create to represent a currency, for example, CND for the Canadian dollar. Figure 6-1 on page 94 shows the Currency Codes application.
When you enter purchasing records in a foreign currency, the system uses the current exchange rate to calculate the base cost in the currency of your company. Purchasing records include purchase requisitions, purchase orders, and invoices.

The Currency Codes application stores currency codes at the system level. All organizations can view and use the defined currency codes and add new ones as necessary.

After you establish an active currency code, you may use that currency code where a Currency field appears, such as in the Purchase Requisitions, Purchase Orders, Invoices, and Companies applications.

Although you use the Currency Codes application to define currencies, you use the following applications to manage other aspects of currency administration:

► Organizations application to specify the base currency for an organization.
► Exchange Rates application to specify exchange rates between currencies for defined periods

Although currency codes are defined at the System level, other financial information (exchange rates, tax codes, General Ledger accounts, financial periods, and so forth) is defined at the Organization level. You also create contracts (master, labor rate, lease/rental, purchase, and warranty type contracts) and vendor records, and define terms and conditions for contracts and purchasing at the Organization level.

When a user enters an amount in a foreign currency, for example on a purchase requisition, purchase order, or invoice, the application finds the active exchange rate for that currency to calculate the cost in the organization's base currency. If the application does not find the exchange rate between two currencies explicitly defined, it will use specific rules and logic to calculate the exchange rate from other exchange rates, if they exist.
6.2.3 Exchange rates

You use the Exchange Rates application to enter, view, and modify exchange rates for converting currencies. The exchange rate is the multiplier used to convert the currency in the Convert from Currency field to the currency in the Convert to Currency field. For example, an exchange rate of 1.7 from British pounds to U.S. dollars means that the value in British pounds is multiplied by 1.7 to calculate the value in U.S. dollars.

When a user enters an amount in a foreign currency, for example on a purchase requisition, purchase order, or invoice, the application finds the active exchange rate for that currency to calculate the cost in the organization's base currency. If the application does not find the exchange rate between two currencies explicitly defined, it will use specific rules and logic to calculate the exchange rate from other exchange rates, if they exist.

The application stores exchange rates at the organization level. Therefore, each organization defines and maintains its own exchange rates.

The Exchange Rates application contains two table windows:

- Organizations window is used to select the organization for which you want to enter or modify exchange rates.
- Exchange Rates widow is used to enter and modify exchange rates for the selected organization for specific periods of time.

Although you use Exchange Rates application to define exchange rates between currencies, you use the following applications to manage other aspects of currency administration:

- Currency Codes application is used to define the currency codes.
- Organizations application is used to specify the base currency for an organization.

The application stores exchange rates at the organization level. Therefore, each organization defines and maintains its own exchange rates.

**Converting a foreign currency value to base currency**

When you specify a foreign currency on a purchase requisition (PR) or purchase order (PO), the system calculates two values:

- Total Cost, expressed in the foreign currency
- Total Base Cost, expressed in the base currency (your company's currency)
**Example: Conversion**

Your base currency is US$ (U.S. dollar). You enter a PR for gaskets, to be ordered from a French company. On the PR tab, you select **EUR** (euro) in the **Currency** field. On the PR Lines tab you enter the following values:

- Quantity: 25
- Unit Cost: 3.14 (in euro)

Using the active exchange rate of 1.17726 for the EUR, the system calculates two values and displays them on the PR tab:

- Total Cost: \((25 \times 3.14 \text{ euro}) = 78.50 \text{ (in EUR)}\)
- Total Base Cost: \((78.50 \text{ euro} \times 1.17726 \text{ exchange rate}) = 92.41 \text{ (U.S. dollars)}\)

**Tax options**

You use the Tax Options dialog box in the Organizations application to specify default tax GL accounts and to define tax codes for the system to use in calculating the amount of tax that is due on a PR, RFQ, PO, or invoice. You may define up to five tax types, each of which can have any number of tax codes. The system uses tax type and tax code as follows:

- A **tax type** corresponds to a kind of tax, for example, to a federal, state, or city sales tax. Another tax type might be a special tax for handling hazardous material.

- A **tax code** represents a particular tax rate, such as MA for the Massachusetts sales tax of 5%. Thus, one tax type might include tax codes for all state or provincial sales taxes.

Tax Options are set at the Organization level.

**Note:** Paid Tax GL Account field is for taxes paid to the vendor and is only used in the Invoice application. Unpaid Tax GL Account field is for taxes not yet paid to the government and is only used in the Invoice application.

Some businesses require that taxes be reflected in the total price of some or all purchased goods and services. Adding this procurement cost to the item price increases a stocked item’s average cost. If an item is issued directly to a work order, general ledger (GL) account, location, or asset, taxes are added to the cost of the individual item.

Loaded Cost field indicates the total cost of the item, including taxes and service costs.
IBM Maximo Asset Management enables you to define the category of line items to which you can add taxes:

- No items option means taxes are not added, and are not reflected in the cost fields of the Inventory or Work Orders applications.
- All items option means taxes are added to all line items on the invoice. Adding taxes to the item price increases a stocked (inventory) item’s average cost.

### 6.2.4 Company records versus company master records

Company master records define the records that belong to a Company Set. Company Sets exist below the System level, but above the Organization level so that organizations can share data. Each organization is associated with a Company Set.

If your company has implemented a Multisite configuration that includes multiple organizations, using Company Sets allows your organizations to share master company data on the records created in the Company Masters application, and record organization specific data, for example contacts and branches, on the records in the Companies application.

When creating a complex Multisite implementation, create company records in the following order:

1. Create one or more Company Sets in the administrative Sets application.
2. Create company master records in the Company Master application.
3. Add company master records to one or more organizations.
4. Use the Companies application to add organization specific data to the company records.
5. If appropriate, create company branch records and associate them with a parent company record to create a hierarchy.
6. If your company's Multisite implementation consists of a single organization, your system administrator can configure your Company Set so that records created in the Companies application are automatically added to the Company Masters application.

### 6.2.5 Company records and contracts

Before you can create contract records, you must first create company records for each vendor or company that will be listed on a contract.

To view a read-only list of contracts associated with a company record, choose **Select Action → View Contracts** of the Companies application.
6.2.6 Company records and purchasing

Before you can create purchasing records (PRs, RFQs, or POs), you must first create company records for each vendor or company that will be listed on a purchasing record.

6.3 Companies application

The *Companies application*, located in the Purchasing module, maintains detailed information about vendors, manufacturers, and other companies. Vendors can have parent companies or multiple vendor locations for a single company.

Company information must be entered in the Companies application before other modules, such as Inventory and Purchasing, can access it.

To access the Companies application, click the application link on your Start Center, or select **Go To → Purchasing → Companies**.

The Companies application contains the following tabs:

- **List**
  
  Use this tab to search IBM Maximo Asset Management for company records.

- **Company**
  
  Use this tab to enter, view, and modify information about vendors, manufacturers, and other companies.

- **Contacts**
  
  Use this tab to enter, view, and modify contact information for multiple contacts.

- **Addresses**
  
  Use this tab to enter, view, and modify information about a single contact, company mailing address, and remit to information for a company.

- **Branches**
  
  Use this tab to enter, view, and modify information about multiple locations for the company.
6.3.1 Manage companies

Use the Company tab to enter information about a company, including purchasing and payment information, and information about whether the vendor is enabled for e-commerce through IBM Maximo Asset Management. See Figure 6-2.

[Figure 6-2: Company tab]

You may categorize companies by type for reporting purposes. IBM Maximo Asset Management uses three defaults for company types:

- Courier type is the transit company.
- Manufacturer type is the manufacturer of items or assets.
- Vendor type is the vendor of items or assets.
- AP Control Account type is the credit account used when the invoice is paid.
- RBNI Account type is the account for receipts that have not been invoiced.
- Suspense Account type is the credit account used when invoice is approved.

**Note:** When selecting a company type, the default GL accounts for that company type are automatically displayed in the AP Control Account, RBNI Account, and the Suspense Account fields. To set up default company GL accounts for a particular company type, use the Company Related Accounts dialog box in the Chart of Accounts application.

If your company decides to no longer do business with a vendor, you can mark the record to indicate that the vendor is disqualified. After you disqualify a vendor, you can no longer create new PRs, POs, RFQs, or invoices for the vendor.
If the company is a parent company and has branches, you may add branches here. See Figure 6-3.

![Figure 6-3 Branches tab](image)

Your company may purchase products or services through a national vendor with local offices. You may have locations in different cities, each of which purchases from the local office of the vendor. You can create branch records for a vendor company and track purchasing either at the branch level, or with the vendor as a whole.

For example, each plant location might purchase office supplies at the local office of a national chain, and do their shipping with the local office of an international shipping company. By entering company branches into the system, you can track purchases for each plant location in its branch record, as well as the total purchases for all plant locations in the parent vendor record.

Selecting the **Use Parent Remit To?** field in the Company tab allows users to purchase from a local branch office while still submitting invoices to the parent company.

**Note:** A disqualified vendor affects only those records created after you disqualified the vendor.

**Note:** The company that is a branch has to be entered in, as a company to be in the Value List. Only one level of the Parent/Branch hierarchy is allowed.

### 6.3.2 Deleting a company

Company records that have been referenced in other applications (such as purchase orders, invoices, contracts) may not be deleted. Also, company records that have associated branch records may not be deleted. To delete a company record with associated branch records, you must first sever all the branch associations with that company record.
6.4 Purchase Requisitions application

To access the Purchase Requisitions application, click the application link on your Start Center, or select Go To → Purchasing → Purchase Requisitions.

The Purchase Requisitions application contains the following tabs:

- **List**
  Use this tab to search for PR records.

- **PR**
  Use this tab to enter, view, or modify purchase requisitions.

- **PR Lines**
  Use this tab to enter, view, or modify line items for a purchase requisition. A line can be an item or material from inventory, an item or material not from inventory, or a service.

- **Ship To/Bill To**
  Use this tab to enter, view, or modify shipping information that will be used as a default on each line, and billing information for the entire order.

- **Terms and Conditions**
  Use this tab to add, view, or delete terms and conditions that have been associated with the record.

6.4.1 Managing purchase requisitions

In this section, we discuss how to manage your purchase requisitions, such as creating a new purchase requisitions or viewing or changing the status of existing purchase requisitions.

**Create requisition**

To create a new purchase requisition, select the New icon at the top of the window. IBM Maximo Asset Management automatically numbers the purchase requisition so a window opens with the next available number. The requisition defaults to the WAPPR status when created, as shown in Figure 6-4 on page 102.
The Waiting on Approval (WAPPR) status is assigned to a purchase requisition when it is created; certain default fields are read-only. Status values are:

- **WAPPR (Waiting on Approval):**
  This is the status that a purchase requisition is assigned when it is created. Some default fields are read-only.

- **APPR (Approved):**
  This status is available only if your business rules require approvals. The default configuration does not require approvals for PRs and PR line items that your transfer to POs.

- **CLOSE (Closed):**
  This status indicates that all PR line items have been assigned to one or more purchase orders. All fields are read-only; and the record can no longer be modified.

**Note:** If you try to close a PR and a line item has not yet been assigned, IBM Maximo Asset Management displays a message. IBM Maximo Asset Management can be set to automatically close PRs after you transfer all the line items to POs, RFQs, or contracts.

- **CAN (Canceled):**
  This status is available if the current PR status is APPR and if none of its line items have been assigned to a purchase order, so all fields are read-only.
6.5 Purchase Orders application

You may use a number of methods to create a purchase order:

- From a purchase requisition (PR)
- In the Purchase Requisition application
- In the Purchase Orders application
- From a request for quotation (RFQ) in the Request for Quotation application
- Using the Inventory Reorder actions in the Inventory application
- In the Purchase Contracts application by creating a release

The Purchase Orders application also allows you to generate an internal PO against another storeroom. You can think of a storeroom-to-storeroom purchase as a transfer order or an internal PO because IBM Maximo Asset Management uses the Purchase Orders and Issues and Transfers applications to track these types of item movements. You also use Purchase Contracts application to create change orders.

To access the Purchase Order application, click the application link on your Start Center, or select Go To → Purchasing → Purchase Orders.

The Purchase Orders application contains the following tabs:

- List
  Use this tab to search PR records.
- PO
  Use this tab to enter, view, or modify purchase Orders.
- PO Lines
  Use this tab to enter, view, or modify line items for a purchase Order. A line can be an item or material from inventory, an item or material not from inventory, or a service.
- Ship To/Bill To
  Use this tab to enter, view, or modify shipping information that will be used as a default on each line, and billing information for the entire order.
- Terms and Conditions
  Use this tab to add, view, or delete terms and conditions that have been associated with the record.
6.5.1 Managing purchase orders

A purchase order can list items or services for one vendor or supplier only. You can combine multiple purchase requisitions for the same vendor on a single PO.

Create a purchase order

To create a new purchase order, select the **New** icon at the top of the window, as shown in Figure 6-5.

IBM Maximo Asset Management auto-numbers purchase orders and thus a window opens with the next available number. The purchase order defaults to WAPPR status when created.

Note that from the Select Action tab you have the option to View History. The three categories of history provided on a purchase order are:

- **Status**
- **Vendor Status Information**
- **Advance Ship Notification Information**
Purchase order status
Changing the status on purchase orders affects field functionality and access to various action pages. The purchase order can have the following status values:

- **WAPPR (Waiting on Approval)**
  This status is the default for a PO when you create it. Some default fields are read-only in this status.

- **INPRG (In Progress)**
  This status indicates that a PO still needs to be modified before it can be Approved.

- **APPR (Approved)**
  This status is available only if the current PO status is Waiting on Approval (WAPPR) or In Progress (INPRG). All fields are read only. To approve a PO, you must have a monetary approval limit equal to or greater than the total cost of the PO.

- **CAN (Canceled)**
  This status is available if the current PO status is Waiting on Approval (WAPPR) or Approved (APPR). You cannot cancel an approved PO if any of the following conditions exist:
  - One or more PO lines items has been received.
  - The supplier sent notification of delivery of items in an ASN transaction.
  - The supplier has rejected the PO cancellation.

- **CLOSE (Closed)**
  This status indicates that all of the POs line items have been received. After a PO is closed, it is stored as a history record and cannot be modified.

Purchase order types
IBM Maximo Asset Management uses the following types of purchase orders:

- **CHG (Change)**
  A change order is a duplicate purchase order generated from an approved purchase order. If you must change an approved PO that has no receipts, you might prefer to do so by creating a change order. The change order preserves the audit trail by retaining the original PO while you make the necessary changes to the change order PO.

- **PARTS (Parts)**
  This type indicates that the purchase order is for work order parts.
IBM Maximo Asset Management creates a release type PO when you use the **Create Release PO** action available in the Purchase Contracts application. A *blanket release* is a purchase order that you generate from a purchase contract. Your system purchasing administrator can set IBM Maximo Asset Management so it automatically approves REL type POs generated from valid contracts. Release type POs cannot be duplicated using the Duplicate Purchase Order action. They also cannot be changed to a change (CHG) type PO.

**SERV (Service)**

This type indicates that the purchase order is for services.

**STD (Standard)**

This type is the default for purchase orders created in the Purchase Orders application. When creating a purchase order, STD, SERV, and PARTS are the only selectable values.

### 6.6 Receiving application

You use the *Receiving application* to receive materials and services from purchase orders. You may search for and receive existing PO line items from the Select Ordered Items and the Select Ordered Services dialog boxes, accessible from the Material Receipts and Service Receipts tabs, or manually enter received items on the Receipts tabs. If you have Invoice Management, you may use the invoice claim number or other invoice fields to search for items or services.

To access the Receiving application, click the application link on your Start Center, or select **Go To → Purchasing → Receiving**. See Figure 6-6.

![Figure 6-6 Receiving application](image-url)
The Receiving application contains the following tabs:

- **List**
  Use this tab to search for receipt records in IBM Maximo Asset Management. Use more fields for a specific search and fewer fields for a general search.

- **Material Receipts**
  Use this tab to add, view, or modify materials received on a PO.

- **Service Receipts**
  Use this tab to add, view, or modify services received on a PO.

The Receiving application allows both materials and services to be received and recorded in the database when they are delivered to a site.

- **Material receipts**
  This tab refers to data associated with items used for work done on-site by your company's employees, for example, quantities and lot numbers. When inventory items are received against a purchase order, the quantities in Inventory are updated, and an inventory transaction is generated.

  You can also receive materials not tracked in Inventory, but which require a purchase order. Record the data associated with material receipts on the Material Receipts tab.

- **Service receipts**
  This tab refers to the data associated with any service provided by a vendor or contractor, such as repairs to assets. The service may be performed on or off site. You specify service purchases either in terms of a quantity and a unit cost, or as a single lump sum amount.

In a large enterprise, you might have a centralized purchasing department for several sites. Each individual site receives its own materials and services. The Receiving application allows both materials and services to be received and recorded in the database when they are delivered to a site.

Material receipts refers to data, such as quantities and lot numbers, associated with items used for work done on site by your employees. When you receive inventory items against a purchase order, the quantities are updated in Inventory and an inventory transaction is generated.

You can also receive materials not tracked in Inventory, but which require a purchase order. For example, a catered lunch or a new desk is not stored in Inventory or tracked by an item number. You would, however, track their costs on purchase orders and receipts.

Record the data associated with material receipts on the Material Receipts tab.
Service receipts refers to data associated with any service, such as repairs to assets, provided by a vendor or contractor. The service can be performed on or off site. You specify service purchases either in terms of a quantity and a unit cost, or as a single lump sum amount. Use the same terms on the receipt transaction as those terms used on the service PO. Record service receipts on the Service Receipts tab. Whichever terms you use on the service PO must be the same on the corresponding receipt transaction, which you record on the Service Receipts tab.

You might have to change information when recording the receipt of materials. Change the receiving information before you save the receipt record. For example, if you want to record a partial shipment, change the number in the Quantity field.

In the Receiving application, on the List tab, select the PO for which you want to receive material. To create receipts, the status of the PO must be either In Progress or Approved. On the Material Receipts tab, click Select Ordered Items. In the Select Ordered Items dialog box, select the check box for each line you want to receive. To select all of the items on the PO, select the check box in the table header.

In the Material Receipts table window, click View Details on the material receipt line you want to change. Change material receipt lines information as necessary. After you save the receipt, the fields on the Material Receipts tab become read-only. If you are receiving a line item that is not a rotating item, but is damaged, receive the full shipment amount and then return the rejected quantity. Use the Select Items for Return dialog box to return materials.

When an inspection is required upon receipt of an item or service, the following status values describe where in the inspection process the line item is. Use the Change Inspection Status dialog box to change the inspection status of an item.

The status values can be:

► WINSP (Waiting for Inspection)

This status indicates that the line item is in the process of being received, but has not yet been entered into inventory. The line item is in a holding location, where it stays until an inspection is completed. After inspection, the line item converts to either WASSET or COMP status, depending on whether it is a rotating item.

► WASSET (Waiting for Serialization)

This status indicates that the line item is a rotating item that is waiting to have an asset number assigned to it. If the line item requires inspection, the inspection has already taken place if its status is WASSET. The item is still in the holding location; it has not yet been sent to its appropriate storeroom or
direct issue location. After the item has been serialized in the Receive Rotating Items dialog box, its status will be COMP.

- COMP (Complete)

  This status indicates that the line item has been received, and if necessary, inspected and serialized. When the status of the line item changes to COMP, a transfer transaction is created. The transaction transfers the item to its appropriate storeroom or direct issue location. If the line item is not rotating and does not require inspection, its status is COMP upon receipt.

6.6.1 Rotating items

A rotating item is an individual serialized asset that you define with a common item number, such as a pump or mobile computer. You designate an item as rotating because it shares properties of both items and assets. A rotating item can have inventory value and issue cost, like an item. However, a rotating item cannot be consumed, rather, it is maintained like an asset. For example, you have ten mobile computers of the same model that share the same attributes, and they all have the common item number ABCT23. However, you want to be able to track each as an individual asset, so you flag the items as rotating when you create them.

After creating an item and adding it to a storeroom, you can either use the Assets application to create the asset records for an item you want to track, or create a purchase order for the rotating item and serialize it when you receive it. When you have associated an asset to a rotating item, balances can be displayed and tracked for this item. A rotating item is tracked both by its item number in Inventory records and by its unique asset number in Assets records.

**Note:** An item cannot be both a spare part and a rotating item, because rotating items are generally maintained not consumed (or just used once). For example, you can keep gaskets available as spare parts for use on multiple pieces of equipment, but you cannot classify the gaskets themselves as rotating items because they are used once and then thrown away.

Each rotating item goes into Inventory with an item number. The rotating item is also tracked in the Assets application with an asset number.

To enter line items for rotating items on the Material Receipts tab, use the Receive Rotating Items dialog box. You can enter asset identifiers for specific rotating assets, or auto-number all of the rotating items.
6.7 Request for Quotations application

Use the Request for Quotations application to create requests for quotations and store the quotations so you can assess the vendor that best meets your requirements. See Figure 6-7.

A request for quotation (RFQ) is a request that you send out to one or more potential suppliers. To list a vendor on the RFQ, the vendor must have a record in the Companies application. In the RFQ application, you can specify line items, required delivery dates, and other conditions you want the vendor to meet for the delivery of an item or service.

You may create an RFQ for any of the following circumstances:

- The stock count of a stocked item drops below a certain level and you must place another bulk order.
- A requisition is received for an item or service that requires a quotation each time because of item price or other requirements.
- Someone at your site requests a quote for an item or service. It can be for a normally stocked item or for an item not normally ordered, such as a special order or non-stocked item.

**Note:** If the item requires inspection, its status is WINSP (Waiting for Inspection). If the item does not require inspection, its status is WASSET (Waiting for Serialization).
You have to do commodity bulk-buying for a certain period of time, typically for many items with common commodity codes. The quotation might not be copied to a PO immediately, but the pricing is set.

When you receive the quotations from the vendors, you enter them into the Request for Quotations application one at a time. At the end of the process, you review the quotations and award one quotation for each RFQ line. The quotations are then converted to one or more purchase orders or contracts, depending on the procurement flow within your organization.

Changing status on RFQs affects field functionality and access to various actions. The RFQ status values are:

- **INPRG (In Progress)**
  This status is the default when you create an RFQ. The RFQ should remain in INPRG status until you have entered all RFQ information and RFQ lines. In this status, you may modify most tabs and fields on the RFQ, with the exception of the Quotation Lines table. The RFQ must be saved as INPRG prior to changing to another status. To allow you to edit the RFQ, its status is always INPRG unless the RFQ is completed or closed.

- **READY (Ready to be Sent)**
  This status indicates that RFQ is ready to be sent out to the vendors. In this status, you do not have the ability to change the RFQ-all tabs are read-only.

- **SENT (Sent to the Vendor)**
  This status indicates the RFQ has been sent to vendors. The SENT status causes fields on the RFQ and RFQ Lines tabs to be read-only although fields on the Vendors tab can be modified. You can also modify the Quotations and Terms and Conditions tabs.

- **COMP (Completed)**
  This status indicates when all quotations have been received from vendors. In this status all fields except the fields on the Quotation Lines and Terms and Conditions tabs are read-only.

- **CANCEL (Cancelled)**
  This status indicates a canceled RFQ. Use the CANCEL status to cancel a current RFQ, or a selected set of RFQs. You can only cancel an RFQ if there have not been any quotations awarded (i.e., the CANCEL status is not available after a quotation has been converted to a PO). A canceled RFQ is stored as a history record and cannot be modified.

- **CLOSE (Closed)**
  This status indicates a closed RFQ; the RFQ’s quotation lines have been awarded, and it is stored as a history record and cannot be modified.
6.8 Invoices application

You use the Invoices application to record vendor invoices as you receive them. An invoice is a bill from a vendor for delivered products or services. Figure 6-8 shows the Invoices application.

The Invoices application enables you to record invoices, and debit and credit notes from vendors, and to match invoice details against purchase orders (POs) and receipts. You may also create invoices for which there are no receipts.

As you enter invoices, you can match the invoice information against purchase orders and receipts of materials and services, so that the invoice can be approved and routed to Accounts Payable.

The following fields are required for invoices:

- Invoice Number
- Type
- Entered Date
- Entered BY
- Company
- Currency

**Note:** When you create an RFQ, the system automatically sets its status to INPRG (In Progress). You can change the status of the RFQ as it moves along in its quotation cycle.
The invoice you create in IBM Maximo Asset Management can represent one of the following invoice types:

- An invoice related to a single purchase order. You enter information such as the invoice number, corresponding PO number, any receipts recorded for the PO, and information specific to the invoice.
- An invoice related to many purchase orders for a single vendor. You enter general invoice data on the Invoice tab, including the vendor, then list the related POs on the Invoice Lines tab.
- An invoice without a related purchase order. Typically, such an invoice represents a bill for which no purchase requisition or purchase order exists. You simply enter invoice-specific information. This method can be appropriate if, for example, you receive an invoice for rent or a phone bill.

### 6.8.1 Invoice types

You may create the following types of invoices:

- **Invoice**
  
  This is the default type. It indicates a payment to a vendor.

- **Credit**
  
  When the invoice type is credit, you can enter a negative value for an invoice quantity. This is usually used for returned items.

- **Debit**
  
  This type indicates a charge to your company from a vendor, for example additional charges not listed on a invoice

To access the Invoices application, click the application link on your Start Center, or select Go To → **Purchasing** → **Invoices**.

### 6.8.2 Invoice status

Changing status on invoices affects field functionality and access to various action pages. The invoice status can have the following values:

- **SCHED (Scheduled)**
  
  This status indicates that the invoice is part of a payment schedule, set up for a specific contract. Invoices with this status can be created only from the Contracts applications.
  
  An invoice with this status can be changed to any status except ENTERED.
- **WAPPR (Waiting on Approval)**
  This status is only available if the current invoice status is ENTERED or HOLD. Use this status to indicate that invoice information has been entered and the invoice is now ready for review and approval by the appropriate level of staff. An invoice waiting for approval can be edited.

- **ENTERED (Entered)**
  This status is the default when you create an invoice. A newly entered invoice has certain fields that are completed by default; some of them are read-only. An invoice with the status of ENTERED can be edited. After the status of an invoice is changed from ENTERED in the Change Status dialog box, the ENTERED status is no longer available.

- **APPR (Approved)**
  This status is available only if the current invoice status is ENTERED, WAPPR, or HOLD. If you change the status directly to PAID without first approving the invoice, the system automatically validates the invoice for approval criteria. An approved invoice is stored as a history record; for invoices in history, you can only change the Check Code, Check Number, and Paid fields.

- **HOLD (Hold)**
  This status is available only if the current invoice status is ENTERED or WAPPR. If the invoice should not yet be approved or paid, you can change the invoice to HOLD status. For example, if you have received an invoice but not yet received the items or if there is a discrepancy between the invoice and receipts, you can place the invoice on HOLD status. An invoice on hold can be edited.

- **PAID (Paid)**
  This status is available only if the current invoice status is ENTERED, WAPPR, APPR, or HOLD. If you change the status directly to PAID without first approving the invoice, the system automatically approves the invoice. A paid invoice is stored as a history record and cannot be modified.

- **CANCEL (Cancel)**
  This status is available only on the Change Status dialog box if the current invoice status is ENTERED, WAPPR, or HOLD. You cannot cancel an approved invoice. A canceled invoice is stored as a history record and cannot be modified.
6.8.3 Approving an invoice

Before an invoice can be approved, the system checks that it meets the following conditions:

1. If the invoice will be paid in foreign currency (as indicated in the Currency field), there must be an active exchange rate for that currency (in the Currency application) on the date of approval. If not, the invoice cannot be approved. (If the exchange rate has changed since you created the invoice, the system updates the Total Base Cost field upon approval.)

2. The prices on the invoice must fall within a specified range of the prices on the purchase order (PO). Your system administrator can define the amount by which the invoice price can vary from the PO price and still be approved in the Limits and Tolerances tab in the Security Groups application.

3. Limits must be set on how large a purchase request, purchase order, material requisition, invoice, and contract the group can approve. Use the Limits and Tolerances tab in the Security Groups application to set limits.

   Tolerance levels for the group regarding how much some purchasing amounts (invoices, taxes, and services) can vary from an initial agreement must also be set. Again, use the Limits and Tolerances tab, which contains the following sections:

   – Organization section is for specifying the organization for which you want to set limits and tolerances.

   – Limits section is for setting group approval limits on how large the monetary amount can be on a purchase request, purchase order, material requisition, invoice, and contract.

   – Invoice Tolerance section is for specifying how large a variance the group can accept on an invoice amount.

   – Tax Tolerance section is for specifying how large a variance the group can accept on a tax amount.

   – Service Tolerance section is for specifying how large a variance the group can accept on a service amount.

4. Standard service costs added to the invoice (such as freight charges or installation fees) must also fall within set limits (also set in the Limits and Tolerances tab in the Security Groups application).

5. Line items that must be received before invoice approval (items that have the Receipt Required check box selected on the Invoice Lines tab) are checked to ensure that the receipts have been entered into the system.
After these conditions are met, the system calculates any price differences between the invoice and the PO. Price differences can be the result of a change in the active exchange rate, or the result of a difference between what the vendor charged and the original PO price, or both. Price differences are handled in one of two ways:

- For issue on receipt items (that is, those items not purchased for inventory), the price difference is always applied to the work order, location, equipment, or GL account specified on the PO or Invoice Lines tab.
- For inventory items, the Average Cost field is updated.

### 6.8.4 Create an invoice that contains multiple vendors

You may enter company branches into the system and associate multiple company records with a parent record. You may then use the remit-to information of the parent company on an invoice. When you create an invoice specifying a parent company, the look-up list from the PO field contains all the purchase orders for the parent company and its branch companies.

If the PO field in the Invoices application contains a purchase order, the lines of the invoice include the lines from the current PO only. If the PO has company information, the vendor information from the parent company does not overwrite the vendor information of the PO.

Creating an invoice that contains multiple vendors is a three-part process:

1. Create a company record for each branch and associate it with the parent record.
2. Create purchase orders for the parent and branch companies associated with the parent company.
3. Create an invoice that references the parent company.

### 6.8.5 Add taxes to the cost of an invoice line item

Certain businesses require that taxes be reflected in the total price of some or all purchased goods and services. Adding this procurement cost to the item price increases a stocked item's average cost. If an item is issued directly to a work order, general ledger (GL) account, location, or asset, taxes are added to the cost of the individual item.

The Loaded Cost field indicates the total cost of the item, including taxes and service costs.
IBM Maximo Asset Management enables you to define the category of line items to which you can add taxes:

- No items option indicates that taxes are not added, and are not reflected in the cost fields of the Inventory or Work Orders applications.

- All items option indicates that taxes are added to all line items on the invoice. Adding taxes to the item price increases a stocked (inventory) item's average cost.

- Issue-on-receipt items only option indicates that taxes are added to only those items that, upon receipt, are directly issued to a work order, GL account, location, or piece of equipment. This option avoids increasing the average cost of stocked items.
Resources

In this chapter, we introduce how Resource records are used, managed, and assigned within Maximo. The Resources module is used to create Maximo records for workers, both internal and external, and other people whose names or IDs might be listed on Maximo records.

This chapter contains the following topics:

- “Resources module” on page 120
- “Labor” on page 120
- “Qualifications” on page 127
- “People” on page 131
- “Person Group” on page 133
- “Crafts” on page 135
7.1 Resources module

The Resources module consists of the following applications:

- **Labor**
  Use this application to create and manage records for all employees and contractors who will be performing work on tickets or work orders.

- **Qualifications**
  Use this application to create and manage certificate and qualification records that employees have earned through training or educational programs. You can associate qualifications with labor records to verify that workers are qualified to perform specialized work.

- **People**
  Use this application to create and manage records for people whose names may appear anywhere on a Maximo record.

- **Person Group**
  Use this application to create groups of person records. Maximo uses person groups when performing automated tasks that will perform the same process or task for multiple people of the same type.

- **Crafts**
  Use this application to create and manage craft records, defining skill levels, standard rates, and premium pay codes for crafts. You can associate labor records with one or more crafts to indicate their various job skills.

7.2 Labor

A labor record represents an employee or contract laborer. Labor records are created for workers who spend time working on tickets or work orders, where you want to track either their work hours or the cost for the time they spend working.

You use the Labor application to create, modify, view, and delete labor records for employees and contractors. You can provide personal information and work-related information about a laborer such as their regular and premium hours worked, and overtime refused. In addition, you can also specify crafts, skill levels, pay rates, qualifications and certifications associated with a labor record.

To use Assignment Manager to schedule and dispatch work, labor records must have a calendar and shift indicated. Click the Show/Manage Values button next
to the Calendar field to access the Calendars dialog box where you may enter, view, or modify this information for a labor record.

Labor records for contract labor can be associated with labor rate contracts. You use the Labor Rate Contracts application to create records for labor rate contracts. If the rate for the laborer is specified by a contract, the Contract field will contain a value.

You may associate labor records to crafts in either the Labor application or the Craft application.

A single laborer might have many different job skills. The Crafts table window on a labor record allows you to list multiple crafts and skill levels for a laborer.

Person records contain general personal information, and other information required on Maximo records for non-labor records, such as workflow and purchasing information. Labor records also contain personal information, but they are primarily designed to store information about the worker, for example craft, skill level, hours worked, certifications, and so forth.

A person record does not require any other resource records. Labor records however, cannot be created without a corresponding person record. When you create new labor records if you do not specify a value in the Person field, Maximo will prompt you to create a matching person record for the labor record.

The personal information (name, address, and so forth) in the People application is stored in database columns that are shared with the Labor application. The data in these fields can be entered or modified from either application.

Although you can list labor records on job plans and work orders, you have more flexibility if you list craft records instead. Activities, tasks, and work orders can be assigned to individual laborers using the Assignment Manager application.

Time spent working on a work order can be recorded while work is being performed using the Timer, or after work has been completed using the Labor Reporting application. When you enter a labor code in a transaction in the Labor Reporting application, Maximo copies data from the labor record to the labor transaction. If a laborer has more than one craft, skill level, or rate listed on the labor record, you must indicate which craft, skill level, rate, or contract applies to the hours you are reporting.

To access the Labor application, click the application link on your Start Center, or select Go To → Administration → Resources → Labor.
The Labor application (shown in Figure 7-1) contains the following tabs:

- **List**
  Use this tab to search Maximo for labor records.

- **Labor**
  Use this tab to add, view, and modify data on labor records for employees and contractors, including personal information, year-to-date hours, and procurement card information.

- **Crafts**
  Use this tab to add, view, modify, and delete crafts, skill levels, and premium pay codes.

- **Qualifications**
  Use this tab to add, view, modify, and update qualifications and certifications for labor records.

![Labor application screenshot](image)

**Figure 7-1  Labor application**

You create records for laborers and contractors in the Labor application. Labor records cannot be created without a corresponding person record. When you create new labor records if you do not specify a value in the PERSON field, Maximo prompts you to create a matching person record for the labor record.
A labor record can have one of the following status values:

- **ACTIVE**
  
  This status is the default for new records. A labor record must be active to be assigned to a work order.

- **INACTIVE**

  Inactive labor records do not appear in select value lists. Labor records with a status of INACTIVE cannot be associated with new Maximo records.

When a worker or contractor is no longer employed, that person should no longer be listed as someone who is available to be assigned work. *Do not delete that person’s labor record* because it is listed on existing Maximo records.

You can change the status of a labor record to INACTIVE by using the Change Status action available from the toolbar and the Select Action menu. The status of labor records cannot be changed to INACTIVE if any of the following statements is true:

- The labor ID is listed on a work plan for a work order that is in any status except CLOSED or CAN.
- The labor ID is listed on an assignment for a work order that is in any status except CLOSED or CAN.
- The labor ID is listed on a job plan record.

**Note:** The status of user and person records associated with labor records is not automatically changed when a labor's status changes to INACTIVE. The status of these records must be changed in the User and People applications.

A status change to INACTIVE is not permanent. The labor record’s status can be changed back to ACTIVE, for example if historical labor actuals had to be recorded.

You may associate a labor record with one or more crafts from either the Labor application or the Crafts application. In the Labor application, you associate a labor with a craft by creating a new row in the Crafts table window on the Crafts tab. Maximo then copies the premium pay codes for that craft to the Premium Pay for table window.

If a laborer performs work that required special training, you note their qualifications on their labor record. You add, view, extend or renew qualifications and certifications on the Qualifications tab of a labor record. You may also use the Qualifications tab to note general training that might not be job-related, for example a new employee orientation that covers general company procedures, or first aid certifications.
If you are creating labor records with similar employees, for example several contract laborers with the same skills hired from the same vendor, you can simplify the record creation process by using the Duplicate Labor action available from the Select Action menu.

Crafts listed on a labor record can be deleted by clicking the **Mark Row for Delete** button for the row. You must click **Save** for the deletion to take effect. When a craft record is deleted from a labor record, the associated rows in the Premium Pay table window are also deleted from the labor record. Crafts cannot be deleted from a labor record if any of the following statements is true:

- If the labor record is referenced on an assignment record for a work order that is in any status except CLOSED or CAN (cancelled), the craft referenced on the assignment may not be deleted.
- If the labor record is referenced on a work plan for a work order that is in any status except CLOSED or CAN (cancelled), the default craft for the labor may not be deleted.
- If the listed craft is the *Default Craft For Labor*, it may not be deleted.

**Note:** If the listed craft is the Default Craft For Labor it can only be deleted if it is the only craft listed for the labor record.

Labor records can be deleted by using the Delete Labor action available from the Select Action menu.

**Important:** Any labor record that is listed on Maximo records should have its status changed to INACTIVE rather than be deleted. Deleting labor records is not a good practice.

Labor records may not be deleted if any of the following statements is true:

- The labor ID is listed on a work plan for a work order that is in any status except CLOSED or CAN.
- The labor ID is listed on an assignment for a work order that is in any status except CLOSED or CAN.
- The labor ID is listed on a job plan record.
- The labor ID is listed as a labor transaction for work order that is in any status except CLOSED or CAN.

**Note:** After you save a qualification you cannot delete it.
You use the *Calendars application* (located in the Administration module) to create and modify calendars and shifts that you can associate with the labor records. See Figure 7-2. A calendar specifies the days when work is performed and includes non-work days, for example weekends or holidays. A shift specifies the hours when work is performed. One or more shifts can be associated with a given calendar.

![Calendar application](image)

Figure 7-2 Calendar application

A single calendar can be referenced by any number of person, asset, or other record. A calendar record is defined by:

- Start and end date
- Shift definitions
- Non-working time you apply to it

Non-working time includes holidays and any other type of non-working time you want to define. Applying shifts and non-working time to a calendar generates the work periods for the calendar.

A calendar specifies the days when work is performed and includes non-work days, for example weekends or holidays. A shift specifies the hours when work is performed. One or more shifts can be associated with a given calendar.
Calendars are created in the Calendars application. You can enter a calendar on a labor record to specify the work days for a laborer. You can enter a shift to specify the work hours for the laborer.

**Note:** To indicate when a laborer's availability does not match that person's calendar, use the Modify Person Availability action in the People application.

To assign a calendar to labor within the Labor application:

1. Display the labor record to which you want to assign a calendar.
2. In the Calendar field, enter a value or click the Detail menu to select an option and retrieve a value. See Figure 7-3.
3. In the Shift field, enter a value or click Select Value and click Save Labor.

Another important feature within the Labor module is the option to set year-to-date hours to zero. This option is available from within the Select Action menu.
To use the option *Zero Year to Date Hours* from within the Labor application:

1. Display the record whose year-to-date hours you want to reset.
2. Choose **Select Action** → **Zero Year to Date Hours** (Figure 7-4). The Zero Year to Date Hours dialog box opens.
3. Select one or more types of hours to reset by selecting the appropriate check boxes.
4. Click **OK**.

You use the Zero Year to Date Hours action in the Labor application to reset the year-to-date fields to zero. Typically you would only use this option at the end of the fiscal year.

![Figure 7-4 Zero Year to Date Hours action](image)

### 7.3 Qualifications

A qualification is an indication of a particular job skill or specialized training. A qualification is often, but not necessarily, indicated by a license or certificate, signifying proficiency in a particular skill or skills. Certain certificates have expiration dates and those who hold the certificates must renew the certificates periodically.

You use the *Qualifications application* to create records of qualifications and certification requirements for qualifications. After you have created qualification records, you may associate them with labor records in the Qualifications or Labor applications. You may also view qualifications associated with a particular labor code and may renew and change the status of their qualifications.

You list qualifications on a labor record to show that the worker has completed general or specific training.

Examples of qualifications can include:

- First aid training
- Safety certifications
- Journeyman Welder
- Forklift Operator’s License
- Master Electrician’s License
- Journeyman Plumber Certification
- Heavy Asset Operator’s License

To access the Qualifications application (shown in Figure 7-5), click the application link on your Start Center, or select **Go To → Administration → Resources → Qualifications**.

The Qualifications application contains the following tabs:

- **List**
  Use this tab to search Maximo for Qualification records.

- **Qualification**
  Use this tab to create, view, or modify a certificate or qualification.

- **Associated Labor**
  Use this tab to add, view, modify, or delete the association between labor codes and the qualification. Note that after a qualification is associated with a labor code, the qualification may not be deleted.

![Figure 7-5 Qualification application](image)

You use the Qualifications application to create, view, modify, and manage qualification and certification records. If certification is required for a qualification select the **Certification Required?** check box in the Certificate Information section of the qualification record. Any craft and skill levels that are required for
the qualification can be listed in the Required Craft and Skills Levels table window. For example, a 7018 Welder's certificate would only be issued to a laborer who is a journeyman welder. Tools that require the qualification or certification can be listed in the Tools that Require This Qualification table window.

Existing qualifications can be extended or renewed by using the **Extend/Renew Qualification** button, located on the qualification row. See Figure 7-6.

![Figure 7-6   Extend/Renew Qualification button](image)

Saved qualifications cannot be deleted, but they can have their status changed to inactive by using the **Change Qualification Status** button located on the qualification row. See Figure 7-7 on page 130.
To view the status and renewal history for a qualification, click the **View Qualification Status History** button located on the qualification row.

You may associate a qualification with a labor record from either the Qualifications application or the Labor application. In the Qualifications application, you associate a qualification with a labor record by creating new rows in the Labor table window on the Associated Labor tab.

A qualification record can have one of the following status values:

- **ACTIVE**  
  This status is the default for new records. A qualification record must be active to be associated with a labor record.

- **INACTIVE**  
  Inactive qualification records do not appear in select value lists. Qualification records with a status of INACTIVE cannot be associated with labor records.

A Qualification may not be made INACTIVE if it is referenced by an entry in either of the following tables:

- **LaborQUAL** (in ACTIVE Status)
- **TOOLQUAL**

Qualification records may be deleted by selecting **Delete Qualification** from the Select Action menu. A qualification record cannot be deleted if it is listed on a labor record or on a tool record. Maximo displays a message if the qualification cannot be deleted.
7.4 People

A person record is a record of an individual who might appear somewhere on a Maximo record, for example, in a Reported By or Affected Person fields on a service request, as a SUPERVISOR on a labor record, or as the value in a Ship To or Bill To Attention field on a purchasing record.

You use the People application to create, modify, view, and delete records for individuals. This application stores personal and official information about individuals, such as Maximo users, laborers, asset owners, supervisors, and individuals who receive workflow notifications.

Any individual who will be assigned records as part of a workflow process must have a record created in the People application.

**Tip:** As a best practice, workflow assignments should be made to a person group rather than an individual.

If workflow processes are created that make assignments to person records, the following fields on the person record should contain a value:

- Supervisor
- Primary E-mail
- Primary Calendar
- Primary Shift
- Workflow E-mail Notification

You use the Workflow Delegate, Delegate From, and Delegate To fields to indicate time periods when a workflow process should route assignments to a designated alternate, for example when a worker is on vacation.

To access the People application, click the application link on your Start Center, or select **Go To → Administration → Resources → People.**

The People application contains the following tabs:

- List
  - Use this tab to search Maximo for person records.
- Person
  - Use this tab to add, view, or modify person records.

To create a new person record, click the **New Person** button in the toolbar. At a minimum, you must provide a Person code and then save the record. Almost
every field on the People record is optional. To maximize your searching capabilities, also provide a FIRST NAME, LAST NAME, and PERSON’S SITE. See Figure 7-8.

A person record can have one of the following status values:

- **ACTIVE**
  
  This status is the default for new records. A person record must be active to be assigned to a labor record or a user record.

- **INACTIVE**
  
  Inactive person records do not appear in select value lists. Person records with a status of INACTIVE cannot be assigned to new labor records or new user records.

You can change the status of a person record by using the CHANGE STATUS action available from the toolbar and the Select Action menu. The status of a person record may not be changed to INACTIVE if any of the following statements is true:

- The person ID is listed as a SUPERVISOR on other person records.
- The person ID is listed as a SUPERVISOR on a job plan record.
- The person ID is listed as a CUSTODIAN or a USER for an asset or location.
The person ID is listed on a ticket record as an OWNER.

The person ID is listed on a communications template or a ticket template.

The person ID is listed as a SHIP TO or BILL TO contact on a purchasing record.

The person ID is listed as a member of a person group.

The person ID is listed on an assignment or notification on an active record in a workflow.

Person records can be deleted using the Delete Person action available from the Select Action menu. Person records may not be deleted if any of the following statements is true:

- The person ID is listed on a user record.
- The person ID is listed on a labor record.
- The person ID is listed as a SUPERVISOR on other person records.
- The person ID is listed as a SUPERVISOR on a job plan record.
- The person ID is listed as a CUSTODIAN or a USER on an asset or location.
- The person ID is listed on a ticket record as an OWNER.
- The person ID is listed on a communications template or a ticket template.
- The person ID is listed as a SHIP TO or BILL TO contact on a purchasing record.
- The person ID is listed as a member of a person group.
- The person ID is listed on an assignment or notification on an active record in a workflow.

7.5 Person Group

A *Person Group* is a list of individuals who might have similar job responsibilities, levels of authority, and security clearances. After you define person groups, responsibility for records such as work orders, tickets, and purchasing records can be assigned to a group rather than an individual. This is useful for records that are time-sensitive because Maximo can determine which member of a group to route a record to based on the person’s calendar and shift.

A person group also can receive a record routed by a workflow process. If Maximo routes a record such as a purchase order or a work order to a person group, everyone in the group can receive the record unless the workflow process is configured to send it only to the member whose calendar shows availability.
To access the Person Groups application, click the application link on your Start Center, or select Go To → Administration → Resources → Person Groups.

The Person Groups application (Figure 7-9) has the following tabs:

- **List**
  Use this tab to search Maximo for person group records.

- **Person Group**
  Use this tab to create, view, or modify person groups.

![](image)

**Figure 7-9   Person Groups application**

You use the *Person Groups application* to create, view, modify, and manage person group records. You associate person records with a person group by creating new rows in the People table window. You use the Alternatives For Table window to list which person or persons should receive Workflow notifications if the person listed in the People window is unavailable.

If you are creating person group records with similar member lists you can simplify the record creation process by using the Duplicate Person Group action available from the Select Action menu. After a group has been duplicated you can then add or delete members from the new group as needed.

Person group records can be deleted by using the Delete Person Group action available from the Select Action menu. Person group records may not be deleted if any of the following statements is true:

- The person group ID is listed on a work order that is in any status except CLOSED or CAN.
- The person group ID is listed on a ticket that is in any status except CLOSED or CAN.
- The person group ID is listed on any activities on a ticket template that has a status of ACTIVE.
7.6 Crafts

You use the Crafts application to define skill levels, standard rates, and premium pay codes for crafts. You can associate labor records with one or more crafts to indicate their various job skills. The craft code typically reflects the type of work done by employees and contractors. A craft represents an occupation or trade, and typically the craft name reflects the type of work done by members of the trade. If pay rates differ based on expertise you can create multiple skill levels and assign different pay rates to each skill level. For example, to make a distinction between a junior and senior level mechanic, you do not have to create two separate craft records. You can create a single craft record of MECHANIC and create two skill levels (JUNIOR and SENIOR) within the MECHANIC craft.

Each skill level within a craft can have different standard pay rates. You may also establish standards rates for external vendors (with or without labor contracts) for crafts and for skill levels within a craft. The Crafts application also lets you create and manage premium pay codes for premium pay rates. You have to define premium pay codes before Maximo allows you to associate them with a craft. Any number of premium pay types and rates can be established for each craft record. Premium pay can be calculated as a multiplier, an increment, or as an hourly amount.

You can associate a labor record with a craft from either the Labor application or the Crafts application.

A single laborer might have many different job skills. The Crafts table window on a labor record allows you to list multiple crafts and skill levels for a laborer.

You break the association between a labor record and a craft by deleting the labor record from the Associated Labor table window. When you do this, you are not deleting the labor record from the database, only removing the relationship between that labor record and the craft.
As with job plans, you may choose to list crafts instead of laborers when creating work plans on work orders. This approach allows the work order to be assigned to any available laborer in the craft, on any shift.

A craft represents an occupation or trade. The members of a craft have the same job skills and can be assigned to perform a specific type of work on a ticket or work order. Crafts may include contract laborers. Examples of crafts include mechanics, electricians, plumbers, and so forth.

Person groups are a way to group individuals by job responsibilities as opposed to craft skills, for example supervisors or managers. The members of a person group can be assigned to perform similar types of tasks as part of an escalation or a Workflow process, for example approving status changes for records. Person groups might include individuals with different job skills, job titles, or from different departments within a company.

You may also use the Person Groups application to create groups of individuals who do not share job skills or responsibilities, but might work as a team on a project. For example a safety review team might include members from several different departments, crafts, or skill levels.

To access the Crafts application, click the application link on your Start Center, or select Go To → Administration → Resources → Crafts.

The Crafts application (shown in Figure 7-10 on page 137) contains the following tabs:

- List
  Use this tab to search Maximo for craft records.

- Craft
  Use this tab to create, view, modify, or delete craft records.

- Associated Labor
  Use this tab to add, view, modify, or delete the association between labor cords and crafts.
You use the Crafts application to create, view, modify, and manage craft records. You can add one or more skill levels to a craft as a way to indicate which craft members have more experience. You add skill levels by creating new rows in the Skill Levels table window. Skill levels are defined by an administrator in the Domains application.

You use the Outside Rates table window to record and view the standard rates charged by vendors for contract labor for the craft and skill level.

**Note:** Outside rates associated with a labor rate contract cannot be modified after the contract has been approved.

The Craft tab can also be used to define skill levels and specify standard rates for crafts. Premium pay codes associated with each craft are also displayed in this tab. Standard rates for crafts can be based on skill levels, external vendors, and premium pay codes.

**Note:** The standard rate established for a craft is irrespective of the skill level.

You use the Premium Pay table window to list premiums paid in addition to standard rates, for example premiums paid for working particular shifts, for working on holidays, or for possessing a particular qualification or certification. You create, view, modify and delete premium pay codes from a master list of
premium pay codes using the **Manage Premium Pay Codes** action in the Select Action menu.

If the **Apply to New Crafts?** check box is selected for a pay code (Figure 7-11), Maximo automatically copies the pay code to a new craft record when the record is saved. You may provide additional premium pay codes to a craft by creating new rows in the Premium Pay table window.

![Figure 7-11  Apply to New Crafts? check box](image)

Having specified a rate in the Rate field, if you select the Inherit check box, the value in the Rate field will revert to the standard rate and the Rate field becomes read-only. To set a rate exclusively for this labor code, enter a rate in the Rate field and do not select the Inherit check box.

You may associate a labor record with a craft from either the Labor application or the Crafts application. In the Crafts application, you associate labor with a craft by creating new rows in Associated Labor table window on the Associated Labor tab.

If you are creating craft records with similar skill levels and pay codes, you may simplify the record creation process by using the **Duplicate Craft action** available from the Select Action menu. When you duplicate a craft record, Maximo copies the values listed on the record (skill levels, pay codes, laborers and so forth).

You can break the association between a labor record and a craft by clicking the **Mark Row For Delete** button for the labor in the Associated Labor table window. You must click **Save** for the deletion to take effect. When you delete a labor record from the Associated Labor table window, you are not deleting the labor record from the database, you are only removing the relationship between that labor record and the craft.
Work Management

This chapter describes work management concepts and capabilities. The Work Management module focuses on planning and executing work orders, assigning crafts and labor, and reporting costs and assets downtime.

This chapter contains the following topics:

- “Work orders” on page 140
- “Work order flow control” on page 150
- “Plan labor and crafts” on page 153
- “Failure class” on page 156
- “Safety module” on page 159
- “Reporting costs” on page 166
- “Reporting downtime” on page 171
8.1 Work orders

Work orders are used to plan, review, and approve work for assets and locations. When you create a work order, you initiate the maintenance process and create a historical record of work being performed. To access the main application to manage work orders, select Go To → Work Orders → Work Order Tracking.

8.1.1 Work order status

A work order can have a set of status settings that best describes the actions that are performed or are waiting to be performed. By default, the meaning and behavior of a status is provided by IBM Maximo Asset Management and they are described in the following list. However, they can be set and customized to consider the customer requirements. IBM Maximo Asset Management provides the following work orders status values:

- **WAPR (Waiting on Approval)**
  This initial status is where the work order is planned. It allows the setting of job plans and work plans; does not allow entering actual information.

- **WMATL (Waiting on Material)**
  This status indicates waiting for material purchase or acquisition.

- **WPCOND (Waiting on Plant Conditions)**
  This status indicates waiting for plant conditions to approve.

- **APPR (Approved)**
  This status indicates that the work plan is approved. Does not allow changing planned information, like job plan, safety plan and work plan for labor, tasks, materials and services.

- **INPRG (In Progress)**
  This status indicates that the work order is being executed.

- **COMP (Completed)**
  This status indicates that the work order was executed. This status allows to edit some information before closing the work order.

- **CAN (Canceled)**
  This status indicates that the work order is not be executed for a particular reason. It does not allow any editing.

- **CLOSE (Closed)**
  This status indicates the work order is closed and does not permit editing.
An action in the Work Order Tracking application allows the editing of history information about work orders when they are in the closed status. The Edit History Work Order action enables certain information to be edited, including tasks. Labor, materials, services, and tools are not allowed to be edited.

The limits to change work order data, considering work order status, are provided by default in IBM Maximo Asset Management, however they can be edited by using the Edit Rules action in the Organizations application.

**Note:** A work order is created and planned in the Waiting on Approval status. After work is started, it enters the Progress status. When the work order is done, it is in a Completed status and can be closed.

### 8.1.2 Work plans

A work plan describes the labor, materials, tools, services, and tasks necessary to complete a work order. Selecting a job plan to a work order, modifying the work plan to the requirements, or creating a work plan manually are possible.

The Plan tab in the Work Order Tracking application contains all the definitions necessary to create a work plan. You may define tasks and flow sequence for tasks, and request labor, materials, services, and tools.

To add, remove, and modify a work plan regarding labor, materials, services and tools, the work order has to be in the WAPR status. However, to add, remove or update tasks, the work order cannot be in the CAN or CLOSE status.

Tasks also define their own status, which is not necessarily the same defined in the work order. A task can be edited considering the work order status and its status. A task only can be removed if it is at the WAPR status. If some labor is reported for a task, the status is automatically changed to APPR, not allowing labor removal.

Figure 8-1 on page 142 shows an example of a work plan. It defines a series of tasks to be performed. Also, it has two planned laborers to do the work.
8.1.3 Job plans

A job plan is a detailed description of work to be performed for a work order. It can be copied to PM records, routes, and directly to work orders. To open the Job Plans application, select Go To → Planning → Job Plans.

Job plans generally contain tasks (procedures), along with lists of estimated labor, labor hours, materials, services, and tools required for the work. It is basically a template used for work planning.

Note: After a work order is canceled or closed, the Work Order Tracking application does not allow any modifications to it; however the action Edit History Work Orders enables a user to modify data and tasks from closed work orders.
This application provides two tabs to manage a plan:

- **Job Plan**
  
  Use this tab to create, modify and delete a job plan record. In this tab it is also possible to specify the tasks, flow control and flow action. This tab also enables to plan labor, materials, services and tools.

- **Work Assets**
  
  Use this tab to add work assets that a job plan relates to.

Figure 8-2 shows an example of a job plan for pump services, which defines tasks. Figure 8-1 on page 142 showed the work plan based on this job plan.

![Job plan example for pump service](image)

Defining a job plan in a work order implies in copying all the content from a job plan to a work plan. It serves as a template for the work plan. After a job plan becomes a work plan on a work order, you can modify the work plan without affecting its original job plan. It is also possible to modify a job plan without affecting already generated work plans.

To select a job plan in a work order, select **Go To → Work Orders → Work Order Tracking application**, and then select a work order. In the Job Plan field, filter the desired job plan.
The work assets defined in a job plan enables you to filter a job plan considering the same work assets used by the work order. Figure 8-3 shows this filter option, enabled by the first check box: Show Job Plans for the Work Order’s Asset and Location Only.

![Figure 8-3 Work order job plan filter](image)

**Note:** A work plan can be defined manually or can be created by a job plan. Changes made to a work order work plan do not affect its job plan.

**Create a job plan from a work plan**

When you manage work orders, an action is available to create a job plan from an already-created work plan. The Create a Job Plan from a Work Plan action is located in the Work Order Tracking application and performs this task. The only information necessary to provide is a new name for the job plan that is being created.

Figure 8-4 on page 145 shows an example of creating a job plan from the current work order. The work plan used in this example is from the work order previously presented in the Figure 8-3 and in Figure 8-1 on page 142.
Figure 8-4  Create a job plan from a work plan

Creating a job plan from a work plan reuses the following information:

- Work order data, like responsibilities, priorities, flow control
- Work assets such as work order asset and location
- Tasks and flow control sequence
- Planned labor, material, services and tools

Figure 8-5 shows the job plan example created by the action executed in Figure 8-4.
Figure 8-6 displays the work assets of the job plan created from the work plan by the action described in Figure 8-4 on page 145. This action reuses the asset and location information from the work order.

![Figure 8-6 Job plan created from a work plan](image)

**Note:** The Work Order Tracking application can create a job plan from a work plan using the Create Job Plan from Work Plan action.

### 8.1.4 The Move/Swap/Modify actions

In a work order, IBM Maximo Asset Management supports asset move and swap, attributes modifications, and users and custodians assignments. The Move/Swap/Modify action is used to plan and execute these changes to assets and locations. This action is located in the Work Order Tracking application when you select **Go To → Work Orders → Work Order Tracking**.

The changes can be saved as a plan or can be executed immediately. If they are saved as a plan, they are automatically executed when the work order is changed to the completed status. Otherwise, if it is executed immediately, the changes are done and the Move/Swap/Modify dialog is closed. Press **Execute Now** button or **Save as Plan** button to choose between these two options.

**Move action**

Use the Move/Swap tab to move or swap an asset. If the check box for swapping is not enabled, a move can be planned or executed. When you move an asset, the following fields are available, which define where the asset is going to be moved out to:

- Move To Parent
- Move To Location
- Move To Bin

You may select more than one asset to be moved by a work order.
Figure 8-7 show an example of moving an asset from SHIPPING location to the AIR105 location.

Swap action
The Swap action is located on the Move/Swap tab. If the swap check box is selected, the action executes an asset swap rather than a move. On any single work order, you must choose either move or swap, but not both move and swap. Swaps are assumed to just be swapping one thing by another. Attributes cannot be modified.

When swapping, assets continue to have the options to move to a parent, move to a location, and move to a bin. There is one more information provided, the Replacement Asset field, which enables to select the asset that replaces the current one. It is possible to select a list of assets for swapping in a single work order.

Note: The Move/Swap tab allows either moving or swapping assets. The move function uses new location information; the swap function uses new locations and replacement assets information.

Modify action
The Modify tab allows changes to asset or location attributes. To enable changing an attribute from one of these objects, you must specify and classify this attribute in the Specifications tab, available from each application that defines these objects.

Figure 8-8 on page 148 shows an example of modifying the alternate name of the asset 11230, that is classified as a motor.
Attribute modifications are not allowed for the assets that are being swapped. Defined locations are still allowed to have attribute modifications even during a swap.

**Note:** The Modify action can change an attribute value from an asset or location.

### The Users and Custodians tab

While performing move, swap, or modify actions, you may define users and custodians for assets and locations selected. The Users and Custodians tab in the Move/Swap/Modify action enables this functionality.

Figure 8-9 on page 149 shows an example of changing the custodian of asset 1002 to Wilson.
Work orders enable you to define an owner or an owner group to track responsibility of the current work that is being done. An owner is not necessarily the same person that is going to execute a work order. An owner performs an administrative task that assures the execution of the work order.

The Work Order Tracking application provides, on the Work Order tab, the Responsibility area where you may view the owner and the owner group for the current work order. The Owner and the Owner Group fields are read-only. To select an owner, select either one of the following actions:

- Select Owner action enables selection of a person or a person group from a list to take ownership of the current work order.
- Take Ownership action assigns the logged-in user as the owner of the current work order.

Both actions are used to designate ownership for work orders.
8.2 Work order flow control

Tasks are part of work plans and help to divide work orders into steps to structure, organize, and report activities according to the work that is being executed. A work plan and a job plan are used to define tasks.

Tasks define status and sequences that indicate the current phase of the work order. Tasks can automatically flow through their sequences considering work order status and tasks status. For more information about work plans, refer to 8.1.2, “Work plans” on page 141 and 8.1.3, “Job plans” on page 142.

8.2.1 Process flow

A process flow denotes, for sequencing purposes, when a work order and its tasks start and complete. It is defined in work types, which can be associated in work orders. Process flow enables the processes to automatically start and complete considering the work order status.

Work types can be managed in the Organization application, located at Go To → Administration → Organization. To access Work Type action, select a valid organization, and in the Action menu, select Work Order Options → Work Type.

Figure 8-11 shows an example of a work type that define the process flow to start when the work order is in progress and to end when it is completed.
8.2.2 Flow control

Flow control enables a task sequence to be executed automatically. Task flow sequences are used to indicate the steps necessary to complete a work order following a structured plan.

The Predecessors field, located in each task, is used to define the task predecessors that enable tasks to start in a planned sequence. This field determines all predecessor tasks that have to end their flow before starting the flow of the next tasks.

A task flow control is controlled by the Under Flow Control check box, which enables the task to change its status considering the sequence defined. This check box is located in the work order level and in the tasks level. The option for flow control has to be enabled in the work order level to allow activation in the tasks level. After it is enabled in the work order level, all of the tasks enable theirs
automatically, including the new ones. You may disable this option separately for each task.

Figure 8-12 shows an example of a work order that enables flow control in the work order level. The work type automatically starts the flow sequence when the status is changed to INPRG (in progress).

![Figure 8-12 Work order that enables flow control and automatically starts it](image)

When the work order, shown in Figure 8-12, changes its status to INPRG, its tasks automatically start their sequence flow. The first task in the sequence changes its status to in progress; the other tasks continue with the same status.

When the current task changes its status to completed, the next task changes its status to in progress. As the work type defines the end of the process in the completed status, the work order is completed when all tasks are completed.

By default if a work type is not defined, and to facilitate flow control use, the work order starts the process flow when it is INPRG, and ends when it is in the COMP (completed) status.

**Note:** Work orders can automatically start tasks flow control considering the work type defined. Tasks can automatically follow their sequences when the work order is under flow control.

### 8.2.3 Flow action

Work order flow action functionality is used to execute actions when the work order is started with process flow control. The action to be fired is selected in the Flow Action field, located in the Work Order tab and in each task definition. The
Flow Action Assist check box suppresses the automatic firing of the selected action. Figure 8-12 on page 152 shows these fields.

Figure 8-13 shows examples of actions that can be executed.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTIVITY APPLYSLA</td>
<td>Apply SLA to Activity</td>
<td>WOACTIVITY</td>
</tr>
<tr>
<td>CHANGE APPROVE</td>
<td>Approve Change</td>
<td>WOCHANGE</td>
</tr>
<tr>
<td>CHANGE CANCEL</td>
<td>Cancel Change</td>
<td>WOCHANGE</td>
</tr>
<tr>
<td>CHANGE COMPLETE</td>
<td>Complete Change</td>
<td>WOCHANGE</td>
</tr>
<tr>
<td>NOSTATUS</td>
<td>Register Status Change Event Action</td>
<td></td>
</tr>
<tr>
<td>OKSTATUS</td>
<td>Clear Status Change Event Action</td>
<td></td>
</tr>
<tr>
<td>PVSTATUS</td>
<td>Prevent Status Change Exception Action</td>
<td></td>
</tr>
<tr>
<td>WFWAKEUP</td>
<td>Wake an instance</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 8-13  Flow action examples*

By default, if a work type is not defined and to facilitate flow action use, a work order starts the process flow when its status is changed to INPRG. When a work order process control starts, the selected action is fired.

**Note:** The flow action functionality executes an action when the work order is started through process flow control and the Flow Action field has an action selected.

### 8.3 Plan labor and crafts

A work order might require different tasks to be performed, and with that might require the services of different laborers or crafts. IBM Maximo Asset Management creates a separated requirement for each task or labor listed on a work plan. For example, if two mechanics are required for a task, two requirements are created. Similarly, if two different crafts are required for a task, IBM Maximo Asset Management creates one requirement for each craft.

The Labor application is used to define labor and related skills, whose definition is provided by the Crafts application. To learn more about managing labor and crafts, refer to Chapter 7, “Resources” on page 119.
8.3.1 Work plans

A work plan is commonly used to add labor and crafts requirements to a work order. The Job Plan application provides a method to apply planned labor consistently; the Work Order Tracking application provides a direct method to plan labor in a work plan. Planning information can be applied to a work order before it achieves the approved status. More references about these applications are described in the 8.1, “Work orders” on page 140.

When planning labor, you may define the task it associates with. It enables a work plan to associate a craft or a person to execute a specific task. A craft is a generic method to plan labor because it specifies the necessary skills to accomplish work. In the planning phase, crafts are better suited because they do not require a specific person.

Figure 8-14 shows an example of planned labor to perform the maintenance in a pump system. It requires a mechanic apprentice and a specific person to accomplish task 10.

![Figure 8-14 Planned labor for maintenance](image)

Note: Labor and crafts can be planned in a work plan through the Job Plan application or the Work Order Tracking application. The Job Plan application is used to apply planned labor more consistently.
8.3.2 Activities and Tasks application

The *Activities and Tasks* application is used to plan, review, and manage activities and tasks. To open this application, select **Go To → Work Orders → Activities and Tasks**. In this application, you may list all activities and tasks from work orders, and consequently plan and report labor, materials, tools and services for them.

Figure 8-15 shows an example of the task 10 created to replace a keyboard.

![Figure 8-15 Using the Activities and Tasks application to plan labor, materials, services and tools](image)

**Note:** The Activities and Tasks application enables you to plan and report labor and crafts for tasks.
8.4 Failure class

Failure class identifies failure hierarchies, which helps you to track the failures that affect assets and operating locations. Using this information can help you to take preventive measures and to analyze failure trends. This classification can be related in assets and locations when it is necessary to report work done on them.

The Failure Codes application is used to create failure classes, whose structure defines failure hierarchies. To open this application, select Go To → Assets → Failure Codes.

8.4.1 Hierarchy

The Failure Codes tab in the Failure Codes application is used to build, view, modify, and delete failure hierarchies. A failure hierarchy is an organized set of data about problems, causes, and remedies related to assets and operating location failures. The failures hierarchies classify possible failures for assets and operating locations when building work orders.

A failure class is defined by the following hierarchy:

- Problems, which define problems for the failure class
- Causes, which define causes for each problem
- Remedies, which define remedies for each cause

Figure 8-16 on page 157 shows an example of a failure class hierarchy for pump failures. Four related problems are shown. For the stopped problem, three causes are described. One remedy is defined for the breaker tripped cause.
8.4.2 Assets and locations failure class

The Assets and Locations applications, which are respectively opened by selecting Go To → Assets → Assets and at Go To → Assets → Locations, can define a failure class for assets and locations, respectively. This enables a work order to define a problem cause considering the failure class of its working assets.

Figure 8-17 on page 158 shows an example of the Centrifugal Pump asset that defines the Pumps failure class, previously shown in Figure 8-16.

Note: A failure hierarchy is defined by a failure class, which can be described by problems, causes, and remedies.
8.4.3 Work order problem code

A work order may reuse the information of a failure class related in an asset or location to be filled in the Failure Class field, which is located in the Work Order Tracking application. Also, this information is filled automatically when you select an asset or a location whose failure class is defined; you may fill it manually.

The failure class information enables the Work Order Tracking application to select a problem code, which gives more options to track and classify a work order. The values provided for the Problem Code field are those that are related in the first level of the failure class previously selected in the Failure Class field.

Figure 8-18 shows an example of a work order that relates the Centrifugal Pump asset shown in Figure 8-18. When this asset is selected, the failure class information is provided, enabling you to select a problem code for the work order. In this case, the problem code selected is STOPPED.
8.5 Safety module

A safety plan has the objective to describe safety requirements to execute or accomplish work orders. This procedure helps employees stay informed about hazards while performing work and the actions they must take to prevent accidents.

IBM Maximo Asset Management provides a set of applications that define safety procedures to be associated with work orders with the objective to define precautions when executing the orders. These applications are located in the Planning module. To open it, select Go To → Planning → Safety.

The Safety module contains the following applications:

- **Hazards**
  This application defines hazards that exist in the workplace, associates preventive measures with these hazards, and links hazards to other related documents.

- **Precautions**
  This application defines safety procedures and lists all hazards associated with it. To relate a precaution to a hazard, use the Hazards application.

- **Lock Out/Tag Out**
  This application describes how to take work assets out of service and how to place them back in service. This application defines the locking and unlocking sequence for the lockout operation.

- **Safety Plans**
  This application defines safety plans to be applied on Job Plans or directly to the work orders.

**Note:** Safety applications are related to planning and are located in the Safety planning module. To open it, select Go To → Planning → Safety.
8.5.1 Hazards

A hazard is important information used in safety plans. It can contain procedures about precautions, hazardous materials, and tag out/lock out operations. Hazards can be managed by using the Hazards application. To open it, select **Go To → Planning → Safety → Hazards**.

A hazard has three types of associations:

- **Precautions**
  This type enables a hazard to contain precautions. A precaution is added to a hazard when the Can Have Precautions check box is selected. This option enables one or more previously created precautions to be related to the current hazard.

- **Hazardous Materials**
  This type enables a hazard to contain information about hazardous materials. If the Can Have Hazardous Materials check box is enabled, this association is set, and you may set hazardous material information to the current hazard.

- **Tag Outs**
  This type enables a hazard to be used with tag out/lock out procedures. Tag outs are created in the Lock Out / Tag Out application and are associated with hazards in both the Assets and Locations application. The Tag Outs tab in the Hazard application lists only the related tag outs.

Figure 8-19 shows an example of an Electrocution hazard that enables tag outs.

![Figure 8-19 Electrocution hazard for tag out/lock out operation](image)

Precautions and hazardous materials are the only things that can be associated together. If a hazard is associated with tag outs, it cannot be associated with precautions or hazardous materials. Figure 8-19 shows this example by disabling the association of precautions and hazardous materials when tag outs is enabled.
Associate hazards with assets and locations

Hazards can be related directly with assets and locations to build safety plans when a work order involves them. Both the Assets and Locations applications provide a Safety tab that enables the association of the selected asset or location with hazards.

On the Safety tab, in both applications, are three sub tabs: Hazards and Precautions, Hazardous Materials and Lock Out/Tag Out. Each sub tab enables associating the specified hazard type.

Figure 8-20 shows an example of associating the asset Electrical Control Panel with the hazard High Voltage. The same tab is provided for the Locations application.

8.5.2 The Safety Plan application

The Safety Plans application defines safety procedures. To open it, select Go To → Planning → Safety → Safety Plans. Safety procedures can be either

Note: Hazards can have three types of associations: precautions, hazardous materials, and tag outs. However, a tagged out type cannot be associated with precautions or hazardous materials.
generic safety plans for use on all work assets or locations, or for use on a predefined set of work asset or location.

A safety plan may contain the following components:

- **Hazards and Precautions**
  This component associates a previously created hazard that relates precautions to a safety plan.

- **Hazardous Materials**
  This component associates a previously created hazard that relates hazardous materials to a safety plan.

- **Tag Outs**
  This component associates a previously created hazard that relates tag-out procedures to a safety plan. Use the Tag Outs tab to specify a tagged-out hazard that defines safety sequences to apply a work asset to or remove it from service.

Figure 8-21 shows an example of a safety plan.

![Figure 8-21 Example of a safety plan to work on an electrical service](image)

**The Tag Outs tab**

The Tag Outs tab is used to add or view procedures to eliminate hazards for work assets. These procedures contain information about lock-out operations and describe how to take work assets out of service and place them back in service.

Figure 8-22 on page 163 shows an example of a tag-out definition inside a safety plan to work with electrical equipment.
Observe that each tag-out has a list of lock-out procedures to be followed. The Apply Sequence column identifies the locking sequence for the lock-out operation and the Remove Sequence column identifies the unlocking sequence for the lock-out operation.

![Figure 8-22 Example of a tag-out to execute power off procedures](image)

**Note:** the Tag Outs tab provides the applicable sequence for locking and the removal sequence for unlocking work assets in lock-out operations.

### 8.5.3 Associate a safety plan

IBM Maximo Asset Management provides several distinct ways to associate safety plans to work orders. An association with a job plan is more structured and can make the process of building work orders easier. However, a work order can directly associate a safety plan. Let us now discuss how to assign a safety plan to a work order using job plans.

**Set up a job plan**

To open the Job Plans application, select Go To → Planning → Job Plans. The application can be used to create job plans and relate work assets to them. To ensure that work performed on a work asset is executed in a safe manner, a job plan can associate safety plans to each work asset listed.

The Work Assets tab of the Job Plans application enables you to associate a safety plan for a work asset. For job plans, a work asset can be assets, locations, or items. Work orders usually reference assets and locations.

Figure 8-23 on page 164 shows an example of a job plan JP12300 that associates the safety plan POLEPLAN for the work asset location POLE300. It is possible enable the current safety plan to be a default one for that work asset.
For more information about managing job plans, refer to 8.1.3, “Job plans” on page 142.

**Note:** The Work Assets tab in the Job Plans application enables associating safety plans for work assets. This makes the process of selecting safety plans for work orders easier.

**Select safety plan for work orders**
To open the Work Order Tracking application, select Go To → Work Orders → Work Order Tracking. This application enables you to select a safety plan for the current work order.

Figure 8-24 on page 165 shows an example of a work order that has a job plan and a safety plan selected. Note that this work order defines the location POLE300 and the asset 52300 as work assets.
When you select a safety plan, three options are available for filtering plans:

- **Show all**
  
  This option does not filter any safety plans.

- **Show for the current work order**
  
  This option filters safety plans based on the asset and location of the work order. This list is based on the safety plans already associated with assets and locations on the Work Assets tab of the Job Plans application.

- **Show safety plans for the job plan of the current work order**
  
  This option lists all safety plans related to the current job plan of the work order. It does not consider the work assets of the current work order.

Figure 8-25 on page 166 shows an example of these options. The selected one is to list all safety plans related to the current job plan of the work order. As already shown in Figure 8-23 on page 164, the Pole Safety Plan is a safety plan for the job plan JP12300.
8.6 Reporting costs

IBM Maximo Asset Management defines various applications that may be used to report actual costs incurred against work orders. The following items can be reported as costs in work orders:

- Labor, which can be reported using the Work Order Tracking application, Labor Reporting application and Quick Reporting application. The Activities and Tasks application can be used to report labor, however it is used to relate tasks and activities instead of work orders.

- Materials, which can be reported using the Work Order Tracking application and the Quick Reporting application.

- Tools, which can be reported using the Work Order Tracking and the Quick Reporting application.

- Services, which can be reported using the Work Order Tracking application and the Services Request application. Services topic is covered in the Chapter 9, “Service Requests” on page 177.
8.6.1 Work Order Tracking application

In the Work Order Tracking application, costs are reported on the Actuals tab. To enter data on this tab, the work order must not have a status of Waiting on Approval, Closed, or Cancelled.

The Actuals tab supports reporting costs for labor, materials, tools and services. Figure 8-26 shows an example of the Actuals tab that reports labor to relocate guard rails around compressors.

Material costs

Material costs can be recorded to a work order if the requested material is a direct receipt. To enable this function, you may receive the material against a purchase order whose purchase order line charges the GL account related to this work order in question. To open the Purchase Orders application, select Go To → Purchasing → Purchase Orders. To learn more about purchasing, refer to Chapter 6, “Purchasing” on page 87.

Figure 8-27 on page 168 shows a purchase order line that references the work order 1172 to report materials costs.
8.6.2 Labor Reporting application

The Labor Reporting application is used to report the type and total number of hours of work that external contractors or internal employees performed. You can enter labor information by work order, labor (timecard reporting), ticket, or contract/vendor.

The Labor Reporting application contains a single table window, which displays labor transaction records. The Transactions table window is used to add, modify, or delete labor transactions. This table displays labor transactions that are entered in this application or in any other application where recording labor actuals is possible. Figure 8-28 on page 169 shows a sample list of transactions.

Note: material costs are recorded to a work order by receiving them by a purchase order that references the work order.
The Labor Reporting application can report labor by:

- **Work order**
  This method selects a work order to report labor time. It is also possible to specify a task from the selected work order.

- **Ticket**
  This method reports labor time by ticket. It is similar to reporting a work order, but instead of selecting a work order, it is selected with ticket class, such as an incident or a problem.

- **Labor**
  This method reports labor directly to a worker. Relating a task or a work order in this method is not necessary. Instead of only reporting labor time, this method also can report labor's attendance.

- **Contract/Vendor**
  This method reports a daily time labor to a contract or a vendor. In this case, a company is selected to report labor.

All these methods require:

- **Labor**, which is essential to classify who performed the selected work and to define rate for payment.
- **Craft**, which classifies the labor's skill and determines rate for premium pay hours. In this application, classifying a craft is only possible after selecting a labor.
- **Transaction type**, which can classify the type of work like actual work time, travel time, sick time, vacation or non work type.
- **Start date**, which determines the date on which the reported work began.
Figure 8-29 shows an example to report by labor. The person selected as laborer is Mike Wilson. One hour is reported for daily time, and one hour is reported for daily attendance.

<table>
<thead>
<tr>
<th>Labor</th>
<th>WILSON</th>
<th>Mike Wilson</th>
<th>Organization</th>
<th>EAGLENA</th>
</tr>
</thead>
</table>

Note: The Labor Reporting application can report labor by work order, ticket, labor and contract/vendor. Reporting by labor gives the option to specify labor time and labor’s attendance.

### 8.6.3 Quick Reporting application

*Quick Reporting application* is used create, review, and approve work orders for assets and locations. You may also define tasks and report actuals information for work orders.

This application practically resumes a work order in one tab, the Quick Reporting tab, which shows work order details, tasks summary and actuals reporting for labor, material, tools and failure reporting. Also, this application does not request services. A work order created in this application starts with the INPRG (in progress) status because planning is not performed in this application.
8.7 Reporting downtime

Downtime is for verifying how much time was necessary for an asset to be down in order for maintenance procedures to be performed. IBM Maximo Asset Management provides an action to report asset downtime in the Assets application and in the Work Order Tracking application.

The two methods to report asset downtime are:

- Set the asset status from UP to DOWN, and from DOWN to UP. With this information, IBM Maximo Asset Management can calculate the time that the asset was down.
- Report the start and end time of the downtime for the asset after it has occurred.

These two methods are provided by the Report Downtime action, which is in the Asset application and the Work Order Tracking application.

Figure 8-30 on page 172 shows an example of the Report Downtime action that changes the status of the fire extinguisher asset from UP to DOWN. After selecting Asset Up and Change Status, then clicking OK, the asset status is changed to DOWN. You may execute the Report Downtime action again to change the asset status back to UP.
IBM Maximo Asset Management provides a function to check whether the asset status is DOWN before completing or closing a work order. This function opens a dialog box that warns you to change the asset status back to UP before finishing a work order.

Figure 8-31 on page 173 shows the message that is displayed before you complete or close a work order that has its asset in the DOWN status. This message reminds you to change the asset status to UP.

8.7.1 Check asset status in work orders

IBM Maximo Asset Management provides a function to check whether the asset status is DOWN before completing or closing a work order. This function opens a dialog box that warns you to change the asset status back to UP before finishing a work order.

Figure 8-31 on page 173 shows the message that is displayed before you complete or close a work order that has its asset in the DOWN status. This message reminds you to change the asset status to UP.
This function can be enabled in the Other Organization Options action or in the Work Type action, both provided by the Organization application, which you can open by selecting **Go To → Administration → Organizations**.

The Other Organization Options action provides a check box labeled as follows:

**Display Downtime Report Prompt upon WO Completion for Asset in a Down Status**

It indicates whether IBM Maximo Asset Management should open the dialog box shown in Figure 8-31.

Figure 8-32 displays the Other Organization Options action.
When defining a work type, you may enable this option by using the Downtime Prompt check box. Figure 8-33 shows an example of the Emergency Maintenance work type that enables the downtime prompt.

Figure 8-33   Emergency Maintenance work type that enables downtime prompt

The two options differ, as follows:

- The Other Organization Options action is more generic and services all work orders specified inside an organization
- The Downtime option, located in the Work Type action, is only considered if a work order specifies a work type that enables the Downtime Prompt check box.

**Note:** A work order can check whether the asset status is up before completing or closing a work order. This option can be enabled by the Other Organization Options action or by the Work Type action in the Organizations application.

### 8.7.2 Downtime history

Assets downtime history can be edited by the Manage Downtime History action, which is provided by the Assets application and by the Work Order Tracking application.

This action lists all the downtime history for the selected asset. You may edit the downtime start date, end date, start work order, and end work order in which the downtime is reported. Figure 8-34 on page 175 shows an example of this action.
Figure 8-34  The Manage Downtime History action

**Note:** the Manage Downtime History action enables you to edit the downtime history of assets.
Service Requests

This chapter contains information regarding service requests and their use and configuration within IBM Maximo Asset Management.

After it is configured, the application can process service requests in several ways including agent-entered, Web-based, or through an e-mail listener.

This chapter contains the following topics:

- “Service Requests application” on page 178
- “Self-Service” on page 182
9.1 Service Requests application

A service request is used for reporting an issue, requesting information, or a change to a service. The Service Requests application allows a service desk agent to manage service requests from internal or external users as well as enter new service requests.

9.1.1 Out-of-the-box functionality

The Service Requests module and its related modules such as self-service have been enabled with standard functionality that is already configured (referred to as out-of-the-box). For example, when a service desk agent selects an owner or owner group, the status for the service request automatically changes from NEW to QUEUED. However, this type of functionality may be configured to fit the customer requirements.

The service request can have the following status values:

- **NEW**
  A service request has been created. You cannot revert to this status after it has been changed.

- **QUEUED**
  Service request ownership has been given to a person or a group. Ownership assignment can be made manually or might be made automatically through workflow, a service level agreement, or other escalation process.

- **INPROG**
  The service request is in progress. Someone is working on this service request. The first time a service request reaches this status, the system populates the Actual Start field, if it is empty.

- **PENDING**
  A service request is pending an action (for example, waiting for a vendor or user callback, or waiting for parts).

- **RESOLVED**
  The service request has been resolved. Information has been gathered and routed, service has been restored or a solution has been provided. The first time a service request reaches this status, the system populates the Actual Finish field, if it is empty.

If necessary, you may reopen a service request and change the status from RESOLVED to INPROG.
CLOSE

The service request is closed. The service request is now a historical record. When a record is closed, you cannot change the status. You can, however, edit certain parts of the record.

Furthermore, many business processes use a service request as their initial contact with the customer and then create and associate subsequent records to fulfill the customer requirements. See Figure 9-1.

![Service Request Create menu](image)

**Figure 9-1  Service Request Create menu**

*Note:* Service requests exist at the system level.

### 9.1.2 Creating a service request

Within the Service Requests application, select the **New Record** icon to begin creating a service request. The only required field when creating a service request is the ID.

### 9.1.3 Owners and person groups

When a service desk agent is using the Service Requests application to assign to the appropriate owner or owner group the agent may select from either a *person* or *person group*, which might or might not be a group of workers. The agent may select the ownership from either the Select Action menu or the toolbar. See Figure 9-2.

![Service request owner](image)

**Figure 9-2  Service request owner**
When creating a person group, the user or administrator selects people and then orders their assignment sequence. The first person in the person group is selected as the group default as seen in Figure 9-3.

![Figure 9-3 Person group default assignment](image)

Person groups may be used for assignment on work orders, service requests or tickets, and also roles for use within workflow.

Figure 9-4 shows the configuration of a person group in a new role.

![Figure 9-4 Role configuration with a person group](image)

**Note:** Person groups can be associated to roles for ease of assignment.

### 9.1.4 Ticket Templates

The *Ticket Templates application* allows you to create and manage predefined templates for common high-volume service requests, incidents, or problems.

To open the Ticket Templates application, select **Go To → Service Desk → Ticket Templates**.

When you create a ticket template, the two required fields are Template ID and Class. The Template ID is the unique identifier for a particular template, and
Class is used to determine the type of ticket record that the template will be applied to, such as service request, incident, or problem.

### 9.1.5 Applying a ticket template to a service request

To apply a ticket template to a service request perform the following steps:

1. Select the record from the List tab and then use the Select Action menu to choose **Apply Service Request Template**, as shown in Figure 9-5.

![Figure 9-5 Select Action menu for service request](image)

2. Select the template you want to apply, as shown in Figure 9-6 on page 182.
9.2 Self-Service

IBM Maximo Asset Management offers several methods for users to enter service requests without having to contact an agent. These include creating and managing requests from within the Self-Service module, and the use of the e-mail listener to generate service requests from an e-mail.

9.2.1 Create Service Request

To access the Create Service Request application, select Go To → Self Service → Service Requests → Create Service Request.

Within the Create Service Request application, the logged-in users person record details are automatically populated on the request. A user may submit a request on behalf of another user, as shown in Figure 9-7.
Within the self-service request are several additional fields including asset, location, priority, and classification. See Figure 9-8.

![Figure 9-8  Service Request Classification](image)

**Note:** Service desk agents can use classification to compare and verify whether other similar service requests have been created.

### 9.2.2 View Service Request

To access the *View Service Requests application*, select **Go To → Self Service → Service Requests → View Service Requests**.

Within the View Service Requests application users may filter and view their own service requests. Also, a user may update the communication log for a service request as shown in Figure 9-9 on page 184.
9.2.3 E-mail Listeners

To access the E-mail Listeners application, select Go To → System Configuration → Platform Configuration → E-mail Listeners.

The E-mail Listener application is used to receive and process requests submitted through e-mail. Multiple e-mail listeners may be configured on different mailboxes to process all types of requests such as for different departments within an organization.

When configuring an e-mail listener, an administrator has to provide details such as the e-mail address, mail server, protocol, and its processing frequency, as shown in Figure 9-10 and Figure 9-11 on page 185.
Figure 9-11  E-mail Processing Frequency
After the installation is complete, several tasks have to be completed before you can enable the users to start using the system. Several other tasks, which help to maintain and tune the system, have to be carried out by a system administrator.

This chapter contains the following topics:

- “Security settings” on page 188
- “Logging application” on page 189
- “Log files” on page 190
- “Database configuration” on page 191
- “System Properties” on page 194
- “Attached documents properties” on page 196
- “Electronic audit signatures” on page 196
- “Actions” on page 197
- “Roles” on page 199
- “Person and person groups” on page 202
- “Cron task setup” on page 202
- “System performance issues and guidelines” on page 203
10.1 Security settings

Before configuring the system for WebSphere Application Server or WebLogic Server security, review the following considerations:

- The application server is configured to authenticate against an LDAP server user registry.
- The system supports integration with Microsoft Active Directory® or IBM Tivoli Directory Server, and lets you move LDAP server data into the application database tables.

10.1.1 Synchronization

Synchronization keeps data in the system current with data in the LDAP directory server. How data synchronization occurs depends on whether you use WebSphere Application Server or WebLogic Server:

- For WebSphere Application Server, data synchronization between LDAP repositories and the system is governed by the federated repositories, which, in turn, are managed by Virtual Member Manager and the VMMSYNC cron task.
- For WebLogic Server, data synchronization between LDAP repositories and the system is managed by the LDAPSYNC cron task.

10.1.2 Application server security

For application server security, two types of security files are used:

- Global Security files
- Application server security files

Global security files
The global security files are:

- ibm\SMP\maximo\applications\maximo\properties\maximo.properties
- ibm\SMP\maximo\applications\maximo\maximouiweb\webmodule\WEB-INF\Web.xml
- ibm\SMP\maximo\applications\maximo\mboweb\webmodule\WEB-INF\Web.xml
To configure the system to use application server security, follow these steps:

1. In the system properties file, add the property, `mxe.useAppServerSecurity`. Set the value of the property to 1 and save the file.

2. In the `applications\maximo\maximouiweb\webmodule\WEB-INF\Web.xml` file, uncomment the lines shown in Example 10-1.

**Example 10-1  Web.xml with uncommented lines**

```xml
<!--
<login-config>
<auth-method>BASIC</auth-method>
<realm-name>MAXIMO Web Application Realm</realm-name>
</login-config>
```

**Application server security files**

To be able to configure application server security, the following files must be modified in the application’s home directory:

- `...\maximouiweb\webmodule\WEB-INF\Web.xml`
- `....\properties\maximo.properties`
- `....\maximo\mboweb\webmodule\WEB-INF\Web.xml`

### 10.2 Logging application

You use the *Logging application* to manage log settings and configure log files. The application is part of the System Configuration module of the product.

The Logging application enables you to:

- Create loggers that are components in the product that prepare log statements to be written to console or log file.
- Associate the appropriate log level with each logger.
- De-activate loggers except root loggers.
- Configure appenders that represent a console or log files to which log statements are written.
- Specify an appropriate file name for an appender.
- Specify a log file size for an appender.
- Associate a logger with multiple appenders.
- Associate an appender with multiple loggers.
The Logging application has two table panels (Figure 10-1):

- Root Loggers is for defining the basic loggers of the product.
- Loggers is for defining the child loggers that extend from a basic logger.

![Logging application](image)

**Note:** You can apply logging changes to the application server without interrupting users by selecting **Apply Settings** from the Select Action menu. This step has no effect on the existing users sessions.

### 10.3 Log files

The application server keeps log files of connections, exceptions, and other failures discovered by the application server in real-time. These logs are often helpful in diagnosing errors, in particular EAR (Enterprise ARchive) files and other back-end operations, such as database connections. As an example, if performance is slow, the administrator can start by reviewing these log files:

- systemerr.log
  
  This file logs connections, exceptions, and other failures experienced by the WebSphere Application Server in its day-to-day running.

- systemout.log
  
  This file also logs connections, exceptions, and other failures experienced by the WebSphere application server.
Chapter 10. Other configuration options

- **native_stdout**
  
  This file logs verbose garbage collection information. This log is helpful in the diagnosis of memory and garbage collection issues.

- **maximserver.log**
  
  In WebLogic, this file logs connections, exceptions, and other failures experienced by the application server in its day-to-day running. This log is often helpful in the diagnosis of issues.

- **Maximo.log**
  
  This file logs IBM Maximo Asset Management output, based on settings in the `Logging application/logging.properties` and System Properties:
  
  - Applications: This log file can be influenced by logging levels and types of information from the e-mail listener and the System Properties applications.
  - Files: This log can also be influenced by both the `maximo.properties` and `logging.properties` files.

### 10.4 Database configuration

Database configuration is based on objects. A one-to-one correlation exists between each object and each existing table. Behind the scenes, the business object fetches the columns of the corresponding table and presents them to you as attributes of the object.

Use the *Database Configuration application* to create or modify the objects and attributes in the database used by applications. Some of the things you can do are:

- Change attributes definitions
- Associate domains to attributes
- Create new user defined objects
- Add new attributes to existing objects
- Create and drop indexes
- Create views to look at data from a single, or multiple, objects
- Specify GL account formats
- Set the field length and format for certain fields
- Update statistics on indexes to improve database performance
- Configure the system with multiple languages
- Set up electronic signatures and electronic audit records

When modifying the database (examples: creating or deleting objects, attributes, or indexes), changes are stored in the secondary tables and do not take effect.
until you configure the database. The product restores the backup tables as part of configuration.

The two ways to configure the database are in:

- Command-line mode
- Admin Mode

**Considerations for command-line mode**
You must shut down the application server to configure the database in command-line mode. Command-line mode also requires an information technology administrator user who has control over the application server.

**Considerations for Admin Mode**
To configure the database in Admin Mode, you must have administrator login security authorizations, which permits you to log in when the server is in Admin Mode. This level has five login sessions when Admin Mode is set to ON. You grant these authorizations in the Security Groups application.

The following other considerations apply to Admin Mode:

- No requirement to shut down the application server.
- Admin Mode blocks users from the product applications.
- Admin Mode suspends cron tasks.
- Admin Mode does not allow remote connectivity.
- Admin Mode disables event listeners.

**Note:** When configuring the database in Admin Mode, ensure that all users are logged off. In the case of deploying the EAR file or applying a fixpack, the application has to be taken offline.

**Configuring the database in Admin Mode**
To configure the database in Admin Mode, follow these steps:

1. From the Select Action menu, select **Manage Admin Mode**.
2. In the Turn Admin Mode ON dialog box, if necessary, modify the values in the following two fields. The default value is 5 for each field:
   - Number of Administrative Sessions Allowed
   - Number of Minutes for User Logout

   See Figure 10-2 on page 193)
3. If you modify these fields, click Update Properties for the parameters to take effect.

4. Click Turn Admin Mode ON.

5. In the Electronic Signature Authentication dialog box, type the appropriate value in the Reason for Change field.

6. Click OK. A dialog box opens that indicates that the Admin Mode is starting.

7. Click OK.

8. Throughout the configuration process, click Refresh Status to view the messages that the configuration process writes in the Status window.

9. If you decide to cancel the configuration, click Cancel Admin Mode.

10. Wait until Admin Mode is turned ON before performing this step. Then, click the List tab. From the Select Action menu, select Apply Configuration Changes to configure the database and automatically restore backup tables.

11. To turn off Admin Mode, from the Select Action menu, select Admin Mode, and then click Turn Admin Mode Off.
10.5 System Properties

You use the *System Properties application* to manage system properties and their values used by various product components. The application is part of the System Configuration module of the product. This application hosts the majority of the application's properties.

The System Properties application enables you to:

- Add a new system property.
- Modify an existing property.
- Delete an existing property.
- Encrypt the value associated with the property.
- Associate a domain with the property.
- Specify the data type for specific properties.
- Apply properties and their values to the product dynamically.
- Restore original out-of-the-box values that are shipped with the product.

The System Properties application has two table panels:

- Global Properties is for defining system-wide properties of the product.
- Instance Properties is for defining instance-specific properties of the product.

**Note:** Properties defined in the `maximo.properties` file will be read first, after starting the application server.

Another characteristic of the System Properties application is the *Live Refresh* which allows you to determine whether a new value for a system property can be applied and take effect immediately throughout the product. You do not have to shut down the application when applying a change to `maximo.properties` files.
System property types
The two types of system properties are:

- **Global**
  
  This property exists only at a system-wide level, which means that the property is applicable to all product server instances (such as an application server) working with a common database. For example, the system property `mxe.logging.rootfolder` is a global property whose value is a directory on the hard disk of the server machine where the product's log files reside.

- **Instance**
  
  This instance property is defined and associated with a specific product server instance. For example, you can configure the system property `mxe.crontask.donotrun` to be an instance-specific property. You do this by associating the `mxe.crontask.donotrun` system property with a specific server (for example, MXServer1) and a value applicable only to that server (for example, a value of BBCron). As a result of this configuration, the Bulletin Board cron task (BBCron) is not executed on MXServer1, but it can execute in another product instance, such as MXServer2.

### 10.5.1 Security levels

This characteristic determines whether this property can be retrieved before establishing an authenticated connection to the product. The three levels of security are:

- **PUBLIC**
  
  The property and its value are accessed by unauthenticated client sessions.

- **SECURE**
  
  The property and its value are accessed by authenticated client sessions.

- **PRIVATE**
  
  The property and its value are accessed only within the product business object framework.

**Note:** If a `maximo.properties` file exists and contains the same property name but a different value than the database is aware of, the value maintained in the database will be overridden by the settings in `maximo.properties` file.
10.6 Attached documents properties

You may configure attached documents properties to meet your requirements. You might have to configure attached documents either in the System Properties application or the maximo.properties file.

The attached documents properties are:

- `mxe.doclink.doctypes.defpath`
  This property is the default path for the doclinks folder on the application server computer where the physical documents that are attached to a system record are stored.

- `mxe.doclink.path1 - mxe.doclink.path10`
  Use these to specify the HTTP server path (from path1 to path10) to link documents that are attached to records.

If you are configuring attached documents, you have to modify:

- The `httpd.conf` file for the WebSphere application server
- The `web.xml` file for the WebLogic application server


10.7 Electronic audit signatures

You can enable electronic signature and electronic audit records independently of each other. Typically, however, they are used together.

The Electronic Auditing function writes audit records to the database tables when you modify an audited attribute. The Electronic Signature function records the person who made the modification.

After enabling electronic audit records for a database attribute, the process is:

- Each time a user adds, deletes, or modifies the value of an attribute using a system application, and then saves the change, an audit record is written to the audit object corresponding to the regular database object.

- The audit record includes:
  - Copy of the changed data
  - User name of the user who made the change
  - Identifier indicating whether the change was an insert, update, or delete
– Current date and time of the transaction
– Rowstamp
– Unique e-Audit transaction ID
– Unique e-Sig transaction ID if electronic signature is enabled
– The key values columns for the record, even if those columns are not enabled for electronic audit (for example, the work order number is recorded even when another attribute in the WORKORDER object triggers the electronic audit)

**Note:** Audit records are written in the selected database table name preceded by A_ (which is the letter A followed by an underscore character).

### 10.8 Actions

Actions are scheduled events that occur when a record leaves a workflow node. The *Actions application* is used to create and manage actions and action groups. Actions and action groups can be used with escalation, service level agreement (SLA), and workflow processes. An action group contains multiple actions that are initiated or processed in sequence.

#### 10.8.1 Working with action records

You may use the Actions application to create and manage actions and action groups. Actions and action groups can be used with escalation, service level agreement (SLA), and workflow processes.

An action is an event that is triggered when the escalation engine finds records that meet the conditions defined by an escalation point, SLA, or workflow process. You can create actions that initiate an application action, change the status of a record, run a custom class or a specified executable program, or set the value of a field on a record.

You use the *Actions application* to create and manage both individual action records and action group records. An action group contains multiple actions that are initiated or processed in sequence.

Workflow processes use actions to move records through a process and to trigger events, for example, status changes. Creating records in the Actions application lets you define actions once, then reuse them when creating multiple Workflow processes.
Understanding actions and escalations

An escalation is a mechanism for monitoring time-sensitive records automatically, which can take actions or send notifications when a record reaches a defined escalation point. You create the actions that are associated with an escalation record in the Actions application.

**Note:** Actions can be triggered by escalations, and escalations can trigger workflow processes.

Creating action records

You can create several types of actions by using the Actions application. When you create an action record, you specify an action type to help determine what kind of action to take when the action is encountered in a process.

**Note:** The Type and Action fields are required in order to create an action.

**Action types**

An action can be one of the following types:

- **APPACTION**
  
  This type specifies that an application action be initiated. The type requires values in the Object and Value fields. When creating an APPACTION type action, you specify one of the following actions if it is available for the specified object:
  
  - Apply SLA: Apply the specified service level agreement.
  
  - Create Change: Create a change work order.
  
  - Create Incident: Create an incident ticket.
  
  - Create Problem: Create a problem ticket.
  
  - Create Release: Create a release work order.
  
  - Create SR: Create a service request ticket.
  
  - Create WO: Create a work order.
  
  - WF Accept: Accept the record and route it to the positive path in the workflow process. Also known as workflow auto-accept).
  
  - WF Escalate: Escalate the record in the Workflow process and reassign the assignment to its escalation role.
– **WF Initiate**: Initiate a Workflow process. This option requires a value in the Parameter/Attribute field.

– **WF Reject**: Reject the record and route it to the negative path in the workflow process. Also known as workflow auto-reject.

➤ **CHANGESTATUS**

This type specifies that the status of a record will change. The type requires a value in the Object field and status in the Value field.

➤ **CUSTOM**

This type specifies that a custom class file should run. The type requires a value in the Object field and the name and path of a class file in the Value field.

➤ **EXECUTABLE**

This type specifies that a program on the server should run. The type requires the name of a program file in the Value field.

➤ **GROUP**

This type specifies that the system should run the sequence of actions that you specify in the Members table window.

➤ **SETVALUE**

This type specifies that the system should set the value of a specified field. The type requires values in the Object, Value, and Parameter/Attribute fields.

## 10.9 Roles

You use the *Roles application* to create, modify, view, and delete role records that can be used as part of a communication template, escalation, SLA, or workflow process. When a role is used within a process, the system can determine the correct individual or individuals the process is routed to, based on information with the role record.

A *role* is a function or position in a business. A role can represent a specific job title, for example, a department manager, or an assigned duty, for example, a watch officer. You may also use a role to represent a specific person or a group of people. Role settings can be used with:

➤ Communications templates
➤ Escalations
➤ Service level agreements (SLA)
➤ Workflow processes
10.9.1 Understanding roles and workflow

Workflow inbox assignments and workflow notifications are always made to roles. All role records point to one or more person IDs or to a table and column in the database that represent a person. When a role is encountered in a workflow process, it resolves the role to a person group or individual person record.

Using role records instead of person records for assignments and notifications enables you to create more generic Workflow processes that require less maintenance as individuals move in and out of different roles within your company.

Understanding role types
You use a role to represent different functions or positions. When you create role records, specify a role type to help you determine how to resolve the role when it is encountered in a process.

You can create the following types of roles (see Figure 10-3 on page 201):

- **CUSTOM**
  
  Use this role when you want to use a custom class file that resolves to one or more people. Custom class files are Java programs written to perform specific data management processes. The record is routed to one or more people based on the data returned by the custom class program.

- **DATASET**
  
  Use this role to route a record that is based on a specific field on a record, or a field on a related record or child record. Specify a value in the Object field when creating DATASET type roles. The record is routed to one or more people based on the field that you specify in the Value field. Examples of fields that can be used with a DATASET type role include Affected User, Reported By, Supervisor, Work Group, and so forth.

- **EMAILADDRESS**
  
  Use this role to send e-mail notifications to one or more e-mail addresses. Because e-mail addresses might or might not represent individuals who have person records, these addresses can be used for notifications, but not for assignments.

- **PERSONGROUP**
  
  Use this role to route a record to one or all members of a person group. You use the Person Groups application to create person groups. Note:
  
  - If the Broadcast check box is selected, assignments and notifications are sent to all members of the group.
If the Broadcast check box is cleared (the default), the assignment or notification is not routed to all members of the group. Instead, the assignment or notification is routed to the first available group member based on that person's calendar and shift, or to the individual who is the group default assignee. For more detail about how the assignee is determined, refer to 10.10, “Person and person groups” on page 202.

- **PERSON**
  Use this role to route a record to a specific individual. You use the People application to create person records.

- **USERDATA**
  Use this role to route a record based on a specific field within the person record of the logged in user.

**Notes:**
- Three fields are required in the Roles application: Role, Type and Value.
- For the Value field to be valid Person, Person Group, or E-mail address has to be specified.

Figure 10-3 shows the Roles application.
10.10 Person and person groups

Use the Person Groups application to create, view, and modify person groups. A person group consists of people, who might or might not be workers. The only required field is the Group field. After you have created these groups, you can designate a person group as any of the following options:

- Workgroup
- Owner group on a work order
- Owner group on a ticket

A Person Group can also be the recipient of a document routed by a workflow process. If a document is routed to a Person Group, everyone in the group receives it unless you configure the process to send it to the individual whose calendar indicates that they are available.

When creating new Person Groups, note that the first person assigned to the group is automatically selected as the default group.

Assigning a Person to a Person Group would require you to specify the Person and the Sequence. The sequence representing the numerical value, which indicates to the workflow the assignment sequence for this person.

10.11 Cron task setup

Use the *Cron Task Setup application* to add cron tasks and cron task instances, remove cron tasks and their instances, and modify cron task parameters. You may also change the status by using the **Active?** status check box, or adjust the schedule of a cron task. Cron tasks can be rescheduled and parameter values can be changed without stopping and restarting the server.

**Notes:**

- WebSphere Application Server: Data synchronization between LDAP repositories and the system is governed by the federated repositories which, in turn, are managed by the Virtual Manager and the VMMSYNC cron task.
- WebLogic Server: Data synchronization between LDAP repositories and the system is managed by the LDAPSYNC cron task.
10.12 System performance issues and guidelines

This section offers tips and tricks to tailor the system performance to your requirements.

10.12.1 Factors in system performance

System performance depends on more than the IBM Maximo Asset Management itself and the database. The network architecture also affects performance. The application server configuration can hurt or improve performance. The way that you deploy the application across servers affects the way the application performs. Many other factors can also be considered for improving the user experience of system performance.

Better performance can be gained from examining the following factors:

- Application server configuration
- Scheduled tasks (cron tasks)
- Reporting
- Integration with other systems with the Maximo Enterprise Adapter
- Network issues
- Bandwidth
- Load balancing
- Database tuning
- SQL tuning
- Client workstation configuration
- Miscellaneous performance improvement tips
- Troubleshooting

10.12.2 Configuration issues

Even with fewer than 50 users, the basic application configuration can become overloaded by using hardware-consuming tasks. For example, running scheduled jobs (cron tasks) or running reports both require considerable memory and processing power.

When processing power and memory are overtaxed, the user who is using the application from a browser can experience reduced performance. If the basic configuration is performing poorly, you might have to deploy the advanced enterprise configuration.

In the basic configuration, even if the application server process runs on a 64-bit computer, performance can be slow. Although a 64-bit computer allows greater
memory utilization, the server process suffers from Java garbage collection pauses because of large heap space, and slow performance.

10.12.3 Performance and system maintenance guidelines

The following considerations are related to system maintenance:

- Define a fixed maintenance window to perform routine maintenance on your deployment. Inform your users of the maintenance schedule by using the Bulletin Board within IBM Maximo Asset Management.

- Perform load-balancing tasks on your servers and reassess your thread counts and your socket and memory settings in your application deployment on a regular basis. Consult the WebSphere Application Server and WebLogic Server documentation for further information.

- Adjust thread counts to improve performance. Application servers use threads to listen for and process requests from the browser. A thread represents a work item or task. Application servers (WebSphere Application Server and BEA WebLogic Server) have default settings for number of threads. WebSphere Application Server has a default minimum thread size of five. A WebLogic Server has a default thread count of 25 (when started in production mode). You can, and often should, revise these values to improve system performance. To optimize performance, try to determine the correct number of threads.

  If the thread count is too high, you have too many simultaneous requests on the processor level, and servicing the requests becomes inefficient. If the thread count is too low, the processor is not fully utilized. The queue grows and the workload accumulates. The correct number of threads varies from site to site, but an optimal number of threads can often be found in the range of 40 - 55. The number depends on the volume of front-end transactions (user load) and back-end transactions (nonuser load).

- Use the WebSphere Application Server and WebLogic Server monitoring features to set and monitor thread usage and queue times for your application servers.

- To buffer database growth and performance, implement indexes to speed up search requests within common used modules, for example, Purchasing and Work Order Tracking modules. A database administrator can monitor growth and sizing and tune the database accordingly.

- Frequently consult IBM Asset Management user groups and knowledge bases for issues and tips about tuning, performance, and best practices.

- Conduct regular audits and database integrity checks to find any backend database malpractices or possible bugs and errors.
Before implementing any application change, ensure you have a change management procedure and release management protocol in place. Also ensure that change requests are approved by senior management and that they match your business processes. Change requests are best released in phases in the deployment: for example, first the development environment, then training, then acceptance, and only then to the production environment. Use tools such as the Migration Manager to maintain identical deployment platforms.

Review updates and new patch releases in development environments before attempting to implement these changes in acceptance and production environments.

If you are experiencing technical issues with the IBM Asset Management application, copy the IBM Maximo Asset Management database and restore it in a test environment. From there, enable debugging by using the Logging application. Avoid running the Logging application in the production environment; logging may hinder the performance of the application server.

Monitor for processes and applications that are not responding. They use memory and can affect the performance of the client workstation. A workstation can have unresponsive processes or applications that the user might not be aware of. Use system tools, such as the Windows® Task Manager, to check for and stop processes and applications.

Use one active network link only. If a user has both an active wireless network link and an active LAN link, system performance issues can result. Limit users to one active network link.

**Note:** To tune the IBM Maximo Asset Management V7.1 for better performance, review the SQL statements periodically in the QUERY and KPIMAIN tables.

### 10.12.4 Loading and looping of MBOs in memory

MBO stands for Maximo Business Object. All objects in Maximo (Tivoli Process Automation Engine) are represented as MBOs. These objects have their definitions (including parent-child relationships) in the meta data of the Tivoli Process Automation Engine database.

You can learn whether an application or an MBOset is loading a large number of objects (MBOs, for example) into the MBOset and, in turn, into memory. Enable the following property in the `maximo.properties` file to display MBO creation:

```properties
mxe.db.fetchResultLogLimit=200
```
After you enable this property (by uncommenting it), the application server writes a stack trace for each MBOset, which generates a multiple of 200 MBOs.

Analyze the stack trace to determine where the objects are being created. You can then take the necessary steps to reduce the object creation if it was an unwanted event. Using this setting does not cause the server to stop creating these objects. It only displays (on the console or in the logging file) where these objects are created. Increase this parameter to 5,000 or 10,000 to avoid printing logs unnecessarily.

**Note:** The mxe.db.fetchResultLogLimit allows you to identify the memory usage.

**Note:** You can also configure the garbage collection for analysis while tuning the Web application server.

## 10.12.5 Attached documents

Most IBM Service Management applications have Attachments Library/Folder actions you access from the Select Action menu and an Attachments icon and Attachments hyperlink displayed on the application page.

The application highlights this icon and activates this hyperlink when the record has documents attached to it. Additional actions are available by clicking **Attachments**.

Use the *Attached Documents* feature to attach relevant information to a record (or to a task on a record) in the form of a file or Uniform Resource Locator (URL) address. These attached documents can be located on your company’s network, on the Internet, or in a Document Management System (DMS) and might include text files, spreadsheets, images, or Web pages.

The Attached Documents feature allows you to:

- Attach a copy of a document to a record, for example an owner’s manual could be attached to an asset.
- Attach individual documents to records, for example attaching a permit to a work order.
- Attach an image to a record, for example attach a photo to a service request, to view documents attached to a record, or to related records.
Print one or more documents attached to a record.

Manage the Library of documents available to be attached to records.

**Types of attachments**

The Attached Documents feature includes two kinds of attachments:

- Direct Attachments
  These documents are attached directly to an application record. For example, in the Work Order Tracking application, all documents attached to the work order are direct attachments. When working with Attached Documents, you may attach, view, modify, and print documents that are part of the current record's document collection.

- Referential Attachments
  These documents are attached to other application records, which are associated with the current record. For example, a work order record might also display document collections for the asset and location associated with the work order. You may view and print documents that are referential attachments, but you cannot add or modify attachments to related document collections.

**Attached documents administrative actions**

If Attached documents is enabled for an application, three actions appear when you choose **Select Action → Attachment/Library Folders** menu:

- Manage Library
  Select this option to register new documents to the Library and manage the document properties of existing documents in the Library.

- Manage Folders
  Select this option to create document folders and set a default file location for storing documents associated with each folder.

- Associate Folders
  Select this option to associate existing document folders with the current application.
Attaching documents

You can attach documents to records (and to task rows within a record) using either of the following methods:

- First, create a document library using the Attachment/Library Folders → Manage Library action, then attach documents to records using the Add From Library option available from the Attachments menu.

- Attach a document using either the Add New File or Add New Web Page option available from the Attachments menu. Documents can also be added to the library by using these actions.

You may configure the system to connect to a Document Management System (DMS). This option is hidden by default. After enabled, documents that physically reside in a DMS can be registered to the library.

Attached documents configuration

The system uses an IBM WebSphere Application Server or BEA WebLogic server. Using one of these application servers, you can configure the Attached Documents action on a single computer or on multiple computers.

The computers from which you access attached documents must have the relevant applications installed on them. For example, to view a Microsoft Word document, a workstation must have Word installed on it.
Sample certification test questions

In this appendix, we provide sample questions that are representative of those you encounter on the actual certification test. We recommend that you take this sample test after studying the chapters in this book.

Note: All questions have only one correct answer.

This appendix contains:
► “Questions” on page 210
► “Answers” on page 218
Questions

The following questions can assist you in studying for the certification test:

1. When a work order status is changed from “in-progress to complete” or “in-progress to close,” the asset history record gets an update. In which application do you configure this action?
   a. Work Order Tracking
   b. Assets
   c. Preventive Maintenance
   d. Organization
   e. Not required to configure

2. Which average calculation methods can be chosen for a continuous meter?
   i. Static
   ii. Sliding - Days
   iii. Sliding - Reading
   iv. Dynamic
   a. iii and i
   b. ii and iii
   c. i and iv
   d. i, ii, and iii
   e. None of the above

3. If an asset does not have a user or a custodian, any type of user can raise an incident by using a desktop requisition, a service request requisition, or a Service Desk requisition on that asset. True or False?
   a. True
   b. False
   c. It depends on the type of asset

4. In Asset application’s Specification tab, Classification and Class Description fields are applicable when an asset is categorized as which of the following?
   a. Inventory item
   b. Rotating asset
   c. Non-rotating asset
   d. Capitalized asset
   e. None of the above
5. Meters that are used in Meters, Meter Groups, Assets, Locations, Preventive Maintenance, Job Plans, Items, and Condition Monitoring applications reflect logical, not physical, meters. Meters used in these applications signify:
   i. Each gauge is identified individually
   ii. Meters are identified as a measurement point
   iii. Meters can be shared across organization and sites
   a. i and ii
   b. i and iii
   c. i, ii, and iii
   d. None of the above

6. An extended date field on the Frequency Tab of PM overrides the seasonal dates of a PM. If the Adjust Next Due Date field is set to Yes (Y), the calculation of the next due date for a work order generated from the PM uses which of the following calculations?
   a. Extended Date + Frequency
   b. Extended Date - Frequency
   c. Next Due Date + Frequency
   d. Next Due Date - Frequency
   e. None of the above

7. An asset is configured in IBM Maximo Asset Management to generate a work order for PM, based on both frequency and meters. It employs which of the following logic?
   a. Only frequency based work orders
   b. Only meter based work orders
   c. Both frequency and meter, whichever is earliest
   d. Both frequency and meter, based on whichever has later date
   e. Not possible to configure both frequency and meter simultaneously.

8. IBM Maximo Asset Management checks inventory item balances at which of the following levels?
   a. Bin level
   b. Storeroom level
   c. Site level
   d. Organization level
   e. Company level
9. Item's cycle count frequency for ABC categorized items is defined in which of the following locations?
   a. Item Master application
   b. Organization's Inventory defaults
   c. Storeroom application
   d. Issues and Receipts application

10. When Lot type is selected for an item in the Item Master application, which of the following statements is true?
   a. Item has a shelf life
   b. Item is stored in lots
   c. Item is issued in lots
   d. Item has no shelf life

11. GL accounts are configured for any transactions on items that are issued or transferred from a storeroom. If an item is issued from inventory to a job plan task in a work order, where is this entry recorded?
   a. In the GL Debit account
   b. In the GL Credit account
   c. In the GL Debit account and reverse entry recorded in storeroom GL Credit Account
   d. In the GL Credit account and reverse entry is recorded in storeroom GL Debit Account

12. In a Purchase contract, the payment schedule is created in every 30 days from the receipt of materials. How does IBM Maximo Asset Management generate invoices?
   a. Multiple invoices are generated after every 30 days of receipt of the material.
   b. Single invoice is generated for multiple deliveries from the vendor at the end of the contract term.
   c. Generation depends on how frequency of proforma invoice's are raised by the vendor.
   d. Generation depends on the terms and conditions of the contract.
13. In a Labor Rate contract, if there is a revision to one of the craft's standard rate, how can you apply the revised rates?

a. IBM Maximo Asset Management does not allow you to revise standard labor rates. You have to revise whole contract.

b. You can apply Price Adjustments and revise the Standard Labor rates.

c. IBM Maximo Asset Management allows you to modify the complete contract amount but not the rate schedule.

d. It is not possible to modify the labor contract. You need to create a modified new labor contract.

14. In a Warranty contract for an asset or service, how can you monitor and control the Service Provider's performance?

i. IBM Maximo Asset Management does not allow you to define metrics on performance of service provider.

ii. You can define Service Provider's service performance metrics with the help of service level agreements.

iii. You can define your own terms and conditions to monitor and control Service Provider's performance.

a. i

b. ii

c. iii

d. ii and iii

e. None of the above

15. Purchase record line item or service costs are allowed to distribute across multiple GL accounts. To distribute costs across multiple GL accounts which of the following conditions are required?

i. The line item is a direct issue item or service.

ii. None of the items have been received.

iii. The service line is not prorated.

a. i and ii

b. ii and iii

c. i and iii

d. i, ii, and iii

e. None of the above
16. Which of the following criteria are checked and in which order by the system before the invoice status is changed to approved?
   a. Foreign currency and active exchange rates.
   b. Invoice price is within the specified limits (as set by the system administrator) of purchase order.
   c. Standard service costs like freight, installation and others are included in Invoice price and fall within the set limits.
   d. Invoice Lines field - Receipts Required.
   a. i, ii, and iii
   b. i, iii, and iv
   c. ii and iii
   d. ii, iii, and iv
   e. None of the above

17. When an invoice is approved, the invoice price amount is moved to which of the following GL account?
   a. Credit account
   b. RBNI account
   c. Suspense account
   d. Supplier account
   e. None of the above

18. A contractor is working overtime hours based on his labor rate. You can approve payment based on standard labor rate and disapprove payment based on overtime labor rate. True or False?
   a. True
   b. False

19. In IBM Maximo Asset Management, is it possible to issue spares and or tools to a technician and carry those issued items to the work site to complete the work order and return unused material?
   a. Yes
   b. No
20. The relationship between Persons and Labor applications is which of the following?
   i. Persons application is used for workflow and purchase information.
   ii. Labor application is used for crafts, skills, hours worked, certifications.
   iii. Labor record cannot exist without a record in Persons application.
   iv. Data in Persons application is shared with Labor application.
   a. i
   b. ii
   c. iii
   d. iv
   e. All of the above

21. Person Group application is used for which of the following action(s)?
   i. To create a work group.
   ii. To create owner group on a work order.
   iii. To create owner group on a ticket.
   iv. To route a document by workflow to the recipient.
   a. i
   b. ii
   c. iii
   d. iv
   e. All of the above

22. Which statement (or statements) is the definition of flow control?
   i. Flow control is a set of business rules built into the Work Management applications that allow status changes to be processed automatically in a work hierarchy.
   ii. To detect the appropriate time to start a record so that the combination of its status and ownership place it in the right persons work view.
   iii. The ability to run a task-specific action (group) along with the status change that starts it.
   a. i
   b. ii
   c. iii
   d. i, ii, and iii
   e. None of the above
23. The Move/Modify/Swap Select Action in Work order tracking application is used for which of the following action?
   a. To move assets from one location under a site to another
   b. To change the ownership of associated assets from different organizations
   c. To swap an asset or a location from one organization to another
   d. It does not allow modifying associated asset specifications as part of the work order

24. Resolving a service request involves which of the following activities?
   a. Capture relevant information from the party making the request.
   b. Check existing records to the service request.
   c. Create incident, problem or work order.
   d. All of the above.
   e. None of the above.

25. If a service user wants to know the progress on her request, how can she do it?
   a. From the status of the service request.
   b. Under Log tab, a requester can check this under the work log sub-tab (If service users are configured to view the progress.)
   c. Cannot check the progress until the requester receives a communication.
   d. Service users cannot chase service providers until their turn comes, hence none of the above.

26. Is it possible for a Service Provider to modify the work log?
   a. Yes
   b. No

27. Which characteristic determines whether this property can be retrieved before establishing an authenticated connection with the product?
   a. Global
   b. Instance
   c. Security
   d. Domain
   e. Data Type
28. The Logging application enables you to create and manage log files that contain the following types of messages?
   a. Informational, Warning, or Error messages
   b. Warnings or Error messages
   c. Only Error messages
   d. Only Warning messages
   e. None of the above

29. When are the cron task instances reloaded in the Cron Task Setup application?
   i. When you change any other attributes on the cron task instance (schedule, run as user).
   ii. When switching cron task from Active to Inactive.
   iii. If the parameter value is cached when cron task instance starts or reloads. Check the parameter field to see if this occurs.
   iv. Generally, do not submit a reload request after changing parameter values.

   a. i and ii
   b. ii and iii
   c. iii and iv
   d. i and iii
   e. i and iv
Answers

The correct answers to the sample questions in this appendix are:

1. d
2. d
3. a
4. c
5. c
6. a
7. c
8. a
9. b
10. a
11. c
12. a
13. b
14. d
15. d
16. b
17. c
18. a
19. a
20. e
21. e
22. d
23. a
24. d
25. b
26. b
27. c
28. a
29. d
Related publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this book.

IBM Redbooks

For information about ordering these publications, see “How to get Redbooks” on page 220. Note that some of the documents referenced here might be available in softcopy only.

- Deployment Guide Series: Maximo Asset Management V7.1, SG24-7640
- IT Asset Management Processes using Tivoli Asset Manager for IT, SG24-7601
- Maximo Asset Management Essentials V7.1 Implementer’s Guide, SG24-7645

Online resources

These Web sites are also relevant as further information sources:

- IBM Professional Certification Program Web site:
- Test 015 objectives
- IBM Maximo Asset Management V7.1 courses:
- IBM Maximo Asset Management V7.1 online publications:
How to get Redbooks

You can search for, view, or download Redbooks, Redpapers, Technotes, draft publications and Additional materials, as well as order hardcopy Redbooks publications, at this Web site:

ibm.com/redbooks

Help from IBM

IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
Index

A
actions 197–198
  creating action records 198
  types 198
Actions application 197
Activities and Tasks application 155
Add Item to Storeroom action 65
Add/Modify Commodity Codes action 91
Admin Mode 192
Alternatives For Table table window 134
Application Designer 33
Application server log files
  maximoserver.log 191
  native_stdout 191
  systemerr.log 190
  systemout.log 190
Application server security
  application server security files 189
  global security files 188
  security files 189
Apply to New Crafts? check box 138
Approved (APPR) 102
approved purchase orders 89
approved purchase requisitions 89
asset custodian 149
asset identifiers 109
asset number 109
assets
  ancestors 15
  asset hierarchy 13
  children assets 15
  creating 14
  Massive Move 20
  Move Asset dialog box 20
  replace assets 20
  rotating item 16
  save the asset record 14
  Swap Assets 20
  swapping 19
  Users and Custodians tab 21
Assets application 13
  Associate User and Custodians action 21
  Move/Modify Assets action 21
  tabs 13
    Asset 13
    List 13
    Meters 14
    Safety 13
    Spare Parts 13
    Specifications 14
assets life cycle 12
Assets module
  applications
    Assets 12
    Condition Monitoring 12
    Failure Codes 12
    Locations 12
    Meter Groups 12
    Meters 12
Assignment Manager 120
Assignment Manager application 121
associated contracts 80
Associated Labor table window 138
attached documents
  Attachments icon 206
  configuration 208
  properties 196
  types of attachments 207
    administrative actions 207
    Attachments hyperlink 206
    Direct Attachments 207
    Referential Attachments 207
Attached Documents feature 206
Authorize Sites action 91
auto-numbers 104
Average Cost field 116

B
basic logger 190
benefits of certification 3
blanket release 106
Bulletin Board cron task (BBCron) 195

C
calendar 126
calendar record 125
Calendars application 125–126
centralized purchasing department 107
certificates 127
expiration dates 127
renewing 127
certification
benefits 3
checklist 5
IBM Professional Certification Program 2
Test 015 7
Tivoli Professional Certification Program 4
Certification Required? check box 128
Change Item Number 18
change order 105
Change Status action 123
characteristics records 12
Classification 27
Classifications application
Attribute 28
benefits of classifications 27
Children 28
classification 27
classification attributes 28
how to access 27
Use with 28
classifying items 91
Closed (CLOSE) 102
commodity code information 91
Commodity Codes 91
Companies 91
Item Master 91
Purchase Orders 91
Service Items 91
Tools 91
commodity codes 53
commodity group 53
Companies application 53, 98
List 98
tabs
Addresses 98
Branches 98
Company 98
Contacts 98
Company
types
Manufacturer 99
Vendor 99
Company field 88
company master 88
company master record 93
company records 93
company set 88, 97
Company tab 99
Company types
Courier 99
Complete (COMP) 109
Condition Codes application
accessing 70
Condition Monitoring application 23
consumable material 18
Contract field 121
Contract module 73–74
Contract types 74
contracted labor 74
Contracts
changing 80
Contract Line Details table window 81
creating 77
creating a new contract
Buyer 78
Contract Identifier and Description 78
Contract lines 78
Contract Type 78
Start Date and End Date 78
Status 78
Terms and Conditions 78
Total Cost or Maximum Amount 78
Vendor Reference number 78
deleting 81
Master Contract 78
number 81
original 81
Purchasing Contract
Change Price on Use? 83
Change Quantity on Use? 83
Payment Schedule 83
Vendor Items 83
revise 80
Revision field 81
revision number 81
types of contracts 77
conversion factor 51
courses 8
Crafts application 123
Crafts table window 121
creating a release 103
creating purchasing records 92
Cron Task application 46
Cron Task Setup application 202
Currency Codes application 93
Exchange Rates 94
Organizations 94
CUSTODIAN 132

D
Database Configuration application 31, 191
capabilities 191
configuring the database 192
Admin Mode 192
command line mode 192
Table.Column 31
Database Configuration Object 31
Default Craft For Labor 124
Delete Person action 133
Delete Person Group action 134
delivery time expectations 89
Desktop Requisitions application 60
disqualified vendor 100
Document Management System (DMS) 206, 208
Domains application 137
downtime history 174
Duplicate Craft action 138
Duplicate Labor action 124
Duplicate Person Group action 134

E
EAR (Enterprise ARchive) files 190
Edit History Work Orders action 142
Editable on Use? check box 84
electronic audit signatures 196
Electronic Auditing functionality 196
E-mail Listeners application 184
escalations 198
Exchange Rates application 95
Exchange Rates 95
Organizations 95
Extend/Renew Qualification button 129
External Purchases 89

F
failure class 156–157
Failure Codes application 156
Assets and locations 157
Hierarchy 156
work order problem code 158
failure hierarchy 157
first aid training 127

G
garbage collection 206
gauge 12
Generate WO, Meter Frequency Is Reached 39
Generate WO, on Meter Reading (Do Not Estimate) 39
GL Account code 90

H
hazard 160

I
IBM Certification Agreement 6
IBM Maximo Asset Management publications 8
IBM Tivoli Asset Management for IT 75
IBM Tivoli Directory Server 188
In Progress (INPRG) 112
incidents 180
internal PO 103
internal purchases 89
inventory 65
Inventory Adjustments sub-menu 66
Inventory application 66
tabs
Inventory 67
Count Frequency 67
Issue Unit 67
Stock Category 67
List 66
Reorder Details
Economic Order Quantity 68
Lead Time 68
Safety Stock 67
Rotating Asset 68
Where Used 68
Inventory costing model 55
Inventory module 50
applications 56
Item Master 56
add item to a storeroom 58
Item 57
Item Assembly Structure 58
List 56
**System** 27
locations
  add a new location 25
  create a location 19
  initial status 19
Locations application 25
Logging application 189
capabilities 189
Loggers 190
manage log settings 189
Root Loggers 190
lump sum amount 108

**M**
Manage Downtime History action 174
Manage Premium Pay Codes action 138
Mark Row For Delete button 138
Master Contract 75, 79
  approving 79
  association
    Create Associated Contract 79
    Lease Contracts 79
    Purchase Contracts 79
    Warranty on assets 79
  creation 79
  status 80
Master Contracts application. 79
Master PM 36
  non-master PM 36
Master PM records 36
Material receipts 107
Maximo Enterprise Adapter 203
Maximo.log 191
maximo.properties file 205
maximum amount per contract 75
maximum amount per contractor 75
MBOs in memory 205
meter groups 22
meters
  characteristics meter 25
  characteristics meters 25
  creating 22
  measurement point 25
Meters application 22
types of meters
  Characteristic 22
  Continuous 22
  Gauge 22
Microsoft Active Directory 188
Modify Person Availability 126
Move/Swap/Modify action 146
multiple loggers 189
Multisite configuration 97
mxe.db.fetchResultLogLimit 205–206
mxe.doclink.path1 - mxe.doclink.path10 196
MXServer1 195

**N**
network system 27
non-capitalized rotating asset 55
non-inventory location 20
non-master PM 36
non-rotating item 18

**O**
Organization 88
organizational level 77, 91
Organizations application 47, 54
Outside rates 137
Outside Rates table window 137

**P**
Paid Tax GL Account field 96
Pearson Virtual University Enterprises (VUE) 5
People application 126, 131
tabs
  List 131
  Person 131
performance troubleshooting 204
Person field 121
person group 133, 180
PM alerts 45
PM hierarchies 36
PNDREV(Pending Revision) 80
PO Line 91
PR Line 91
Premium Pay table window 137–138
premiums 137
Preventive Maintenance (PM) 37
Preventive Maintenance application 36
  creating Master PM 37
  delete a PM record 44
  Frequency 38
  generate PM work orders 37
  Override Updates from Master PM? 44
Certification Study Guide Series: IBM Maximo Asset Management V7.1

PM hierarchy 44
PM record 43
PM records and routes 43
scheduled work orders 44
Sessional Date 39
updating associated PM records 41
working with the Master PM 37
Primary Calendar 131
Primary E-mail 131
Primary Shift 131
problems 180–181
process flow 151
Prometric 5
Purchase Application 75
purchase contract 75, 92
Purchase order status 105
Approved (APPR) 105
Canceled (CAN) 105
Closed (CLOSE) 105
In Progress (INPRG) 105
Waiting on Approval (WAPPR) 105
purchase orders (POs) 85, 88, 92
CHG 92
PARTS 92
REL 92
SERV 92
STD 92
Purchase Orders application 53, 60, 88, 92, 103
create a purchase order 104
manage purchase orders 104
tabs
List 103
PO 103
PO Lines 103
Ship To/Bill To 103
Terms and Conditions 103
purchase requisitions (PRs) 89–90
Purchase Requisitions application 60, 101
create requisition 101
Ship To/Bill To 101
tabs
List 101
PR 101
PR Lines 101
Terms and Conditions 101
WAPPR status 101
Purchasing Module
applications

Companies 88
Company Master 88
Invoices 88
Purchase Orders 88
Purchase Requisitions 88
Receiving 88
Request for Quotation 89
Terms and Conditions 89
Contracts Module integration 91
Inventory Module 89
Purchasing module 88, 91

Q
qualification 127
Qualification records 130
Qualifications application 127
tabs 128
Associated Labor 128
List 128
Qualification 128
Qualifications tab 123
QUERY tables 205
Quick Reporting application 170

R
receipts 88
Receive Rotating Items action 89
Receiving application 88, 106
tabs
List 107
Material Receipts 107
Material receipts 107
Service Receipts 107
Service receipts 107
Redbooks Web site 220
Contact us xvi
Rental Contract 74
reorder items 89
Reorder Point (ROP) 67
Report Downtime action 171
Reporting downtime 171
request for quotation (RFO) 103, 110
Request for Quotation application 103, 110
Required Craft and Skills Levels table window 129
resources for study 8
Resources Module 120
Calendar field 121
Crafts 120
Labor 120
People 120
Person Group 120
Qualifications 120
return on investment (ROI) 5
role 199
role names for certification 2
Roles application 199
rotating assets 89, 109
rotating item 16, 57, 109
associate a meter 22
associate a meter group 22
creating 17
non-rotating item 18
Routes application 43

S
Safety module 156
applications
Hazards 159
Lock Out/Tag Out 159
Precautions 159
Safety Plans 159
safety plan 159
Safety Plan application 161
associate a safety plan 163
safety plan 162
safety plan components
Hazardous Materials 162
Hazards and Precautions 162
Tag Outs 162
set up a job plan 163
tabs
Tag Outs 162
sample questions 209
seasonal work 39
Security Groups application 115
Security levels 195
PRIVATE 195
PUBLIC 195
SECURE 195
Security settings 188
configure log files 189
synchronization 188
Select Action menu 123, 138
Select Reserved Items dialog 69
self service request 183
Self-Service application 182
serialize 109
Service Contract 75
Service Desk agent 179
service item examples 60
service item status 60
Active 61
Obsolete 61
Pending 61
Pending Obsolescence 61
Planning 61
service items 59
Service Items application 53, 59, 90
how to access 60
Reorder Direct Issue Itms/Svcs action 60
tabs
List 60
Service 60
Specifications 60
service level agreement (SLA) 197
service provider 75
service purchases 107
Service receipts 108
service request 181
high volume 180
status
CLOSE 179
INPROG 178
PENDING 178
QUEUED 178
RESOLVED 178
Service Request Classification 183
service requests 178
Service Requests application 178
Apply Service Request Template 181
applying a ticket template 181
Out of the box functionality 178
set level 60
Sets application 53
Ship To or Bill To Attention field 131
shipping and handling details 89
Site level 91
skill level 137
Skill Levels table window 137
Software Contract 75
spare part 109
specialized training 127
standard rate 137
Standard Service 60
Stocked Tools application 64
  how to access 64
  tabs 65
    Balances sub-tab 65
    List 65
    Rotating Tool Assets 65
    Stocked Tool 65
    Vendors 65
    Where Used 65
storeroom 20
Storerooms application 65, 70
  Storeroom
    GL Control Account 71
    Invoice Variance Account 71
    Purchase Variance Account 71
    Receipt Variance Account 71
    Shrinkage Account 71
    Tool Control Account 71
  tabs 70
    Items 71
    Storeroom 70
      Cost Adjustment Account 71
      Currency Variance Account 71
storeroom-to-storeroom purchase 103
SUPervisor 132
Swap action 147
Swap Assets dialog box 20
system maintenance troubleshooting 204
system performance
  configuration issues 203
  factors affecting 203
  troubleshooting 204
System Properties application 194
  capabilities 194
  Global Properties 194
  Instance Properties 194
  Live Refresh 194
property types
  Global 195
  Instance 195

T
tax code 96
  Tax Options dialog box 96
tax type 96
  template id 180
Terms and Conditions 83
  creating 84
  tab 84
Test 435 7
Ticket Templates application 180
  creating a new ticket 180
    class 180
    required fields 180
    template id 180
Timer 121
Tivoli Certification benefits 4
Tivoli environment 5
tool requirements 36
Tool status
  Active 63
  Obsolete 63
  Pending 63
  Pending Obsolescence 63
  Planning 63
TOOLQUAL 130
tools
  definition 61
  tabs 62
Tools application 53, 91
  how to access 62
  tabs 62
    List 62
    Required Qualifications 62
    Specifications 63
    Storerooms 62
    Tool 62
    Vendors 63
Tools that Require This Qualification table window.
  129
Total Base Cost 115
transfer order 103

U
unapproved purchase orders 89
unapproved purchase requisitions 89
Uniform Resource Locator (URL) 206
Unpaid Tax GL Account field 96
Use Last WO's Start Information to Calculate Next Due Frequency 38
Use Parent Remit To? field 100

V
valid rotating item 17
vendor disqualified 100
Vendor field 88
vendor quotations 89
View Contracts action 97
View Qualification Status History button 130
View Service Requests application 183
Virtual Member Manager 188
VMMSYNC cron task 188

W
Waiting for Inspection (WINSP) 108
Waiting for Serialization (WASSET) 108
Waiting on Approval (WAPPR) 102
Warranty Contract 75
Warranty Contracts application 75
Web-based courses 8
Weblogic 191
WebLogic Server 188
WebSphere Application Server 188, 190
WO Completion 173
work order 140
  check asset status 172
  Downtime Prompt checkbox 174
flow action 152
flow control 150–151
Other Organization Options action 173
ownership 149
status 150
Work Order Tracking application 140, 167
  Actuals tab 167
  Flow control 151
  Material costs 167
  Modify action 147
  Move action 146
  process flow 150
  Swap action 147
work orders
  status 140
work plan 141, 144, 154
Workflow assignments 131
Workflow E-mail Notification 131
Workflow Inbox assignments 200
workflow node 197
Workflow notifications 200
workflow processes 131, 197

Z
Zero Year to Date Hours 127
This IBM Redbooks publication is a study guide for IBM Maximo Asset Management V7.1 and is aimed at individuals who want to get an IBM Professional Certification for this product.

The IBM Maximo Asset Management V7.1 certification exam, offered through the Professional Certification Program from IBM, is designed to validate the skills required of technical professionals who work in the implementation and configuration of the IBM Maximo Asset Management V7.1 product.

This publication does not replace practical experience, and is not designed to be a stand-alone guide for any subject. Instead, it is an effective tool that, when combined with educational activities and experience, can be an extremely useful preparation guide for the exam.

For your convenience, we structure the chapters based on the sections of the Test 000-015: IBM Maximo Asset Management V7.1 Implementation, such as Assets, Inventory, and so on, so studying each chapter will help you prepare for one section of the exam.


For more information: ibm.com/redbooks